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SpeechMiner Administration Guide
The following topics provide instructions required to install and configure the SpeechMiner
components and describe new features of the latest SpeechMiner release.

About SpeechMiner
Find out about SpeechMiner:

Introduction
New in this Release

Installation and Configuration
Find out about how to deploy the
components:

SpeechMiner Components
Installing SpeechMiner
Configuring SpeechMiner
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Introduction
SpeechMiner® is the Genesys Telecommunications Laboratories’s speech-analytics platform. It
analyzes audio content and text-based interactions such as email, chat messages and so on. Speech-
analytics leverages recorded customer interactions (from any recording system) and analyzes each
interaction for critical business topics and events. The system analyzes interactions between
customers and contact-center agents, precisely identifies the topics that were discussed, and
categorizes the contents of each interaction.

SpeechMiner consists of a user interface (UI) and several back-end components that deliver key
capabilities required for various products within the Genesys Workforce Optimization suite. These
products include:

SpeechMiner UI: The SpeechMiner UI is a component of the SpeechMiner package and provides a
single User Interface (UI) for all Genesys Interaction Recording, Quality Management and Genesys
Interaction Analytics functionality. Through the SpeechMiner UI users can perform search and
playback for voice and screen recordings, perform traditional quality management tasks such as
evaluation of interactions through form based scoring, or advanced speech and text analytics
capabilities such as topic analysis or trending and exploration analysis of transcripts.

SpeechMiner UI is comprised of two software components:

• SpeechMiner browser-based interface: Offers a variety of ways to access call audio and the results
of the interaction analysis performed by the system (when Analytics mode is in use). Users of the
speech-analytics system interface can do the following:
• Find interactions that have specific characteristics or are about particular topics.
• Identify and listen to the parts of calls that interest them.
• Audit and fine-tune SpeechMiner's call processing.
• Keep track of a range of system-metrics.

• SpeechMiner Administration Tool (SMART): Enables users of the speech-analytics system to
configure it to search interactions for specific topics and other characteristics.

Genesys Interaction Recording (GIR): Genesys Interaction Recording (GIR) provides cradle to
grave dual channel voice recording and screen recording for customer-ivr and customer-agent
conversations as they occur within the Genesys Contact Center. Through deep integration with
Genesys SIP and the TLib event model, GIR is able to automatically stitch together call segments and
capture all relevant call meta data to provide the information you need to fulfill important use cases
within your business including Compliance, Dispute Resolution and Workforce Training and Coaching.
GIR utilizes components of the core Genesys Contact Center stack such as SIP Server and Media
Server, but brings along its own components to deliver the full set of features within GIR. Additionally,
the GIR User Interace (UI) is provided by the SpeechMiner UI, which is the unified interface for
recording, quality management and interaction analytics capabilities within the Genesys suite.

Quality Management (QM): Quality Management (QM) enables you to monitor quality and
evaluate agent performance on a periodic and consistent basis while minimizing effort through
automated interaction selection to improve customer experience and engage with your staff. QM
includes a robust and feature rich form designer along with a number of evaluation schedule types to
meet the SLAs required by your business in providing core use cases around Quality Management as
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well as input to Coaching and Training through form based scoring of interactions. Interactions can be
sourced from GIR or third party recording platforms, depending on the deployment type selected. All
QM functionality is provided through the SpeechMiner UI, which is the unified interface for recording,
quality management and interaction analytics capabilities within the Genesys suite.

Genesys Interaction Analytics (GIA): Genesys Interaction Analytics (GIA) provides automated
speech and text analytics capabilities on 100% of interactions to provide deep insight into customer-
agent conversations. For voice interaction, GIA provides automated transcription and employs
Speech-to-Phrase grammar based recognition along with non-linguistic analysis of recordings to
create meaning from otherwise unstructured data. Organizations can use this data to fulfill key use
cases around Agent Performance Improvement (for example, decrease AHT, increase FCR, Sales
Conversion, and so on.), Compliance and Customer Satisfaction (for example, NPS). Additionally, for
both voice and text interactions, GIA employs advanced unsupervised machine learning algorithms to
surface salient or unexpected terms to enable use cases around Uncovering Emerging Trends or
Discovery of New Phrases and Intents. All analysis and discovery functionality is provided through the
SpeechMiner UI, which is the unified interface for recording, quality management and interaction
analytics capabilities within the Genesys suite.

Important
Each of these products are sold separately and in different combinations based on the
specific requirements of your organization.

SpeechMiner supports the following deployment modes:

• Analytics and Recording UI: Enables search, play back and analysis of interactions recorded using
Genesys Interaction Recording. The QM module is also available is purchased.

• Recording UI Only: Enables search and play back of interactions recorded using Genesys Interaction
Recording. The contents of the interactions are not processed by the interactions analytics system. The
QM module is also available if purchased.

• Analytics Only: Imports interactions including their recorded call audio from any recording system
using a UConnector. The UConnector is a Professional Services built ETL application that imports
interactions and meta data from a third party recording system. After the interactions are imported,
SpeechMiner processes the contents of each interaction for interaction analytics. The QM module is
also available if purchased.

• Analytics Only with PureConnect: Imports interactions and their recorded call audio from a
PureConnect deployment using the UConnector for PureConnect. This UConnector is a Professional
Services built ETL application that imports interactions and meta data from PureConnect. After the
interactions are imported, SpeechMiner processes the contents of each interaction for interaction
analytics. The QM module is also available if purchased.

Important
If you have purchased both Recording and Analytics licenses, Genesys recommendeds
that you review the specific SpeechMiner setup instructions in the SpeechMiner
documentation before you begin the installation procedure. You might need to make
changes to the generic analytics procedures in this SpeechMiner Administration
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Guide.

This manual explains how to install and configure SpeechMiner, and is intended for system
administrators. Most of the steps described are only performed once, usually with the help of
Genesys Customer Care.
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New in This Release
This section describes the new features that were released in the 8.5.x version of SpeechMiner.

8.5.512.49 Release

• Indexer component now supports Elastic Search version 8.x, including secure connections with basic
user authentication and TLS

8.5.512.46 Release

This release contains the following new features and enhancements:

• AngularJS is now upgraded to v1.9.7.
• The Indexer component has been upgraded to .NET core 8.

8.5.512.37 Release

This release contains the following new features and enhancements:

• Web UI language: SpeechMiner now displays the web UI in a language that you selected in the
browser. If you select an unsupported language in the browser, the web UI defaults to the language
selected in the SMConfig application. To disable the Multi-Language support, refer to Multiple
Language Support for the User Interface.

• Screen Recording Export: SpeechMiner now provides an option to download Screen Recordings from
the SpeechMiner Web UI. To export screen recordings,
1. Click on the horizontal 3 dots in the top-right corner of the player.
2. Select Export. Additional export options are displayed.
3. Select Include screen recordings.

Important
• The option, Include screen recordings, is supported only for exporting a single

Screen Recording interaction and it is not supported for batch export. Also, the
user cannot select Include screen recordings if they do not have the required
permissions.

Introduction New in This Release
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• To export screen recordings, Genesys Administrator Extension (GAX) plugin must
be updated to 8.5.097.57.

• Users must have the privilege Enable Video Contest Menu to be able to
export screen recordings.

• Enhanced digits filtering (voice interactions only): Digits can be filtered based on complex logic.
Additional conditions can be included in the filter, such as greater than, smaller than or equal to. The
conditions must be separated by a semi-colon. For example, >5;<12;. If complex conditions are not allowed,
the default logic of filtering numbers consisting of more than two digits will take effect.

• Indexer upgraded: The Indexer component now supports Elasticsearch version 7.17.6. Additionally, the
Indexer component has been upgraded to .NET Core 6.0.

Important
Installing .NET 6.0 and Elasticsearch 7.17.6 are mandatory requirements for Indexer. All the libraries mentioned in
Installing .NET Core 6.0 Runtime & Hosting are required for successful installation of SpeechMiner (if the Indexer
component is selected). If the Indexer component is selected and if .NET 6.0 is not installed, installation would fail.

• In Single Connection mode, SpeechMiner communicates only with the RWS component. SpeechMiner no
longer supports configuring RCS URL in the Recording panel of SMConfig tool. Starting from 8.5.512.37,
the only option available in SMConfig (Recording panel) is Internal RWS URI, whereas the previous versions
of SpeechMiner provided fields to enter RCS URI, RWS URI, External RCS URI, and External RWS URI.

Important
To use single connection in Interaction Recording Web Services, refer to Local Decrypt
URI Prefix for Call Recording and Screen Recording. Note that Interaction Recording
Web Services must be upgraded to 8.5.204.02 or a newer version.

8.5.512 Releases (8.5.512.28 and earlier)

This release contains the following new features and enhancements:

• Windows Server 2019 / SQL Server 2019 Support:

• Starting 8.5.512.28, SpeechMiner supports Windows Server 2019 operating system and SQL Server 2019
database. You must upgrade to Elasticsearch 7.16.3 to install this SpeechMiner version.

• Support for Elasticsearch 7.16.3:

• Starting 8.5.512.28, SpeechMiner supports the latest version of Elasticsearch 7.16.3. It no longer
supports the older versions of Elasticsearch.

Introduction New in This Release
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• Interaction Search Improvements:

• Search Results – Total Matches: When a search is performed in the Interactions grid, the search
results now show the total number of interactions within the system that match the specified filter
criteria. [+]

As shown in the following image, previously only the number of interactions returned was shown on the menu :

Now the menu contains information about the number of interactions returned out of the number that match the search criteria in
the server.

• Pop-Out Media Player: Users can now pop out multiple instances of the Media Player in separate
Media Player windows to allow multiple interactions to be accessed at the same time. This also allows
users with screen recordings to stretch out the Media Player to see more detail in the screen recording.

• Quality Management Improvements:

• Improved Scheduling and Distribution Options: A number of changes have been made to the
options available for Evaluation Session scheduling and distribution:
• Changes to Recurrence Parameters: Recurrence options are now Days, Weeks and Months. The

Hours and Minutes options have been removed to reduce the chances of creating too many
unneeded evaluation sessions.

• Distributed Agent Evaluation Improvement: The Exactly option is now available for Distributed
Agent Evaluation types. This allows a specific number of interactions to be selected for evaluation for
a specific set of agents for a given time (for example, in a month).

• Maximum Values for Exactly: The system now has limits on the maximum value for Exactly. These
are 1000 for Shared and Distributed Interaction Evaluation types and 30 for Distributed Agent. Note
that these values are changeable in the database.

• Multiple Evaluators Selection: It is now possible to select multiple Evaluators for Distributed
Interaction, Distributed Agent and Shared Evaluation types. When multiple Evaluators are selected,
the resulting Sessions will be evenly distributed across Evaluators in a round robin fashion.

• Evaluation Session Grid Search: The Search Filter for Evaluation Sessions has been updated and now
users can select the type of sessions (Active, Archived, Expired) and other filter criteria, prior to
submitting a search. Previously, every change resulted in a new search that could cause delays in
loading time.

• Evaluation Session PDF Export Improvements: When exporting an Evaluation Session as a PDF
report, you can now see all text that was entered in a Free Form answer field. In addition, all comments
associated with the underlying interaction are displayed in the PDF report.

• Default Form to 100%: To reduce clicks and save time when performing an evaluation, users can now
select a toggle to default all answers in all forms within an Evaluation Session to 100% (or the maximum
possible score). The default behavior when initially loading the form is configurable in the database.
Also, a new permission to allow access to this toggle has been added. [+]

Introduction New in This Release
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The following image shows the new Default scores to 100% option in the Evaluation Session page:

• Trending Improvements: (In a Genesys Interactions Analytics GIA deployment). A new View Trending
Cluster Task Information permission was added to SpeechMiner Permissions.

• Clustering Information Visibility: Users now have more flexibility about who can view and edit
Clustering Tasks and their related information on the Trending page. Now, users with the View
Clustering Task Information permission can view information without the need for elevated permissions
to edit these tasks.

• Language Enablement

• Recognition of Russian (ru-RU) and Russian UI (ru-RU) support has been enabled. Genesys Interactions
Analytics (GIA) now operates on voice interactions and text interactions in Russian.

• The Turkish Language pack (tr-TR) for interaction analytics has been improved with additional training
material.

8.5.511 Release
This release contains the following new features and enhancements:

• Interaction Search Improvements:
• Search for Interactions with Screen Recording (In a Genesys Interaction Recording GIR

deployment): It is now possible to search for interactions that include or exclude screen recordings.
Interactions that have an associated screen recording are tagged with the Screen Recording tag.
This feature can be used in conjunction with Quality Management (QM) to exclusively perform
evaluations on interactions that have screen recordings.[+]

The following Tag section Explore > Search page includes a Screen Recording tag. Previously, this tag did not appear in this
list:
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Note: This feature only works under the following conditions:

• Only for interactions that have been added to the system after SpeechMiner 8.5.511 was
installed.

• The system must be configured with an external RWS to enable screen recordings.
• The solution requires Interaction Recording Web Services (RWS) version 8.5.202.69 or later.
• By default the Screen Recording tag is not enabled. To use the Screen Recording tag you must

first configure SpeechMiner to enable tagging. For details refer to SpeechMiner Settings

• Filter by Minute Granularity: You can now search for interactions within the Interactions and
Events grids with minute granularity. Also, the filter within the QM Evaluations Manger and
Trending can now be specified with minute granularity. [+]

As seen in the following image the Custom date filter now contains hour and minute values:
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Previously, the Custom date filter did not contain hour and minute values.

• Search E-mail Headers: The search capability has been extended to include additional filters for e-
mail headers. You can now search for e-mails according to header fields including To, From, Cc and
Bcc fields. After upgrading to 8.5.511 you must re-index text interactions in order to be able to use
the new email filters for existing data.[+]

The following Email Search section has been added to the Explore > Search page:

Introduction New in This Release
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• Support for Elasticsearch: The solution no longer uses Lucene to store the index for search and
retrieval purposes. The solution now uses Elasticsearch, which is a more scalable search engine based
on a distributed storage that streamlines the backup process and provides robust functionality around
data integrity. As a result, all index data must be migrated from Lucene to Elasticsearch as part of the
upgrade. For details, refer to Install, Configure and Run Elasticsearch

• Quality Management Improvements:
• Form Weighting: It is now possible to provide up to two decimal places when assigning weights

within forms, both at the group level and the question level. [+]

As seen in the following image, you can now enter a value with 2 decimal places:

Previously, you could only enter a whole number.
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• Export Completed QM Sessions Improvement: The exported data is now organized such that
each question and related score are organized in separate columns for every group and form within
the selected evaluations. Also, the export is limited to up to 10 selected evaluations for the chosen
date range. Previously, all evaluations where exported. [+]

As seen in the following image, you can now select up to 10 evaluations:

Previously, you could not select the evaluations for which you wanted to export evaluation data.
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• Text Interaction Improvements:
• Storage of Text Interactions (In a Text Analytics GIA deployment): The solution now stores text

interactions in the file system instead of the database. This includes encryption of the file on disk if
configured as well as a unique value for retention policy period for these text interactions. By
migrating new and existing text interactions from the database to the file system, a large amount of
database space can be freed.

• Text Attachments (In a Genesys Interaction Analytics GIA deployment): The solution now stores and
analyzes text attachments that are part of a text interaction. The system will analyze the content of
the attachment in the same way it analyzes text interactions (for example, topic classification,
searches and so on). The text attachment is displayed below the text interaction transcript with
Attachment in the title. For example: [+]

• Interaction Type: You can now search for interactions according to the new Text interaction type.
• Raw Text Interactions Support (In a Text Analytics GIA deployment): The solution can now analyze

raw text interactions (that is .txt files) in the same way it analyzes audio, e-mail and chat
interactions. You can also search for these interactions using the new Texts interaction type

Introduction New in This Release
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• In-Line Audit of Topic Events (In a Genesys Interactions Analytics GIA deployment): Users can now audit
topic events for Interaction Analytics in-line within the transcription viewer from the search page for all
interactions types. This option is only available is the user has the correct privileges assigned. [+]

As seen in the following image events now appear in an interaction transcript with the option of marking the event with an audit value:

Previously, the transcript events did not have the audit value options:.

• Trending Improvements: (In a Genesys Interaction Analytics GIA deployment)

• New Words More Prominent: In Trending reports, when new terms are uncovered they are now
shown more prominently in Top Movers.

• Layout Options: User now have more flexibility in how the data is viewed on the Trending page. Users
can now select one of three different layout options: Combination, Chart or Table. Combination shows
the chart and table together, while Chart or Table show only one or the other. Also, the option to Ignore
Blacklist is included as part of the layout options drop down. The selected option is persistent across
sessions. [+]

The new Trending page combination option now includes a Layout menu:

The previous Trending page options appeared as follows:

Introduction New in This Release
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• Reset Filters: You can now reset the trending filters to the default state in Trending. [+]

The Trending filter now contains a Reset button as shown in the following image next to the Run button.

The previous Trending Filter did not contain a Reset option next to the Run button as shown here:

The Search Filter page now contains a Reset button as shown in the following image next to the Run button.

Introduction New in This Release
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The previous Search Filter page contained a Clear Filters option as shown here:

• Language Enablement':

• Recognition of Dutch (nl-NL) and Dutch (nl-NL) UI support has been enabled. Genesys Interaction
Analytics (GIA) now operates on voice interactions and text interactions in Dutch.

• The US Spanish Language pack (es-US) has been updated to include improvements for Colombia and
Mexican Spanish dialects.

• PureConnect: Product materials have been updated to reflect the integration of Genesys Engage
Genesys Interaction Analytics and Genesys Engage Quality Management with PureConnect.

8.5.510 Release

This release contains the following new features and enhancements:

• Interaction Search, Export and Add Improvements:
• Sort by Agent: Within the Interactions grid it is now possible to sort by the Agent column.

Interactions with multiple agents will appear after (descending order) or before (ascending order)
the alphabetized list of interactions with one agent. Subsequently, Interactions with multiple agents
are sorted by the number of agents and then relevance. [+]

The new Agent column heading now includes sorting options:

The previous Agent column heading appeared as follows:

• Search by List of Interaction IDs: It is now possible to search for a specific set of Interactions
based on a list of Interaction IDs. A list of up to 50 Interaction IDs is supported. This can be useful
when working with a specific set of interactions. [+]

The new Interactions ID field contains a new resize option in the bottom right corner of the field that enables you to view
the interaction ID's:

The previous Interactions ID field did not contain this option:
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• Export All Interaction Meta Data: You can now easily export all the metadata associated with
Interactions from an interaction search, up to the maximum number of listed interactions, without
having to scroll through all interactions in the search results. [+]

The new Export window enables you to select the interactions that should be exported. The following window appears before
the previous Export window:

The previous Export window did not contain this option:

Introduction New in This Release
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• Add All Interactions to a List: You can now easily add all Interactions from an interaction search
to an Interaction List without having to scroll through all interactions in the search results. [+]

The new Add To... window enables you to select the interactions that should be added to the selected list:

Introduction New in This Release
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The previous Add To... window did not contain this option:
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• Quality Management Improvements:
• In-Line Rubric / Standards Definition: Forms and Questions within Forms now have an

expanded Question Description field that can be used to store the standard definition or rubric
used by your Quality Managers to ensure consistency when performing evaluations of Agents. [+]

The new Question Description field contains a new resize option in the bottom right corner of the field:

The previous Question Description field did not contain this option:
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• Form and Evaluation Manager Improvement: The Forms Manager grid and the Evaluations
Manager grid now includes a Description column; if a description is long, the full content is shown
in a tooltip. In addition, when you hover over a Form or Evaluation name, a tooltip with the
description of the specific Form/Evaluation is shown. [+]

When you hoover over the Form / Evaluation name, the description appears in the tooltip as shown in the following image:

• Trending Rank for Top Terms (In a Speech Analytics deployment - GIA): The Top Terms table in the
Trending report results now includes a Rank column for each period. The Rank column displays the
relative importance and prominence of the specific term/phrase in the selected Period. [+]

The new Rank columns are now included in the Top # Terms table. The Period 1 and Period 2 column headings have been
replaced with Count (P1) and Count (P2). The table also includes a Select Columns option that enables you to change the
columns in the table:

The previous Top # Terms table did not contain the Rank columns and the Select Columns option:
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• Manual Text Categorization (In a Speech Analytics deployment - GIA): You can now manually assign
a category to a Text Interaction from the Attributes page of the interaction.

• SMART Improvements (In a Speech Analytics deployment - GIA):
• Option to Re-categorize Interactions: SMART users can now decide to re-categorize all existing

interactions in the system or not when updating Category definitions. [+]

The new Recategorize option now appears next to the changes menu:

The previous Apply Changes window did not contain this option:

• SMART Statistics Date: You can now configure the default Show Calls Since date value in
SMART to determine in advance the date range for the information that will be shown.

• Reporting Improvements:
• Agent Comparison by Segment report: It is now possible to report on agents performance

based on the Segments within an Interaction instead of just at the Interaction level only.
Interactions can have multiple Segments, each involving a different Agent. Reporting by Segment
provides more precise Agent Comparison information for multi-segment interactions.

• Agent Trend by Segment report: It is now possible to report on agent performance trends based
on the Segments within an Interaction instead of just at the Interaction level only. Reporting by
Segment provides more precise Agent Trend information for multi-segment interactions.

• Team Comparison by Segment report: It is now possible to report on teams performance based
on the Segments within an Interaction instead of just at the Interaction level only. Interactions can
have multiple Segments, each involving a different Agent from different Teams. Reporting by
Segment provides more precise Team Comparison information for multi-segment interactions as
only Segments where that Team was involved are included in the comparison report.

• Language Enablement: Recognition of Canadian French (fr-CA) and Canadian French UI support was
enabled. Speech Analytics and Text Analytics now operate on voice interactions and text interactions in
Canadian French.

Introduction New in This Release
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• SpeechMiner Web UI: Windows 10 64-bit Support: SpeechMiner Web UI is now supported for all
existing supported browsers (for example, Chrome and Internet Explorer) on systems running Windows
10 64-bit.

8.5.509 Release

This release contains the following new features and enhancements:

• Genesys Logo: The Genesys logo has been updated throughout the product based on new Genesys
branding. [+]

The new logo now appears as follows:

The previous logo appeared as follows:

• Access Control: SpeechMiner now supports Configuration Server based Access Control for items within
SpeechMiner for Genesys based user accounts. This functionality determines the agents and users that
are visible to a logged in user based on their granted Read permissions. Additionally, access to items
within SpeechMiner (For example, Forms, Evaluations, and so on.) is also limited based on read access
to the creator of those items. Access Control is enabled in the following areas of the user interface:
• All Agent Hierarchy filters, including those in Search, Evaluation Manager, Evaluation Sessions and

Trending.
• All Users filters, including those in Search, Evaluation Manager, Action Items, Saved Reports -

Sharing, Saved Searches – Sharing, Interactions List - Sharing.
• Forms, Evaluations and Evaluation Sessions.
• Coaching and Alerts.

• Improved Tooltips: Tooltips in SpeechMiner in various locations now provide more detail; for cases
where even more space is required, clicking on the element loads a modal window with all the
information. Affected areas include: Topics and Categories in the Interactions Grid, Current Filter
at the top of the Interactions Grid, and Action Items details.

• Quality Management Improvements:
• Evaluation Sessions Grid: You can now filter the Evaluation Sessions grid according to the date on

which the session was created as well as when the session was completed.[+]
In the following image of the Evaluation Sessions filter, you can see the new Creation Date and Completion Date
parameters.
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The following image represents the previous Evaluation Session filter (without the Creation Date and Completion Date
options):
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• Evaluation Session Completion: The workflow to close an Evaluation Session has been optimized
to reduce the number of clicks required.

• Language Enablement: Recognition of Cantonese (zh-HK) and Cantonese UI support was enabled.
Speech Analytics and Text Analytics now operate on voice interactions and text interactions in
Cantonese.

• Topic Analysis – Audits: (In a Speech Analytics deployment - GIA) The header row in the Topic
Analysis – Audits report is now fixed so users can always see the column titles. This functionality is
only supported in the Chrome browser.

• Trending Export: (In a Speech Analytics deployment - GIA) You can now export all information shown
in a Trending report. This capability is enabled only for users with the appropriate permissions.

• Coaching Improvements: (In a Speech Analytics deployment - GIA)
• Interaction Comments: It is now possible to add comments from the Media Player that is available

in the Coaching and Operations Search pages.[+]
The following image represents the updated Coaching Media Player with the New Comment option:
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• Session Subtype and Reason Code: You can now add session subtypes (a secondary or
subordinate session type that falls under the general classification of a specific session type) and a
reason code (the cause, explanation or justification for completing a coaching session) to each
Coaching Session.[+]

In the Coaching > Session List page, the Session Types button has been changed with the Configure button.

>
The Session Types window is now called Configure, since it now includes two tabs: Session Types and Reason Codes.
The following 2 images represents the new Configure window:
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The following image represents the previous Session Types window:
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• Updated Icons: The Coaching Session summary page now includes a Status icon and a Status
name that makes it easier to identify the status of a case at a glance.[+]

In the following image you can see that the Status column now includes a more easily discernible status, as the icons are
more varied and the Status label is shown:

In the following image you can see that the previous Status column did not indicate the status label and the icons for each
status were very similar:
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8.5.508 Release

• Search for Users: (In a Recording and QM deployment) When using the Users filter option in the
Search Filter in Search or Evaluation Sessions, or when selecting Evaluators in Evaluation Manager,
the names are listed alphabetically according to the user's full name, also the filter now filters based on
username and full name.

• Events and Comments for Text Interactions: (In a Speech Analytics deployment - GIA)
• You can now add in-line comments to text interaction transcripts. Event markers are located

throughout the text interaction based on where the event was detected in the text.
• Event navigation is now available in text interaction transcripts from the events and comments list

on the right side of the screen and from the transcript timeline. When clicking on an event marker
the event will be highlighting in the transcript.

• Interaction Transcript Search: When you view an interaction transcript, you can now search for
specific terms within the transcript using the Search field above the transcript.

• The text interaction timeline now contains both event and comment markers.
• The new Search filter above the events and comments list now enables you to quickly filter the

events and comments list for all interaction types. This filter can also be made persistent.

• Trending: (In a Speech Analytics deployment - GIA)
• The Related Words option from the Trending chart, now produces the Related Words chart based on

the Trending page filter selections.
• The Trending chart can now include verbs. Previously, the chart only included noun phrases.
• Custom Trending Cluster Tasks can now be defined with specific filter criteria, beyond the default

cluster tasks, to ensure that the data and results shown on the Trending bubble chart fully reflect
the specific data set that you are interested in exploring with this tool.

• The Header row of the Topic Analysis - Audits report is now static when the report is long and you
must scroll down to view additional details. The static row is only supported when working with
Chrome.

• SpeechMiner no longer supports Internet Explorer 10.
• Screen Recording Grid: (In a Recording and QM deployment) The SpeechMiner Screen Recording grid

now includes two new columns (Agent First Name and Agent Last Name).
• Usage Tracking Report: In a Recording and QM deployment, the Usage Tracking report now logs

separate entries for playing a voice interaction vs. selecting an interaction from the search results grid.
• Audio Wave Graph: When working with Chrome, the SpeechMiner Media Player, in a Recording and

QM deployment (when Speech Analytics is not deployed), now contains an Audio Wave Graph that
enables the user to see where there are silences in the audio. From the Audio Wave Graph (when dual-
channel audio is available), the user can also distinguish between when one speaker is talking vs. the
other.

8.5.507 Release

• Auto Fail Report: A drill down report that focuses on auto fail Quality Management questions and
agents.
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• Auto Fail Permission: A new Auto Fail permission has been added to enable the user to create, edit
and/or view the Auto Fail report.

• Distributed Evaluations Targeted to Specific Agents: Provides supervisors with the ability to
evaluate specific agents repeatedly over time.

• Quality Management - Agent Notification: Enables agent collaboration to provide agent feedback
against evaluations and related scores.

• Show Evaluation Session Score Permission: Enables a user to turn on/off the evaluation session
Show Score option.

• Replace Interaction: Enables a user (based on existing search criteria) to select an alternative
interaction due to the interaction's quality.

• Replace an Evaluation Session Interaction Permission: Enables the user to replace the evaluation
session interaction.

• Interaction Tags: Enables you to use user defined tags for a variety of uses (for example, compliance
or training).

• Define Tags: Enables you to define tags for a variety of uses (for example, compliance or training).
• Define Tags Page Permission: Enables a user to define and edit an interaction tag.
• Tag Interactions Permission: Enables a user to tag an interaction.
• Protect from Deletion: Enables you to prevent an interaction from being deleted.
• Protect Interactions from Deletion: - A new permission has been added to enable you to protect

interactions from deletion.
• Tag Interactions as Evaluated: Automatically adds an Evaluated tag when an evaluation session is

completed.
• Ad-Hoc Evaluation: Enables you to launch an evaluation from the player against a specific media

asset.
• Create Ad-Hoc Evaluation Permission: This permission will enable the user to evaluate interactions

from the Explore page.
• Trending Bubble – Drag and Drop: Enables you to move a Trending bubble to a different location on

the screen. This ability is useful in moving apart bubbles that are close together as the system has
found that they are closely related. Once the Trending chart is re-run , the bubble returns to its original
place.

• Recognition Improvements: Recognition enhancements to have been made for improved accuracy
and detection results.

8.5.506 Release

• Installation/Upgrade Prerequisite: Before installing/upgrading SpeechMiner .NET 4.6.2 must be
installed.

• Export to PDF: Enables users to export a completed evaluation session as a PDF file.
• Export Completed QM Sessions: Users can now export completed evaluation sessions according to a

specific date range.
• Recognition Improvements: Recognition improvements have been made for Italian.
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• Alpha Numeric Operation IDs: Operation IDs can now contain both letters and numbers.

8.5.505 Release

• Improved Trending capabilities: Enables users to monitor and analyze terms and phrases within
conversations in conjunction with a variety of search criteria to better surface and analyze unforeseen
or unexpected trends to improve business outcomes and agent performance.

• Configuration Data:
• User lists now include only users associated with the context in which they are shown (for example,

a list of evaluators will only include users with QM permissions).
• Changes in the Configuration Database are visible immediately in the user interface (for example,

when a user is given QM permissions, his/her name will appear in the evaluators list the next time
you view the list).

• Preset views are now supported for users with Genesys authentication.

• Default Call List Order: A new configuration option that enables you to determine the order of
interactions in an interaction list. The new sort options are: Descending by Date Added, Ascending by
Date Added, Descending Alphabetical and Ascending Alphabetical.

• Database Optimization: Database storage can now be significantly decreased by not storing events
that were not found with a high enough confidence.

8.5.504 Release

• Encrypt exported interactions: Enables you to encrypt exported interactions, so that a password is
required to access the interactions.

• Export an Interaction List / Saved Search from a Coaching Session: Enables you to export
interaction lists and saved searches directly from a Coaching session.

• Retrieve Original Interaction: Enables you to export an interaction with its original audio or text file
(including all attachments).

• Export Coaching Session Permission: A new permission has been added to enable or disable the
option of exporting an interaction list and/or saved search from a Coaching Session.

• Retrieve Original Interaction Permission: A new permission has been added to enable or disable
the option of retrieving original audio or text data for a specific interaction. This permission is only
available in a SpeechMiner Analytics environment.

• Language Support: Support for the Catalan (ca-ES) language has been discontinued.
• Search Page: When the Search page is accessed, the Filter Panel will be opened and a search will not

be run.
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8.5.503 Release

• Predictive Elements Report: A report composed of two bar graphs that show the relationship
between selected Categories and Target Categories.

• Interaction Evaluation Summary Report: A report that shows the evaluation score for the last
evaluation session, associated with a specific evaluator and interaction.

• Program Distribution Report: A report that graphs the interaction volume for each Program.
• Edit Call Comments Permission: A new permission has been added to control which Users can edit

an interaction comment; this permission is system wide for a given User.
• Customer Sensitive Data Permission: A new permission has been added to enable the user to

display customer sensitive meta data (for example, attached data from CIM) in the SpeechMiner GUI.
When this permission is enabled, the data is visible

• Agent Sensitive Data Permission: A new Recording Only permission has been added to enable the
user to display agent sensitive meta data (for example, agent name) in the SpeechMiner GUI. When
this permission is enabled, the data is visible

• Interaction Evaluation Summary Permission: A new permission has been added to enable or
disable the Interaction Evaluation Summary report.

• Timestamps in Comments: Interaction display improvements have been made to include a
timestamp in comments. Users will now see the date and time at which the comment was made/last
edited.

• Segment Filter: Users can now filter the Search Results grid according to a specific number of
segments. In addition, the search results can be restricted further using the greater than and/or less
than options.

• Support for MSSQL 2014: SpeechMiner now supports MSSQL 2014
• Recognition Improvements: Recognition improvements have been made for the following existing

languages: Arabic (ar-WW), Brazilian Portuguese (pt-BR), German (de-DE), Korean (kr-KO), Japanese (ja-
JP).

• Language Enablement: Recognition of Indian English (en-IN) was enabled. Speech Analytics and Text
Analytics now operate on voice interactions and text interactions in Indian English.

8.5.502 Release
• Recognition Improvements: Recognition enhancements to voice analysis have been made for

improved accuracy and detection results for English and Spanish.
• Shared Evaluations: Creates evaluation sessions about an agent's performance during customer

interactions without assigning the sessions to a specific evaluator(s). Instead, each evaluator
associated with the session can select and assign himself/herself a specific session from the
available pool of sessions.

• Edit a Completed Evaluation: Users with the correct permission can open, save, export, and
close a completed evaluation session.

• Filter Panel: Users can now quickly and easily create retrieve evaluation session information by
filtering the evaluation session list.

• Export Incomplete Evaluation Session: Users can now export an evaluation session that was
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saved but not completed.
• Archive Completed Evaluation Sessions: Users can now archive completed evaluation sessions

automatically at a specific period of time or manually.
• Interactions Report: A new report that provides a list of all the interactions in the system.
• Localization for Turkish: User Interface localization was added for Turkish.
• Analytics for Turkish: Speech Analytics and Text Analytics now operate on voice interactions and

text interactions in Turkish.

8.5.501 Release
• Enhanced Segment Data and Metadata: The Attributes page now contains data for

interaction segments.
• Localization for Arabic: User Interface localization was added for Arabic.
• QM Evaluation Score Visualization: When a QM evaluation is completed and saved you can the

evaluation score appears.
• Screen Column Customization: It is now possible to change the column order in the

Interactions, Events and QM grids per user.

8.5.5 Release
• Quality Management - Question Library: When creating a Quality Management form, you can

now select an existing group of questions and create a new group for future use.
• SMUpgrade: The new upgrade process is faster and no longer requires two databases. This one-

step upgrade procedure can be performed from any version to any version on the customer's
database (that is, a new database is not required).
Note: SMUpgrade is not automatically included with SpeechMiner. Contact Customer Care to
obtain the new upgrade procedure, and allow for one week to receive the required scripts.
For additional details, refer to the SpeechMiner Upgrade Guide.

8.5.4 Release
• QM Evaluations Manager - Media Player: When you play back an interaction in the QM

Evaluations Manager, the Media Player can be opened in a separate window.
• Localization of new languages: User Interface localization is available for the following

languages:

- German
- Brazilian Portuguese
- Japanese
- Italian
- Catalan
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- Mandarin
- French

• Related Words: When you view the transcript of an interaction, you can use the Related Words
option to graphically show which terms are commonly found within the same or similar term
clusters as a selected term, and how frequently the terms are found together in the cluster.

• Search by ID: You can filter an interaction search query according to the interaction's ID.
• Show/Hide Search Filter: You can now select to show or hide the SpeechMiner Search filter.
• SpeechMiner Command Line Configuration: SpeechMiner can now be configured using the

command line.
• Transcript - Comments and Events display: With a new Comments and Events panel, you can

now view and edit a list of all the comments and events associated with the transcript you
selected to view.

• Playback speed: When you play back an interaction you can now select the playback speed. 1.0
is the default speed and every number above is faster. For example, 2.0 is twice as fast as the
default speed.

• Column selections: Column selections are now saved per user profile. The columns you select to
view in a SpeechMiner grid are displayed until you select the "'Reset to defaults'" option. This
option resets the grid to display the default column layout.

8.5.3 Release
• New Quality Monitoring: A completely new Quality Monitoring module features enhanced forms

as well as improved workflows for scoring interactions and agents. Four new Quality Monitoring
report templates are included in this release.

• Exploration of text channels: Text channels are now included in Exploration tasks. Term clusters
can be generated for chat and email messages, and displayed in the Trending page.

• Language enablement: Recognition of Italian and Mandarin audio is enabled.
• Functionality changes: Three Dashboard widgets (Gauge, My Queues, and Recently QAed) and

the QM Agent Summary report were removed from SpeechMiner 8.5.3.

8.5.2 Release
• New Responsive Style User Interface: The Main page, Menus, Media Player, Search pages and

grids have been updated with the new design.

• New Media Player with Video Playback Capability: The updated media player, now supports
screen recordings. When working with GIR, audio and screen recordings can now be synchronized.

• Multiple QM Forms per Interaction: Multiple QM form evaluations can now be attached to a
single interaction.

• Categorization Based on Spatial Relationships: Text interactions can now be categorized
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based on rules such as: "found abc within X words of xyz.".

• Wildcard Support for Text Interaction Topic Definitions: Similar to Voice interaction topic
definitions, text interaction topic definitions can now use wildcards.

• Recognition Improvements: Recognition improvements were made in this release based on new
customer and vertical training material.

8.5.001 Release
• Ability to add text interactions to saved lists: Similar to voice interactions, text interactions

can now be added to saved lists.

• Ability to add comments to text interactions: Similar to voice interactions, comments can
now be added to text interactions.

• Ability to search for numbers in text interactions: Numbers and special characters can now
be used in search term definitions for text interactions.

• Events are displayed in text interactions: Similar to voice interactions, topic events are
highlighted when they occur in text interactions.

• Topic filters in reports supports text interactions: The topic parameter in the Data Set Filters
on the reports now works for text interactions.

• Support for wildcards in Spanish: Similar to English, wildcards are now supported for Spanish
voice interactions.

• High Availability improvement for indexing: In the event of an index failure, the system will
automatically switch to a backup index.

8.5.0 Release
• Interaction Recording Integration: SpeechMiner 8.5.x provides the UI for Genesys Interaction

Recording - Voice Edition. This enables preconfigured integration with the new Genesys recording
product.

• Chrome Support: Support for Chrome on Windows for the Interaction Recording features.

• Chat Support: Support for chat interactions with multiple speakers.

• Genesys Branding: The web UI has been re-branded with the Genesys name, logos, and colors.

• Configuration Server Integration: SpeechMiner now integrates with Genesys Configuration
Server for centralized user management.

• Language Recognition Support: Support for Brazilian Portuguese and German language calls.
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Deploying SpeechMiner
This section describes the SpeechMiner system and how to configure each component for your
enterprise.

Components

SpeechMiner Components

The SpeechMiner system makes use of the following components:

• UPlatform service: Manages all the processing tasks of SpeechMiner—fetching (in the case of
Analytics mode), recognition and exploration (in the case of Analytics and Analytics & Recording UI
modes), categorization compression, and indexing (in all modes).

• Interaction Receiver: A web service which receives calls (audio and metadata) from the Genesys
Interaction Recording system.

• MS-SQL database: The SpeechMiner database that stores the interaction data and the interaction
processing results.

• Web service: Runs the SpeechMiner web-based interface that enables users to view and work with the
interaction data after it is processed.

• ULogger: The log viewer for the SpeechMiner logs.

System Software
Users work with the following software to use SpeechMiner:

• SpeechMiner browser-based interface: Offers a variety of ways to access call audio and the results
of interaction analysis performed by the system (when Analytics mode is in use). Users of the speech-
analytics system can:
• Find interactions that have specific characteristics or that are about particular topics.
• Identify and listen to the parts of calls that interest them.
• Audit and fine-tune SpeechMiner call processing.
• Keep track of a range of system metrics.

• SpeechMiner administration tool (SMART)—An application that enables users to configure the
speech-analytics system to search calls for specific topics and other characteristics.

• SMConfig—An application that is used by system administrators to configure SpeechMiner.
• SMUpgrade—An application that upgrades the SpeechMiner database from the previous version to the

current version.
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Install

Installing SpeechMiner

This section includes pre-installation steps; setting up the system components, database, and the
software steps that users perform to interact with the system. The components can be installed on a
single machine, or on separate machines, as required by the particular configuration of your system.

Configure

Configuring SpeechMiner

Most of the SpeechMiner configuration is performed in the SMConfig application after SpeechMiner is
installed. This is a Windows application that can be installed on any machine on your network. Once
SMConfig is installed, it can be used, from any machine on which it is installed, to configure the entire
SpeechMiner system.

SpeechMiner supports users defined in three places:

• Internal (SpeechMiner):

Users are defined in the SpeechMiner interface.
• Windows:

Users are defined in the SpeechMiner interface and are managed with the
Windows Active Directory.

• Genesys Configuration Server:

Users are defined in the Genesys Configuration Server. Refer to steps 1-5 and
11 in the Configuring SpeechMiner Users in the GIR Solution Guide.

Important
It is recommended that users be defined using only one type of authentication
method. To set the authentication type, configure the AuthenticationTypes and
AuthenticationDefault fields in the WebServiceParams table in the SpeechMiner
database.

Deploying SpeechMiner New in This Release

SpeechMiner Administration Guide 39

https://docs.genesys.com/Documentation/CR/latest/Solution/Speech#Configuring_SpeechMiner_users


Language Support

SpeechMiner Language Support

SpeechMiner language recognition and user interface (UI) support is available for the following
languages:

Language Recognition Support UI Support
Dutch - NL X Dutch - NL
English - USA X English - USA
English - UK X English - USA
English - Australia X English - USA
English - South African X English - USA
English - Indian X English - USA
French - Canadian X French - Canadian
Russian - Russia X Russian - Russia
Spanish - Columbian X Spanish - Mexican
Spanish - Mexican X Spanish - Mexican
Spanish - Spain X Spanish - Spain
German - Germany X German - Germany
Portuguese - Brazil X Portuguese - Brazil
Korean - Korea X Korean - Korea
French - France X French - France
Japanese - Japan X Japanese - Japan

Mandarin - China X Simplified Chinese (labeled as
Mandarin)

Italian - Italy X Italian - Italy
Arabic - World Wide X Arabic - World Wide
Turkish - Turkey X Turkish - Turkey

Cantonese - Hong Kong X Traditional Chinese (labeled
as Cantonese)
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Installing SpeechMiner
This section describes how to prepare your environment before you install SpeechMiner, and how to
install the SpeechMiner software. The SpeechMiner components can be installed on one or more
servers, as required by the particular configuration of your system.

Important
The SpeechMiner supported environment might be different for each SpeechMiner
version and the current SpeechMiner Administration Guide information might not
apply to your version of SpeechMiner. For detailed information about supported
operating environments, see the Supported Operating Environment Reference Guide

.

Getting Started

Before you install SpeechMiner, confirm the following:

• The system requirements are met.
• The required third-party software has been installed on the machines in your system.
• The required permissions are set.
• The individual installing SpeechMiner must be a database owner.

Once the above are confirmed, review the Preinstallation Checklist before you begin the installation
process.

Important Points to Remember

• When working with Internet Explorer 11+, the Online Help documentation may not appear as it
should due to your Internet Explorer > Compatibility View settings. To view the Online Help
properly, go to the Tools menu, select Compatibility View Settings and verify that Display
intranet sites in Compatibility View is not checked.

• A Text Interaction with more than 100K characters (with or without an attachment) is not supported.

• The following characters are not supported in Text interactions with xml formats (for example, chat and
social): & < >.
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• Phrases defined in SMART must be part of a single sentence. Phrases cannot be a combination of
multiple sentences separated by a period. The period can only appear once at the end of the phrase.

System Requirements

Disk Space

Each server in the system requires at least the following available disk space before installing
SpeechMiner:

• All servers: Approximately 1 GB of disk space for the recognition engine
• Recognition server(s): For the UPlatform service, 20 MB of disk space for the runtime folder plus

approximately 10 GB for caching recognition packages. (The exact amount required for caching
depends on the size of the implementation.)

• Database server: At least 20 GB for the SpeechMiner database. In addition, for some types of
recording-system integrations that have a very high volume, a larger (10-200 GB) storage area is
needed for temporary files.

Important
• The initial size of the database is about 20 GB; it might grow larger, depending on the

call volume and the call-purging policy.
• On relatively high-volume installations, UConnector might need its own dedicated

server.

• Web server: About 20 MB of disk space are needed for the SpeechMiner virtual folder, plus additional
space for call audio. (The exact amount required for caching depends on user activity.)

• Interaction Receiver: About 15 MB for the Interaction Receiver virtual folder.
• Machines running SMART: About 1 GB of disk space for the recognition engine.

Database

For detailed information about the SpeechMiner database refer to the Supported Operating
Environment Reference Guide.
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Operating Systems

SpeechMiner works on machines running Windows operating systems.
For detailed information about the Windows operating systems that are compatible with each
SpeechMiner component, refer to the Supported Operating Environment Reference Guide.

Browser

When working with the SpeechMiner web application, you must work with specific operating systems,
browsers and resolutions.

• For detailed information about SpeechMiner operating system and browser compatibility refer to the
Supported Operating Environment Reference Guide.

• For additional information about minimal desktop resolution and browser configuration see:
Configuring your Browser

Machines running SpeechMiner must have the following minimal web client
desktop specification:

• 8 GB RAM
• Dual-core, 2GHz or faster CPU x64-bit processor
• 10 GB hard drive

Memory (RAM)

Machines running SpeechMiner servers and applications must have the following minimum memory
requirements:

• Database server: 4 GB - 128 GB (dependent on call volume)
• Web server: 4 GB
• SMART application: 2 GB
• Platform server: 8 GB (allow 1 GB per recognizer task)

What Is Installed?

The following software will be installed on the machines in your system:
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Machine Components

On the Recognition Server(s) • UPlatform service

On the DB Server • SpeechMiner database

On the Web Server • SpeechMiner virtual folder

On the Interaction Receiver Server • Interaction Receiver virtual folder

On Every Machine Running SMART
• Recognition engine
• SMART executable and runtime files (dlls)

Ports Used by the System Components

The following ports are used by SpeechMiner:

Important
The ports listed are the default ports. Most of them can be changed upon request.

Source Destination Protocol and Port Pair (ex.
TCP 3389)

Web Servers, Platform Servers,
SpeechMiner Administrator
Workstations (SMConfig/SMART)

Database Server tcp 1433

Database Server, Web Server,
Platform Servers, SpeechMiner
Administrator Workstations
(SMConfig/SMART)

MS-SQL Report Server http 80 / https 443

SpeechMiner Administrator
Workstations (SMConfig/SMART) WebServers http 80 / https 443

Genesys Interaction Recording
Server Interaction Receiver Server http 80 / https 443

Web Servers Web Servers http 80 / https 443
SpeechMiner Administrator
Workstations (SMConfig) Platform Servers, Web Servers tcp 135

Web Servers, Platform Servers,
SpeechMiner Administrator File System smtp over tcp 445
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Source Destination Protocol and Port Pair (ex.
TCP 3389)

Workstations (SMConfig/SMART)
Web Servers, SpeechMiner
Administrator Workstations
(SMConfig/SMART)

Active Directory tcp 88

Web Servers, Platform Servers Email Server smtp over tcp 25
Platform Servers Indexer Microservice http 80
Elasticsearch Cluster Elasticsearch Cluster tcp 9300
Indexer Microservice Elasticsearch Cluster http 9200

Ports and Protocols Required for SpeechMiner UConnector
SpeechMiner UConnector requires access to the recording-system database and file-storage system.
SpeechMiner UConnector uses the TCP protocol with port 1433 to access the database. (The port
number can be configured on the database server.) To access the storage system, the SMB over TCP
protocol with port 445 is used. Other protocols can be used as well, if they are available in the
underlying file-storage system.

Important
• Professional Services is responsible for the development, installation and configuration

of UConnector and UConnector for PureConnect. For additional information about
UConnector refer to Professional Services.

• Verify that your antivirus software and firewall configuration are not blocking
SpeechMiner ports and protocols.
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Required Third-Party Software

Important
You must install specific third-party software on the computers in your system before
you install SpeechMiner.

.NET Framework

Installing the .NET Framework

Microsoft .NET Framework 4.7.2 SP2 or higher must be installed on all machines that run the
SpeechMiner Web component. Machines that run SpeechMiner components and do not include the
SpeechMiner Web component, must install a minimum of Microsoft .NET Framework 4.7.2.
.NET 3.5.1 must be installed on all machines that will run SpeechMiner components or interact with
SpeechMiner.

If you are installing the .NET Framework on machines that are running Windows Server 2008 R2,
Windows Server 2012, Windows Server 2016 or Windows Server 2019:

• Enable .NET framework using the Add Features option in the Server Manager (Start > Administrative
Tools > Server Manager).

• Verify that Windows Update is enabled.

If Windows Update is not enabled or you are using an operating system other than Windows Server
2008 R2, Windows Server 2012, Windows Server 2016 or Windows Server 2019, manually download
and install .NET 4.7.2 from the following location: https://support.microsoft.com/en-us/help/4054530/
microsoft-net-framework-4-7-2-offline-installer-for-windows

Important
Hosts on which the Indexer will be installed must have .NET Core
Runtime & Hosting version 6.0 (see: https://dotnet.microsoft.com/en-
us/download/dotnet/6.0). If the system does not have an Internet
connection, obtain and install the Microsoft Visual C++ 2015
Redistributable (64-bit) before installing the ASP.NET Core/.NET Core:
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Runtime & Hosting Bundle.

Installing .NET Core 8.0 Runtime & Hosting

To ensure that the Indexer application is installed successfully, install the following .NET components
before you begin installing SpeechMiner:

• dotnet-sdk-8.0.403-win-x64
• dotnet-hosting-8.0.10-win
• dotnet-runtime-8.0.8-win-x64

Download and install these components from the following location: https://dotnet.microsoft.com/en-
us/download/dotnet/8.0

Microsoft Visual C++ Redistributable

Installing Microsoft Visual C++ Redistributable

The following Microsoft Visual C++ Redistributable's must be installed on all machines that will run
SpeechMiner components or interact with SpeechMiner.

• Microsoft Visual C++ 2013 Redistributable: 2013 installation

Important
• When installing Microsoft Visual C++ 2015 Redistributable you must install both x86

and x64 versions.
• Hosts on which the Indexer will be installed must have version 6.0

(see:https://dotnet.microsoft.com/en-us/download/dotnet/6.0). If the system does not
have an Internet connection, obtain and install the Microsoft Visual C++ 2015
Redistributable (64-bit) before installing the ASP.NET Core/.NET Core: Runtime &
Hosting Bundle.
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SQL Server

Setting Up the SQL Server

Before you begin installing SpeechMiner, you must install the SQL server on the database server. You
can use either Microsoft SQL Server 2008 R2 with Reporting Services, Microsoft SQL Server 2012 with
Reporting Services, Microsoft SQL Server 2014 with Reporting Services, Microsoft SQL Server 2016
with Reporting Services or Microsoft SQL Server 2019 with Reporting Services.

For information about installing and configuring the SQL Server for SpeechMiner, see Setting Up the
SQL Server for SpeechMiner.

For details about which MS SQL is supported, refer to the Supported Database/DB Clusters section in
the SpeechMiner page in the Genesys Supported Operating Environment Reference Guide.

Elasticsearch

Installing and Configuring Elasticsearch

Elasticsearch must be installed and operational before you begin installing SpeechMiner.

For information about installing and configuring Elasticsearch for SpeechMiner, see Install, Configure
and Run Elasticsearch.

Internet Information Server

Installing IIS on the Web Server or Interaction Receiver Server

The Internet Information Server (IIS) must be installed and operational on the servers that will be
used to run the SpeechMiner Web and the Interaction Receiver. You can install and configure IIS on
either:

• Windows Server 2008
• Windows Server 2012
• Windows Server 2016
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• Windows Server 2019

Notes:

• The SpeechMiner and Interaction Receiver Application Pool must use .NET framework version 4.0. After
you install the SpeechMiner web server, you should check that this is the version in use.

• We recommend to enable HTTP Compression on the IIS server. For additional information, see
http://technet.microsoft.com/en-us/library/cc771003(v=ws.10).aspx.

Report Viewer

Installing Report Viewer

You can configure SpeechMiner to use Microsoft Report Viewer to run saved reports at night and
cache their results. Using Microsoft Report Viewer can significantly reduce the time required to load
the SpeechMiner Views page, especially if it contains a large number of reports. To use this feature,
install Reporter Viewer and then configure it to run the reports you want it to generate. You can
download the installation file at https://www.microsoft.com/en-us/download/details.aspx?id=1299.

Important
A security issue is identified with Report Viewer Redistributable 2005
Service Pack 1. Protect your Windows-based system by installing the
security update from Microsoft: https://www.microsoft.com/en-us/
download/details.aspx?id=1299.

For additional information about Report Caching, see: Defining Caching Reports.
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Setting Up the SQL Server for SpeechMiner

Installing SQL Server 2012

Installing SQL Server 2012

To install SQL Server 2012 for use with SpeechMiner, run the normal setup wizard first and follow the
instructions.

1. Run the installation program. The SQL Server Installation Center window opens, with the Planning
screen open.

2. From the menu on the left, select Installation. The Installation screen opens. Select New
installation or add features to an existing installation. The installation wizard opens.

3. Follow the on-screen instructions. When the screens mentioned below open, follow the instructions
below to select the required settings and options for SpeechMiner.

4. From the Setup Role screen, select SQL Server Feature Installation.
5. From the Feature Selection screen, select the following options:

• Database Engine Services
• Reporting Services
• Client Tools Connectivity
• SQL Server Books Online
• Management Tools Basic
• Management Tools Complete

Installing SpeechMiner Required Third-Party Software

SpeechMiner Administration Guide 50



6. From the Server Configuration screen, in the Service Accounts tab, for the SQL Server Agent,
SQL Server Database Engine, and SQL Server Reporting Services, do the following:
• Enter the user account and password of the service account.
• Under Startup Type, select Automatic.
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7. From the Server Configuration screen, in the Collation tab, under Database Engine, select
SQL_Latin1_General_CP1_CI_AS (the default value).
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8. From the Database Engine Configuration screen, in the Data Directories tab, select the locations
for the database folders. If possible, put the User database directory, the Temp DB directory, and the
Backup directory on a separate drive from the other folders.
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9. From the Reporting Services Configuration screen, select Install the native mode default
configuration.

10. When you finish installing SQL Server, restart the machine on which you installed it.

Installing SQL Server 2014

Installing SQL Server 2014

To install SQL Server 2014 for use with SpeechMiner, run the normal setup wizard first and follow the
instructions.

1. Run the installation program. The SQL Server Installation Center window opens, with the Planning
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screen open.
2. From the menu on the left, select Installation. The Installation screen opens.

3. Select New SQL Server stand-alone installation or add features to an existing installation.
The installation wizard is activated.

4. Follow the on-screen instructions. Refer to the instructions below to select the required settings and
options for SpeechMiner.
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5. In the Setup Role screen, select SQL Server Feature Installation and click Next.
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6. In the Feature Selection screen, select the following features, and click Next:
• Database Engine Services
• Reporting Services - Native
• Client Tools Connectivity
• Management Tools Basic
• Management Tools Complete
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7. In the Instance Configuration screen select the Instance Configuration option and set the
Instance ID name.

Installing SpeechMiner Required Third-Party Software

SpeechMiner Administration Guide 58



8. In the Server Configuration > Service Accounts tab, perform the following for the SQL Server
Agent, SQL Server Database Engine, and SQL Server Reporting Services and click Next:
• Enter the service Account Name and Password.
• Under Startup Type, select Automatic.
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9. In Server Configuration > Collation tab, under Database Engine, select
SQL_Latin1_General_CP1_CI_AS (the default value) and click Next.
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10. In the Database Engine Configuration > Server Configuration tab, select an Authentication
Mode and click Next. If required specify the SQL Server administrators password.
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11. In the Database Engine Configuration > Data Directories tab, select the database folder locations
and click Next.
Note: It is recommended that the User database directory, Temp DB directory, and Backup
directory be located on a drive that is different from the Data directories.
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12. In the Reporting Services Configuration screen, select Install and configure and click Next.

Installing SpeechMiner Required Third-Party Software

SpeechMiner Administration Guide 63



13. In the Ready to Install screen, click Install.
14. When you finish installing SQL Server, restart the machine on which you installed it.

Installing SQL Server 2016

Installing SQL Server 2016

To install SQL Server 2016 for use with SpeechMiner, run the normal setup wizard first and follow the
instructions.

1. Run the installation program. The SQL Server Installation Center window opens, with the Planning
screen open.

2. From the menu on the left, select Installation. The Installation screen opens.
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3. Select New SQL Server stand-alone installation or add features to an existing installation.
The installation wizard is activated.

4. Follow the on-screen instructions. Refer to the instructions below to select the required settings and
options for SpeechMiner.
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5. In the Product updates screen, click Next.
6. In the Feature Selection screen, select the following features, and click Next:

• Database Engine Services
• Reporting Services – Native
• Client Tools Connectivity
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7. In the Instance Configuration screen select the Instance Configuration option and set the
Instance ID name.
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8. In the Server Configuration > Service Accounts tab, perform the following for the SQL Server
Agent, SQL Server Database Engine, and SQL Server Reporting Services and click Next:
• Enter the service Account Name and Password.
• Under Startup Type, select Automatic.
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9. In Server Configuration > Collation tab, under Database Engine, select
SQL_Latin1_General_CP1_CI_AS (the default value) and click Next.
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10. In the Database Engine Configuration screen, in the server configuration add the Authentication
mode. In the Data Directories tab, select the locations for the database folders. If possible, put the
User database directory, the Temp DB directory, and the Backup directory on a separate drive from the
other folders. Click Next.
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11. In the Reporting Services Configuration screen, select Install the native mode default
configuration and click Next.
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12. When you finish installing SQL Server, restart the machine on which you installed it.

Installing SQL Server 2019

Installing SQL Server 2019

To install SQL Server 2019, refer to SQL Server installation guide.

Configuring the SQL Server Setting
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Configuring the SQL Server Setting

After the SQL server is installed, do the following:

• Ensure that the SQL server is running
• Configure the SQL server to start automatically
• Enable both the TCP/IP and the Named Pipes protocols

Important
After you install SpeechMiner, you also have to deploy the CLR
assembly and set its permissions. See Installing the SpeechMiner
Components > Installing the SpeechMiner Database > SQL CLR.

To configure the SQL server and enable the required protocols:

1. From the Start menu, navigate to Microsoft SQL Server 2008 (or later) > Configuration Tools >
SQL Server Configuration Manager. The SQL Server Configuration Manager opens.

2. On the left side of the window, select SQL Server Services.
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3. On the right side of the window, for SQL Server Agent, check that the Status is Running, and the
Start Mode is Automatic.

4. If one or both of these values are not as they should be, do the following:
• Double-click the row. The Properties window opens.
• In the Service tab, set the Start Mode to Automatic.
• If the service is not running, in the Log On tab, select Start.
• Click OK to implement the changes.

5. On the left side of the SQL Server Configuration Manager window, select SQL Server Network
Configuration > Protocols for MSSQLSERVER.

6. On the right side of the window, for TCP/IP and for Named Pipes, check that the Status is Enabled.
7. For each of these protocols, if it is not enabled, do the following:

• Double-click the row. The Properties window opens.
• In the Protocol tab, under Enabled, select Yes.
• Click OK to implement the changes.

Configuring the Reporting Services
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Configuring the Reporting Services (Pre SQL Server 2019)

The SQL reporting services should be configured as explained below.

Tip
The default configuration for mhtml rendering is html3.2. This
configuration does not support padding. In order to render web
archive open the Report Server config file (for example C:\Program
Files\Microsoft SQL Server\MSRS10_50.MSSQLSERVER\Reporting
Services\ReportServer\rsreportserver.config) and change
RenderingExtension (under EmbeddedRenderFormats) to HTML4.0.
Once you are done, restart the report server.

To configure the SQL reporting services:

1. In the Start menu, under All Programs, select SQL Server 2008 R2 > Configuration Tools >
Reporting Services Configuration Manager. The Reporting Services Configuration
Connections window opens.

2. Enter the report server name and the instance name (if they are not already there), and click Connect.
The Reporting Services Configuration Manager opens, with the Report Server Status screen
displayed.
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3. Check whether the report server is running. If it is not, click Start.
4. On the left side of the window, select Service Account.
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5. Configure the account name and password of the service account that will be used to run the report-
server service, as required. Use either a local administrator account or an account that can log in as a
service and run services on the local machine.

The user must be a Domain user.

6. On the left side of the window, select Web Service URL; make sure the settings in the screen match
the settings as follows:
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7. On the left side of the window, select Database. If you created a report-server database when you
installed SQL Server, it appears under Current Report Server Database. If you did not, create it
now.
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8. On the left side of the window, select Report Manager URL; make sure the settings in the screen
match the settings as follows:
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9. On the left side of the window, select E-mail Settings.
10. Enter the settings for the e-mail account you want the report server to use to send reports to

SpeechMiner users.
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11. Click Exit to close the Reporting Services Configuration Manager.
12. In the Report Server config file (rsreportserver.config) change the MaxActiveReqForOneUser

parameter value from 20 to 250.

For more details see: http://msdn.microsoft.com/en-us/library/ms157273.aspx

Configuring the Reporting Services (SQL Server 2019)

The SQL reporting services should be configured as explained below.

Tip
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The default configuration for mhtml rendering is html3.2. This
configuration does not support padding. In order to render web
archive open the Report Server config file (for example C:\Program
Files\Microsoft SQL Server\MSRS10_50.MSSQLSERVER\Reporting
Services\ReportServer\rsreportserver.config) and change
RenderingExtension (under EmbeddedRenderFormats) to HTML4.0.
Once you are done, restart the report server.

To configure the SQL reporting services:

1. In the Start menu, under All Programs, select SQL Server 2019 > Configuration Tools >
Reporting Services Configuration Manager. The Reporting Services Configuration
Connections window opens.

2. Enter the report server name and the instance name (if they are not already there), and click Connect.
The Reporting Services Configuration Manager opens, with the Report Server Status screen
displayed.

3. Check whether the report server is running. If it is not, click Start.
4. On the left side of the window, select Service Account.
5. Configure the account name and password of the service account that will be used to run the report-

server service, as required. Use either a local administrator account or an account that can log in as a
service and run services on the local machine.

The user must be a Domain user.

6. On the left side of the window, select Web Service URL; make sure the settings in the screen match
the settings as follows:
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7. On the left side of the window, select Database. If you created a report-server database when you
installed SQL Server, it appears under Current Report Server Database. If you did not, create it
now.

8. On the left side of the window, select Web Portal URL; make sure the settings in the screen match the
settings as follows:
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9. On the left side of the window, select E-mail Settings.
10. Enter the settings for the e-mail account you want the report server to use to send reports to

SpeechMiner users.
11. Click Exit to close the Reporting Services Configuration Manager.
12. In the Report Server config file (rsreportserver.config) change the MaxActiveReqForOneUser

parameter value from 20 to 250.

For more details see: http://msdn.microsoft.com/en-us/library/ms157273.aspx

Creating the Report-Server Database
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Creating the Report-Server Database

If the report-server database was not created automatically when you installed SQL Server, you can
create it in the Report Server Database Configuration Wizard.

To create the report-server database:

1. Open the Reporting Services Configuration Manager.
2. From the Database screen, under Current Report Server Database, click Change Database. The

Report Server Database Configuration Wizard opens.
3. In the wizard, fill in the fields as they are filled in in the examples shown (except, of course, for the

server name and the credentials, which you must specify as appropriate for your system). Click Next to
progress from screen to screen until you have finished creating the database.

•

Action

•

Database Server

•

Database

Installing SpeechMiner Required Third-Party Software

SpeechMiner Administration Guide 87



•

Credentials

Click on the image to enlarge.

Configuring Report Server Load Value

Configuring Report Server Load Value

To ensure that the Report Server does not crash due to overload, verify that your Report Server is
configured to enable a large amount of concurrent reports.

1. Open the report server configuration file. By default the configuration file can be found in
rsreportserver.config under \\SERVER_NAME\c$\Program Files\Microsoft SQL Server\
MSRS12.MSSQLSERVER\Reporting Services\ReportServer.

2. Change the value of MaxActiveReqForOneUser to the recommended value. The value of
MaxActiveReqForOneUser depends on your deployment. Contact Customer Care for the value
recommended for your deployment.

Important
The report server has a limit of the number of simultaneous
connections, when the limit is reached, the SSRS does not accept
new requests and throws 503 errors.

3. Change the SME data source connection string:
a. Go to the Report Server web interface. By default the location is http://SERVER_NAME/reports.
b. Click on the database folder.
c. Click SME datasource.
d. Add the following string: max pool size = 10000 to the end of the connection string field.
e. Click Apply.
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Setting the Maximum Memory Usage

Setting the Maximum Memory Usage

If the SQL-server's memory usage is not limited, it will consume all of the available memory.
Therefore, it is recommended to limit the memory usage of the SQL Server by setting the max server
memory value.

Important
In addition to the "server memory" that is limited by this value, the
SQL server uses 2-4 GB of other memory. For this reason, it is
recommended to set the max server memory to a value that is 2-4
GB lower than the maximum memory you want to allow the server to
use. For additional details, see http://msdn.microsoft.com/en-us/
library/ms178067.aspx.

You can see the current max server memory value, and modify it as required, in the SQL Server
Management Studio.

To view or modify the max server memory value:

1. From the SQL server, open the SQL Server Management Studio. (For example, in the Start menu,
under All Programs, select Microsoft SQL Server 2008 R2 > SQL Server Management Studio.)

2. On the left side of the window, right-click the SQL server and then select Properties. The Server
Properties window opens.
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3. On the left side of the window, select Memory. The memory settings are displayed.
4. Under Maximum server memory (in MB), enter the value you want to use.
5. Click OK. The setting is implemented, and the window closes.

If you prefer, you can also set the max server memory property by executing a query:

To set the max server memory by executing a query:

1. On the SQL server, open the SQL Server Management Studio. (For example, in the Start menu,
under All Programs, select Microsoft SQL Server 2008 R2 > SQL Server Management Studio.)

2. On the left side of the window, right-click the SQL server and then select New Query. A blank text area
opens on the right side of the window.
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3. Copy the following commands and paste them into the text area:
sp_configure 'show advanced options', 1;
GO
RECONFIGURE;
GO
sp_configure 'max server memory', 4096;
GO
RECONFIGURE;
GO

4. The code sets the max server memory to 4GB (4096MB). If you want to set it to a different value, in the
text area, change 4096 to the required value.

5. Above the text area, select Execute. The commands are executed. When the process is completed
successfully, Query executed successfully appears at the bottom of the window.

Recommended SQL Server Configuration
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Recommended SQL Server Configuration

1. On the SQL server, open the SQL Server Management Studio. (For example, in the Start menu,
under All Programs, select Microsoft SQL Server 2008 R2 > SQL Server Management Studio.)

2. On the left side of the window, right-click the SQL server and then select New Query. A blank text area
opens on the right side of the window.

3. Copy the following commands and paste them into the text area:
sp_configure 'show advanced options',1
reconfigure
exec sp_configure 'backup compression default',1
reconfigure
exec sp_configure 'cost threshold for parallelism',50
reconfigure
exec sp_configure 'remote admin connections',1
reconfigure
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Installing IIS on the Web Server or
Interaction Receiver Server

Windows Server 2008

On Windows Server 2008, you can install and configure the Internet Information Services (IIS) in the
Server Manager.

To install and configure the IIS component:

1. From the Start menu, select All Programs > Administrative Tools > Server Manager. The Server
Manager opens.

2. On the left side of the window, select Roles.

3. On the right side of the screen, select Add Roles.
The Add Roles Wizard opens.
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4. From the list of roles, select Web Server (IIS), and then select Next. An Introduction to the Web
Server is displayed.

5. Select Next. The Role Services screen opens.
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6. Under Role Services, make sure the following services are selected:
a. Under Common HTTP Features:

• Static Content
• Default Document
• HTTP Errors
• HTTP Redirection

b. Under Application Development:
• ASP.NET
• ISAPI Extensions
• ISAPI Filters
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Important
When you select ASP.NET, a window pops up, asking you to confirm that you want to "Add role services
required for ASP.NET." Select Add required role services.

c. Under Security:
• Windows Authentication

d. Under IIS 6 Management Compatibility:
• IIS 6 WMI Compatibility
• IIS 6 Metabase Compatibility

7. Click Next. A Confirm Installation Selections screen opens.

8. Select Install. The installation process begins, and the Installation Progress screen is displayed.
When the installation is completed, an Installation Results screen is displayed.
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9. Click Close. The Add Roles Wizard closes, and the Server Manager lists the Web Server (IIS) role
as installed.
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10. From the Server Manager, in the left pane, select Features, and then, in the right pane, select Add
Features. The Add Features Wizard opens.

11. Select Add required role services. The window closes.

Click Next three times, and then click Install. The installation process begins, and the
Installation Progress screen is displayed. When the installation is completed, the Installation
Results screen is displayed.
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12. Click Close. The Add Features Wizard closes, and the Server Manager lists the features you
selected as installed.
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Windows Server 2012

On Windows Server 2012, you can install and configure the Internet Information Services (IIS),
version 8, in the Server Manager.

To install and configure the Internet Information Services (IIS) component:

1. Open the Server Manager.
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2. From the upper-right side of the window, in the Manage menu, select Add Roles and Features. The
Add Roles and Features Wizard opens.

3. Click Next. The Installation Type screen opens.
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4. Select Role-based or feature-based installation, and click Next. The Server Selection screen
opens.
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5. Verify that the Select a server from the server pool is selected and select the server on which you
will be installing the SpeechMiner web server. Click Next. The Server Roles screen opens.
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6. From the list of roles, select Web Server (IIS). The following window pops up.
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7. Select the Include management tools (if applicable) checkbox and click Add Features. The
window closes.

8. Select Next. The Role Services screen opens.
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9. From the list of Role services, make sure the following services are selected:
a. Under Common HTTP Features:

• Static Content
• Default Document
• HTTP Errors
• HTTP Redirection

b. Under Application Development:
• Application Initialization
• ASP.NET
• ASP.NET Extensibility
• ISAPI Extensions
• ISAPI Filters

c. Under Security:
• Windows Authentication
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d. Under IIS Management tools:
• IIS 6 Management Compatibility
• IIS Management Console

10. Select Next and then select Install. The IIS server is installed with the roles and features you selected.

Windows Server 2016

On Windows Server 2016, you can install and configure the Internet Information Services (IIS),
version 8, in the Server Manager. To install and configure the Internet Information Services (IIS)
component:

1. Open the Server Manager.

2. From the upper-right side of the window, in the Manage menu, select Add Roles and Features. The
Add Roles and Features Wizard opens.
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3. Click Next. The Installation Type screen opens.

Installing SpeechMiner Required Third-Party Software

SpeechMiner Administration Guide 108



4. Select Role-based or feature-based installation, and click Next. The Select destination server
screen opens.
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5. Select Server Selection, verify that Select a server from the server pool is selecte, and select the
server on which you will be installing the SpeechMiner web server. Click Next. The Select server
roles screen opens.
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6. Select Server Roles and from the list of roles, select Web Server (IIS). The following window pops up.
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7. Select the Include management tools (if applicable) checkbox and click Add Features. The
window closes and you are returned to the following Select Features screen.
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8. Select Features.
9. Select .NET Framework 3.5 features and .NET Framework 4.6 features.

10. Click Next. The Select roles services screen appears.
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11. From the Role services list, select the following services:
• Under Common HTTP Features:

Static Content
Default Document
HTTP Errors
HTTP Redirection

• Under Application Development:
Application Initialization
ASP.NET
ASP.NET Extensibility
ISAPI Extensions
ISAPI Filters

• Under Security:
Windows Authentication

• Under IIS Management tools:
IIS 6 Management Compatibility
IIS Management Console

12. Select Next and then select Install. The IIS server is installed with the roles and features you selected.
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Windows Server 2019

On Windows Server 2019, you can install and configure the Internet Information Services (IIS),
version 8, in the Server Manager. To install and configure the Internet Information Services (IIS)
component:

1. Open the Server Manager.

2. From the upper-right side of the window, in the Manage menu, select Add Roles and Features. The
Add Roles and Features Wizard opens.
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3. Click Next. The Installation Type screen opens.
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4. Select Role-based or feature-based installation, and click Next. The Select destination server
screen opens.
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5. Select Server Selection, verify that Select a server from the server pool is selecte, and select the
server on which you will be installing the SpeechMiner web server. Click Next. The Select server
roles screen opens.

Installing SpeechMiner Required Third-Party Software

SpeechMiner Administration Guide 118



6. Select Server Roles and from the list of roles, select Web Server (IIS). The following window pops up.
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7. Select the Include management tools (if applicable) checkbox and click Add Features. The
window closes and you are returned to the following Select Features screen.
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8. Select Features.
9. Select .NET Framework 3.5 features and .NET Framework 4.6 features.

10. Click Next. The Select roles services screen appears.
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11. From the Role services list, select the following services:
• Under Common HTTP Features:

Static Content
Default Document
HTTP Errors
HTTP Redirection

• Under Application Development:
Application Initialization
ASP.NET
ASP.NET Extensibility
ISAPI Extensions
ISAPI Filters

• Under Security:
Windows Authentication

• Under IIS Management tools:
IIS 6 Management Compatibility
IIS Management Console

12. Select Next and then select Install. The IIS server is installed with the roles and features you selected.
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Pre-installation Checklist
Before you begin installing SpeechMiner, ensure the following:

• You have the required hardware (see System Requirements).

• You have received the following from Genesys Customer Support:
• SpeechMiner installation package
• Licenses

Important
If you are installing a deployment that includes SpeechMiner Analytics, you must supply the Genesys
Customer Support Licensing team with your database servers network adapter (MAC) addresses.

To gather all the enabled MAC addresses run the getmac command in a command prompt on each of the
database servers and copy all the physical addresses.

Verify that all network adapter addresses are enabled. If a network adapter is not
enabled, its MAC address will not be listed in the list of physical addresses.

• Space check: The hard drives of the machines on which you are planning to install the system
components have sufficient space available for those components (see System Requirements).

• OS check: All machines have supported operating systems (see System Requirements).

• Machine connectivity: All machines are functional and connected to the network.

• Admin user: The user account that will be used to install the components has Administrator
permissions on all machines on which components will be installed.

• Verify that all of the following Required Third-Party Software is installed and configured:
• .NET Framework
• SQL Server
• Elasticsearch
• IIS installation
• Report Viewer

• Audio capabilities: Machines on which the SpeechMiner web application will run have functioning
audio devices.
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Installing the SpeechMiner Components
The setup wizard is used to install all SpeechMiner components. You can run it separately on each
machine on which you are installing SpeechMiner components. If you are installing multiple
SpeechMiner components on the same machine, you can install them at the same time. For example,
if you are installing the database server and the web server on the same machine, you can select
both of them in the setup wizard. In most systems, SMConfig is installed on all server machines.

Installing Using the Wizard

Installing Using the Wizard

To install components using the setup wizard:

Important
Hosts on which the Indexer will be installed must have .NET Core
Runtime & Hosting version 6.0 (see: https://dotnet.microsoft.com/en-
us/download/dotnet/6.0). If the system does not have an Internet
connection, obtain and install Microsoft Visual C++ 2015
Redistributable (64-bit), before installing the ASP.NET Core/.NET
Core: Runtime & Hosting Bundle.

1. Open the installation package.
2. From the FullInstaller folder, run SpeechMinerInstall.exe. The setup wizard opens, with the

Welcome screen displayed.
3. Click Next. The License Agreement screen opens.
4. Select I accept the terms of the license agreement, and then click Next. The Installation Type

screen opens.
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5. Select the installation mode:
• Analytics and Recording UI: SpeechMiner plays back and analyzes interactions recorded with

Genesys Interaction Recording.
• Recording UI Only: SpeechMiner plays back the call audio for each interaction in the search

results. The contents of the interactions are not processed by the speech-analytics system.
• Analytics Only: SpeechMiner imports interactions and their recorded call audio from any recording

system. Once the interactions and their audio is imported SpeechMiner processes the contents of
each interaction.

6. Click Next. The Choose Components screen opens.
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7. In the list of components , select the components you want to install on the machine.
8. Click Next. Which screen you see next depends on the components you selected in the previous screen.

Important
By default, 64-bit SpeechMiner is installed in the following
location: C:\Program Files (x86)\Genesys\Software.
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9. Modify the default installation location if necessary and then click Next.
10. If you selected Indexer, define a user and password in the Authentication tab and click Next
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11. In the field provided enter the Elasticsearch data nodes (:9200) you created when installing
Elasticsearch add click the + button to add the datanode to the list.
Do not add Master nodes to this list.

Important
If you want to edit, add and/or remove a data node, you must
configure the esNodes environment variable. The value of the
esNodes environment variable, must be a list of data node url's
separated by a semicolon ;. For example,
http://dataNode1:9200;http://dataNode2:9200;http://dataNode3:9200

For Elasticsearch 8.x
If you want to edit, add and/or remove a data node, you must
configure the esNodes environment variable. The value of the
esNodes environment variable, must be a list of data node url's
separated by a semicolon ;. For example,
https://username:password@dataNode1:9200;https://username:password@dataNode2:9200
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(Use the Elasticsearch username and password obtained
during initial setup.)

Indexer Setup Notes: When providing the Elasticsearch link during Indexer
setup, consider these formats based on your ES8 configuration:

• SSL & Security Enabled (Default ES8):
https://username:password@ESserver:9200/

• Security Enabled, SSL Disabled: http://username:password@ESserver:9200/
• Security & SSL Disabled: http://ESserver:9200/

12. Click Install. The installation process begins. When the process is completed, the following screen
appears:
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13. Select Restart Now, and then click Finish. A warning message appears, and reminds you to configure
SpeechMiner before you open it.

14. Click OK. The server restarts.

Installing the SpeechMiner Database

Installing the SpeechMiner Database

The SpeechMiner database stores the interaction data and the results of interaction processing. It is
usually installed on a dedicated machine. The following sections explain how to install the
SpeechMiner database:

• Setup Wizard
• Manual Installation
• Storage Partitions
• Maintenance Jobs
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• SQL CLR
• Recovery Model
• Autogrowth

Running the Setup Wizard

Important
If you are installing SpeechMiner 8.5.512.28, refer to the Known
Issues.

To begin the installation of the database server, run the setup wizard as described under Installing
the Components.

To install the database server:

1. On the database server machine, run the Setup Wizard, as described under Install Using the wizard.
2. Follow the instructions there, until the Database Credentials screen opens.
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3. In the Database Credentials screen, fill in the fields as follows:
Field Description

Windows Authenticated User

Select this option to use the Windows username
and password you used to log into the machine
as the DB User and DB Password. When you
select this option, the DB User and DB Password
become unavailable.

DB Server

Enter the name of the server on which you want
to install the SpeechMiner database. If you want
to install the database on an SQL Named
Instance, the server name should be entered as
server_name\instance_name.

DB Name
Enter the name of the database in the format
speechminer_verX_Y (for example,
speechminer_ver8_5).

DB User

Enter SA. (The credentials of the user name
entered here will be used for the process of
creating the SpeechMiner database.)

Note: This field is not available
when Windows Authenticated
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Field Description

User is selected.

DB Password

Enter the DB password. Only a user with
Administrator permissions can enter password
credentials.

Note: This field is not available
when Windows Authenticated
User is selected. In addition, when
creating a DB Password you cannot
use = and ; as part of the DB
Password.

4. Click Next. The Choose Install Location screen opens.
5. Modify the default installation location if necessary, and then click Install. The installation process

begins. When the process is completed select Restart Now, and then click Finish. A warning message
appears.

6. From the warning message, click OK. The server restarts.
7. After the database-server installation is completed, check that the speechminer_verX_Y database is

present. This can be done by opening SQL Server Management Studio on the SQL server (for
example, in the Start menu, under All Programs, select Microsoft SQL Server 2008 R2 > SQL
Server Management Studio) and reviewing the list of databases on the server.
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Manually Installing the SpeechMiner Database

An alternative way to perform the database installation is to use the SQL backup file (for example,
data_sql_2008.bak) deployed in C:\Program Files (x86)\Genesys\Software\Support during any
regular install. Restore this backup on the SQL server and choose settings based on the settings in
the steps above. After restoration is complete, update the database properties as follows:

• For both the Data and Log files, change Options\Recovery Mode to Simple and change the Files\
Autogrowth\File Growth parameter to 1024 MB for Data files and 256 MB for Log files.

Important
When you manually install the SpeechMiner Database, you must
enable the SQL Server Service Broker to allow purging interactions
from the database.
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To enable the SQL Server Service Broker:

1. Run the SP command: EXEC sp_enableServiceBroker

The SP will try to enable the service broker with ENABLE_BROKER. If it does not succeed, it will run
the command with NEW_BROKER. This SP will also use the current DB name correctly.

2. If sp_enableServiceBroker does not enable the Service Broker, run the following query:

ALTER DATABASE [DB_NAME] SET ENABLE_BROKER WITH ROLLBACK IMMEDIATE

3. Run the following query to verify that SQL Server Service Broker is enabled:

SELECT is_broker_enabled FROM sys.databases WHERE database_id=DB_ID()

A value of 1 indicates that the Service Broker is enabled.

If the enable SQL Server Service Broker query fails:

1. Close all connections to the database.
2. Run the following query:

ALTER DATABASE [DB_NAME] SET ENABLE_BROKER WITH ROLLBACK IMMEDIATE

3. Run the following query to verify that SQL Server Service Broker is enabled:

SELECT is_broker_enabled FROM sys.databases WHERE
database_id=DB_ID()

To disable the SQL Server Service Broker:

1. Run the following query:

ALTER DATABASE [DB_NAME] SET DISABLE_BROKER WITH ROLLBACK
IMMEDIATE

Creating the Storage Partitions

If the database server is an Enterprise Edition, you must create the storage partitions on the
database. To do this, after you install the database server, run the following SQL query on the
SpeechMiner database:

EXEC sp_create_DB_storage_partitions
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Important
For information about how to open SQL Server Management Studio
and run a query, see Setting the Maximum Memory Usage.

Configuring the Database Maintenance Jobs

When the database is installed, a database maintenance job (SpeechMiner_Maintenance_job -
<database>) is automatically created. If the maintenance job doesn’t exist, you should execute
sp_createMaintenanceJob stored procedure to create it. You should schedule the job to run daily or
weekly at a time when call volume is expected to be low. In addition to scheduling the job to run, you
can also modify it to suit your requirements.

By default, the maintenance job does the following:

• Shuts down the SpeechMiner UPlatform service
• Rebuilds fragmented database table indexes
• Restarts the system
• Purges logs of messages that are older than one month
• Purges logs of user events that are older than one year
• Purges the report agent filter by removing entries that are older than 30 days and creating a new list of

agents

Important
• When working with a system that includes text interactions, it is recommended to

configure the system to purge text interactions older than # years.
• It is recommended to delete (or archive) interactions whose topics/terms do not meet

the strictness threshold after a configurable number of days. Doing this will reduce the
number of interactions waiting to be re-indexed after SMART topic or program changes
are applied. For additional assistance, contact Genesys Customer Care.

To open the maintenance-job script:

• From SQL Server Management Studio, under Databases > SQL Server Agent > Jobs, double-
click the job.
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The job may optionally include the sp_updateUntilYesterdayMaxChannels and
sp_agentFilterCleanByDays steps. In addition, any procedure that rebuilds indexes and purges old
calls should be added as a step in the maintenance job.

Important
• When creating an Agent, if you create a username but you do not enter a firstname and

lastname in the fields provided, the specific Agent's name will appear blank in the
Search Filter > Agents & Work Groups list.
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• When creating an agent hierarchy it is recommended that the hierarchy be created in
the Configuration Server if you have the Genesys Interaction Recording (GIR)
system or through the UConnector if you are working with an external recording
system.

• Creating the agent hierarchy in both the Configuration Server and through the
UConnector at the same time is not supported. You must work with one or the other.

• If both GIR and UConnector are not available you can use the stored procedure
sp_createAgentsFromPartitions as a step in the maintenance job to create agents
according to work group and agent partitions.

• The stored procedure is supplied as is. You may need to change it if it does not work
well with your data. For example, if the names of work groups are repeated, you will
not get the results you expect.

• For example, if your system has the following partitions:

1. • /WGA/WGB/AgentA
• /WGC/WGB/AgentB

You will see the following in the Agents filter after executing
sp_createAgentsFromPartitions:

• WGA/WGB/AgentA
• WGA/WGB/AgentB
• WGC/WGB/AgentA
• WGC/WGB/AgentB

Changing the Job Owner

1. Open the SQL Management Tool.
2. Alter the Stored procedure called sp_createMaintenanceJob.
3. In the following procedure text replace dbuser with an existing database user.

@owner_login_name=N'dbuser'

4. Execute the updated Stored procedure to create the correct job.

Cleaning Low Strictness Events
When there are search/index performance issues, it is recommended that you delete old events using
found=0 by performing one or both of the following procedures:
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Initial Cleanup

Delete all the events using found=0 (low strictness events) older than x=days.

1. Create a SQL job to run the following command. For example purposes the parameter in the following
code is 30 days.
declare @maxCallID int
select  @maxCallID= max(callID) from callmetatbl with (nolock) where
dbo.tod2time(calltime)< dateadd (d,-30,GETUTCDATE())
DECLARE @counter INT;
SET @counter = 1;
deletemore:
SELECT TOP 100000 EntryID
INTO #Temp
FROM callEventsTbl
WHERE callID < @maxCallID and found=0
DELETE FROM callEventsTbl where EntryID in (select EntryID from #temp)
SET @counter = @@ROWCOUNT
IF @counter > 0
BEGIN
DROP TABLE #Temp
WAITFOR DELAY '00:00:01'
GOTO deletemore ;
END
ELSE
BEGIN
DROP TABLE #Temp
END

To ensure that older events are deleted, modify the maintenance job as follows:

1. Connect to the SpeechMiner database.
2. Go to SQL Server Agent and find the Speechminer Maintenance job.
3. Click Properties.
4. Under steps click New to add a step after the last step. The name of the step should be Cleanup

unfound Events.
5. Add the following command to the new step:

declare @maxCallID int
select  @maxCallID= max(callID) from callmetatbl with (nolock) where
dbo.tod2time(calltime)< dateadd (d,-30,GETUTCDATE())
DECLARE @counter INT;
SET @counter = 1;
WHILE @counter > 0
BEGIN

BEGIN TRANSACTION;
DELETE TOP (100000) callEventsTbl

WHERE callID < @maxCallID and found=0
SET @counter = @@ROWCOUNT;
COMMIT TRANSACTION;

END
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Deploying the SQL CLR

After you install the database, you should deploy the SQL Common Language Runtime (CLR)
assembly on the SQL server. To do this, on the Master, you must set the permissions of the
XmlSerializers.dll and enable CLR integration, as explained below.

Important
In order to set the permissions, the user running the SQL services
must have modify permissions on sqlclr.XmlSerializers.dll.

To deploy the SQL CLR:

1. On the SQL server, open the SQL Server Management Studio. (For example, in the Start menu,
under All Programs, select Microsoft SQL Server 2008 R2 > SQL Server Management Studio.)

2. On the left side of the window, right-click the SQL server and then select New Query. A blank text area
opens on the right side of the window.

3. Copy the following commands and paste them into the text area:
use [master]
CREATE ASYMMETRIC KEY SQLCLRTestKey FROM EXECUTABLE FILE =
'\\<Machine_Name>\c$\Program Files (x86)\Genesys\Software\Support\
sqlclr.XmlSerializers.dll'
GO
use [master]
CREATE LOGIN SQLCLRTestLogin FROM ASYMMETRIC KEY SQLCLRTestKey
GO
use [master]
GRANT  EXTERNAL ACCESS ASSEMBLY TO SQLCLRTestLogin

4. In the text area, change <Machine_Name> to the name of the machine on which the SpeechMiner
database was installed.
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5. Above the text area, select Execute. The commands are executed. When the process is completed
successfully, Query executed successfully appears at the bottom of the window.

Important
If you get an error message that says, "The certificate,
asymmetric key, or private key file does not exist or has invalid
format," try changing the path to point at the local drive—for
example, C:\Program Files (x86)\Genesys\Software\
Support\sqlclr.XmlSerializers.dll.

6. Open another New Query.
7. Copy the following commands and paste them into the New Query text area:

EXEC sp_configure 'show advanced options', 1
GO
RECONFIGURE
GO
EXEC sp_configure 'clr_enabled', 1
GO
RECONFIGURE
GO

8. Above the text area, select Execute. The commands are executed. When the process is completed
successfully, CLR integration is enabled, and Query executed successfully appears at the bottom of
the window.

9. Open another New Query.
10. Browse to C:\Program Files (x86)\Genesys\Software\Support.
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11. Run the SQLCLR.sql script.

The clr assembly is created with EXTERNAL_ACCESS. To create an EXTERNAL_ACCESS or UNSAFE
assembly in SQL Server refer to: http://msdn.microsoft.com/en-us/library/ms345106.aspx

Important
The sqlclr.sql script should be deployed in a SpeechMiner
database or the SpeechMiner database should be selected in the
Available Databases section when running the sqlclr.sql script.

Important
If a major change is made to the SQL Server (for example, a disk is
moved), the .dll assembly changes its ID. This change may cause a
sequence of SQL errors. To fix this issue, you must do the following:
1. Copy the following commands and paste them into the New Query text area:

EXEC sp_configure 'clr_enabled', 0
GO
RECONFIGURE
GO
EXEC sp_configure 'clr_enabled', 1
GO
RECONFIGURE
GO

Configuring the Recovery Model

In order to save disk space, it is recommended to set the recovery model of the SpeechMiner
database to Simple.

Important
If you use Log Shipping, set the recovery model to a full or bulk-
logged recovery model. Ensure that logs are not written to the same
hard drive as the database files.
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To set the recovery model to Simple:

1. On the SQL server, open the SQL Server Management Studio. (For example, in the Start menu,
under All Programs, select Microsoft SQL Server 2008 R2 > SQL Server Management Studio.)

2. On the left side of the window, right-click the database and then select Properties. The Database
Properties window opens.

3. On the left side of the window, select Options.
4. On the right side of the screen, under Recovery model, select Simple.

5. Click OK. The setting is implemented, and the window closes.
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Configuring the Autogrowth

Important
It is recommended that you enable instant file initialization. For
details refer to: http://msdn.microsoft.com/en-us/library/
ms175935.aspxshould

To modify the Autogrowth settings:

1. On the SQL server, open the SQL Server Management Studio. (For example, in the Start menu,
under All Programs, select Microsoft SQL Server 2008 R2 > SQL Server Management Studio.)

2. On the left side of the window, right-click the database and then select Properties. The Database
Properties window opens.

3. On the left side of the window, select Files.
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4. On the right side of the screen select Autogrowth in the Data File row. The Change
Autogrowth dialog box opens.
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5. Verify that Enable Autogrowth is selected.
6. Under File Growth, select Megabytes, and then, in the text box on the right enter 1024.
7. Click OK. The setting is changed in the Properties window.

8. On the right side of the screen select Autogrowth in the Log File row. The Change Autogrowth
dialog box opens.

9. Verify that Enable Autogrowth is selected.
10. Under File Growth, select Megabytes, and then, in the text box on the right enter 256.
11. Click OK. The setting is changed in the Properties window.
12. In the Properties window, click OK. The setting is implemented, and the window closes.

</tabber>

Required Folders

Creating the Required Folders

After you install the SpeechMiner components, manually create the shared folders as listed in the
table. These folders will be used by SpeechMiner to store the audio, index, and backup files used by
the system.
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Important
Ensure that enough storage space is available to manually create
the folders. By default, the minimum space required for each folder
is 15GB. This minimum value is set in the minimumFolderSpaceMB
field in the SpeechMiner database monitorTbl table. The
recommended default value for free space is 25GB. This value is
configured in the desiredFolderspaceMB field. If the free space is less
than 25GB, the system will show a warning to let you know that you
are reaching the recommended minimum value for the
minimumFolderSpaceMB field.

All SpeechMiner machines should have access to these shared folders, and they should be shared
with all groups and users that require access to them. It is recommended to create the folders on the
same LAN as the SpeechMiner system components.

The folder names listed below are recommended, for convenience, but you can actually use any
names you choose. In addition, you can create multiple folders for most of the folder types, as
explained below. For information about configuring SpeechMiner to use these folders, see Sites &
Machines.

Important
When you configure the shares, make sure to specifically give write
permissions to the user installing SpeechMiner and to the system
user (SMUSER), both under Sharing and under Security.

Folder Name Description Quantity

Input

Folder in which interactions data
and metadata will be placed by
Uconnector when it retrieves
them from the recording system;
fetchers collect the data from
input folders, prepare it for
processing by SpeechMiner, and
then place it into store folders.

One folder for each fetcher task;
if there are multiple recording
systems, or multiple storage
media used for storing the
unprocessed data, a fetcher task
must be created for each data
source and for each input folder.
For information about deciding
how many fetchers to create, see
Configuring Machines and Tasks.

Interaction Receiver Input

Folder in which the audio files
that are received from the
Genesys Interaction Recording
solution will be placed, and later
processed by the Interaction
Receiver.

One for the entire system.
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Folder Name Description Quantity

Note: This is a different
folder than the Input
folder which is used by
fetchers.

Store
Folder in which interactions will
be placed by fetchers to await
processing by SpeechMiner.

The system can have multiple
store folders—for example, if
there are multiple storage media
used for storing the processed
data, you can create a folder on
each of them.

Filtered
Folder in which interactions with
non-existant or inactive Programs
will be placed.

One for each site in the system.

Grammar
The "package" folder, in which
the rules for processing voice
interactions, including those
defined in SMART, are stored.

One for the entire system.

Note: If you want to
have more than one
copy of the folder, you
can create additional
folders and configure
SpeechMiner to use
them. If you do this,
SpeechMiner will save
the same content in
each of the folders, so
that you will have
backups.

Index
Folder in which the system will
store an index of calls, metadata,
and events, so that they can be
found quickly during searches.

One for the entire system.

Backup
Folder in which SpeechMiner will
store backups of SMART
definition sets (Program, Topic,
and Category definitions).

One for the entire system.

Note: If you want to
have more than one
copy of the folder, you
can create additional
folders and configure
SpeechMiner to use
them. If you do this,
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Folder Name Description Quantity

SpeechMiner will save
the same content in
each of the folders, so
that you will have
backups.
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Setting Up Elasticsearch
Elasticsearch is a fast, clever search engine with the power to handle large data volumes. It is a
scalable search engine based on distributed data storage that performs real-time searches and
supports multi-tenancy. Elasticsearch streamlines backup processes and ensures data integrity. It
uses Javascript Object Notation (JSON) and Java application program interfaces (APIs) and
automatically indexes JSON documents. With Elasticsearch each index can have its own settings and
each index can be easily recovered if a server crashes.

Installing SpeechMiner Setting Up Elasticsearch

SpeechMiner Administration Guide 152



Prerequisites
Before you install and configure Elasticsearch, you must consider the following:

Elasticsearch:

• For details about the supported Elasticsearch version, refer to the Prerequisites section in the
SpeechMiner page in the Genesys Supported Operating Environment Reference Guide.

• All Elasticsearch nodes should be located on the same local network.

Operating Systems:

• For details refer to the SpeechMiner page in the Genesys Supported Operating Environment Reference
Guide .

Indexer:

• Indexer cannot be run on either Linux or Docker.
• IIS Web Service must run on the Indexer machine.
• Multiple indexers can be run with a Load Balancer.

Architecture:

• SpeechMiner does not support active-active site deployment. To create a backup of a cluster using
Elasticsearch API refer to Elasticsearch - Shared File System Repository and Elasticsearch - Monitoring
Snapshot Progress.

Shards and Nodes:

• 1 shard is required for every 2 million interactions in a Genesys Interaction Analytics (GIA) solution and
20 million in a Genesys Interaction Recording (GIR) solution. For example, for a GIA solution if you have
32 million interactions you must have 16 shards.

• The number of shards cannot be changed after SpeechMiner indices are created. SpeechMiner indices
are created when the Elasticsearch Migration Tool is run or when you first run Uplatform (when
migration is not required).

• You must have one Data node for every 8 shards (16 million interactions in a Genesys Interaction
Analytics (GIA) solution and 160 million in a Genesys Interaction Recording (GIR) solution).

• A minimum of 2 Shards and 2 Data nodes are required for redundancy.
• It is recommended that you use 3 Master nodes. Note: if you only use 1 Master node, the entire

system is down when your 1 Master node is down.
• You can use the same Elasticsearch node for both the Master and Data node when working with 5 or

less Data nodes.
• If you have more than 5 Data nodes, we recommend that you have 3 separate Master nodes.
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Install and Configure Elasticsearch

Elasticsearch 5.x

1. Download and run java x64 JVM version 8 or later.
2. Set the JAVA_HOME system environment variable:

a. Enter the Variable name JAVA_HOME.
b. Enter the Variable value. That is, the location of the Destination Folder in which you installed java

x64 JVM version 8 or later. For example, C:\Program Files\Java\jre1.8.0_161

3. Download the Elasticsearch Installer from https://artifacts.elastic.co/downloads/
elasticsearch/elasticsearch-5.6.16.msi.

4. Run Elasticsearch.msi.

5. Click Next in the Locations tab.
6. Click Next in the Services tab.
7. Set the Configuration tab as follow:

• Cluster Name: Select a unique name.

Important
Use the same name in all the ES Nodes you install.

• Node Name: Enter your computer name.
• Role: Select Master or Data as needed and deselect Ingest.

Important
Elasticsearch should include at least one Data node and one Master node.

• Memory: Select ~40% of your available RAM memory and mark Lock JVM memory to prevent the
Elasticsearch memory from being swapped.

• Network host: Enter the server's Hostname or IP Address.
• Discovery: Enter the (number of master nodes) / 2 + 1.

For example, set 2 if there are 3 master nodes in your cluster.
• Unicast Hosts: Add all the master nodes host:port to your cluster.
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Important
If you choose to first create Data node, you can configure Unicast Hosts later in C:\ProgramData\
Elastic\Elasticsearch\config\elasticsearch.yml

8. Click Next > Install.
9. Verify that Elasticsearch is functioning successfully:

a. Open your Browser and in the Address field type
http://<ElasticsearchMachineName>:9200/_cluster/health.
Elasticsearch is working as expected if the page opens and the Status attribute is green or
yellow.
If the page does not open or the Status attribute is red, contact Genesys Customer Care for
assistance.

10. Install SpeechMiner. For details refer to SpeechMiner installation.
11. Configure SpeechMiner. For details refer to SpeechMiner configuration.
12. Verify that the Indexer is running and is able to connect to Elasticsearch:

a. Enter http://<IndexerHostName>/indexer/api/v1/status. The Indexer is running and is able to
connect to Elasticsearch if you see isAvailable:true.

Configure Elasticsearch on Windows

Important
• Edit your Elasticsearch configuration only in rare cases. For example, when adding an

additional Master node to the system.
• You can change the Data nodes indexer after the Indexer installation is complete. To do

this, change the esNodes Environment value in the Indexer machine. You must use
the following format: http://ES1:9200;http://ES2:9200;http://smithES2:9200

• The number of shards and replicas are configured in the SpeechMiner database in the
indexParamsTbl table in the numberOfShards and numberOfReplicas columns.
You must configure the number of shards and replicas before you run UPlatform for the
first time.

• If the customer runs a Migration process, the number of shards and replicas should also
be configured in the LuceneToESMigration tool configuration file.

1. Open C:\ProgramData\Elastic\Elasticsearch\config\elasticsearch.yml.
a. Change the following settings:

• cluster.name

• node.name

• Set bootstrap.memory_lock to true.
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• Set network.host as the hostname or the server IP address.
• Set discovery.zen.minimum_master_nodes to (number of master-eligible nodes / 2 + 1). For

example, if there are three Master-Eligible nodes, then
discovery.zen.minimum_master_nodes should be set to 2.

• Set discovery.zen.ping.unicast.hosts to a list of Master-Eligible nodes.

b. By default, a node is a Master-Eligible node, a Data node and an Ingest node.
• To create a dedicated Master-Eligible node, add the following settings to the [node] section:

node.master: true
node.data: false
node.ingest: false

• To create a dedicated Data node, add the following settings to the node section:
node.master: false
node.data: true
node.ingest: false

2. Open C:\ProgramData\Elastic\Elasticsearch\config\jvm.options.
a. Change the JVM heap' size to ~40% of your RAM memory. For example, if you have 32 GB

RAM, ensure that both -Xmx and -Xms values are set to 12g. For example, -Xms12g and
-Xmx12g.

3. Restart the Elasticsearch service from the Services window to update the settings.

Elasticsearch 7.x

Important
Elasticsearch is built using Java and includes a bundled version of OpenJDK. To use
your own version of Java, set the ES_JAVA_HOME environment variable. If you use a
version of Java that is different from the bundled JVM, we recommend using a
supported version of Java. Elasticsearch will not run if an unsupported version of Java
is used. You may remove the bundled JVM directory when using your own JVM.

Install Elasticsearch 7.17.6
To download Elasticsearch,

1. Download elasticsearch-7.17.6-windows-x86_64.zip from Elasticsearch 7.17.6. Note: Select the
Windows option to download a zip package.

2. Unzip it with your unzip tool. This creates a folder called elasticsearch-7.17.6.

To install Elasticsearch as a Windows service, do the following steps:

1. Open Command Prompt and navigate to the elasticsearch-7.17.6 > bin folder.
2. Run the command, elasticsearch-service.bat install. This command installs Elasticsearch as a
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Windows service.
3. Press Windows+R and type services.msc, and press Enter. This opens the Services window that

lists all Windows services.
4. Verify that Elasticsearch 7.17.6 service is available and then start the service.

Important
You can also refer to the official Elasticsearch documentation on how to install it on
Windows.

After the installation is completed, proceed to the Configure Elasticsearch on Windows section
below for instructions on configuring Elasticsearch.

Install Elasticsearch 7.16.3

1. Download the Elasticsearch Installer from https://artifacts.elastic.co/downloads/
elasticsearch/elasticsearch-7.16.3.msi

2. Run Elasticsearch.msi.

3. Click Next in the Locations tab.
4. Click Next in the Services tab.
5. Set the Configuration tab as follow:

• Cluster Name: Select a unique name, for example elasticsearch.

Important
Use the same name in all the ES Nodes you install.

• Node Name: Enter your computer name.
• Role: Select Master or Data as needed and deselect Ingest.

Important
Elasticsearch should include at least one Data node and one Master node.

• Memory: Select ~40% of your available RAM memory and mark Lock JVM memory to prevent the
Elasticsearch memory from being swapped.

• Network host: Enter the server's Hostname or IP Address.
• HTTP port: Set as 9200.

Installing SpeechMiner Setting Up Elasticsearch

SpeechMiner Administration Guide 157



• Transport port: Set as 9300.
• (Optional) This is the first master in a new cluster: Leave it empty.
• Seed Hosts: Add all the master nodes host:port to your cluster.

Important
If you choose to first create Data node, you can configure Seed Hosts later in C:\ProgramData\Elastic\
Elasticsearch\config\elasticsearch.yml

6. Click Next > Install.
7. Verify that Elasticsearch is functioning successfully:

a. Open your Browser and in the Address field type
http://<ElasticsearchMachineName>:9200/_cluster/health.
Elasticsearch is working as expected if the page opens and the Status attribute is green or
yellow.
If the page does not open or the Status attribute is red, contact Genesys Customer Care for
assistance.

8. Install SpeechMiner. For details refer to SpeechMiner installation.
9. Configure SpeechMiner. For details refer to SpeechMiner configuration.

10. Verify that the Indexer is running and is able to connect to Elasticsearch:
a. Enter http://<IndexerHostName>/indexer/api/v1/status. The Indexer is running and is able to

connect to Elasticsearch if you see isAvailable:true.

Configure Elasticsearch on Windows

Important
• Edit your Elasticsearch configuration only in rare cases. For example, when adding an

additional Master node to the system.
• You can change the Data nodes indexer after the Indexer installation is complete. To do

this, change the esNodes Environment value in the Indexer machine. You must use
the following format: ;http://ES1:9200/

• The number of shards and replicas are configured in the SpeechMiner database in the
indexParamsTbl table in the numberOfShards and numberOfReplicas columns.
You must configure the number of shards and replicas before you run UPlatform for the
first time.

• If the customer runs a Migration process, the number of shards and replicas should also
be configured in the LuceneToESMigration tool configuration file.

1. Open C:\ProgramData\Elastic\Elasticsearch\config\elasticsearch.yml.
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a. Change the following settings:
• cluster.name

• node.name

• Set bootstrap.memory_lock to true.
• Set network.host as the hostname or the server IP address.
• Set cluster.initial_master_nodes as the name of the master nodes. This name is the host

name that you provided during the installation of Elasticsearch.
• Set discovery.seed_hosts to a list of Master-Eligible nodes.

b. By default, a node is a Master-Eligible node, a Data node and an Ingest node.
• To create a dedicated Master-Eligible node, add the following settings to the [node] section:

node.master: true
node.data: false
node.ingest: false

• To create a dedicated Data node, add the following settings to the node section:
node.master: false
node.data: true
node.ingest: false

2. Open C:\ProgramData\Elastic\Elasticsearch\config\jvm.options.
a. Change the JVM heap' size to ~40% of your RAM memory. For example, if you have 32 GB

RAM, ensure that both -Xmx and -Xms values are set to 12g. For example, -Xms12g and
-Xmx12g.

3. Restart the Elasticsearch service from the Services window to update the settings.

Elasticsearch 8.x

Important
Elasticsearch 8.x enables security (TLS/SSL and user authentication) by default.
Applications must be configured to use https:// and handle authentication.
SpeechMiner Compatibility: This version of SpeechMiner supports both Elasticsearch 7.x and
Elasticsearch 8.x.

Java Requirement: Elasticsearch 8.x includes a bundled version of OpenJDK. To use
your own version of Java, set the ES_JAVA_HOME environment variable. If you use a
different JVM, Only supported Java versions (11 and 17) are allowed. Elasticsearch will
not run if an unsupported version of Java is used. You may remove the bundled JVM
directory when using your own JVM.

Install Elasticsearch 8.x
To download Elasticsearch,

Installing SpeechMiner Setting Up Elasticsearch

SpeechMiner Administration Guide 159



1. Download elasticsearch-8.18.0-windows-x86_64.zip from Elasticsearch 8.18.0. Note: Select the
Windows option to download a zip package.

2. Unzip it with your unzip tool. This creates a folder called elasticsearch-8.18.0.

To install Elasticsearch as a Windows service, do the following steps:

1. Open Command Prompt and navigate to the elasticsearch-8.x.x > bin folder.
2. Run the command, elasticsearch-service.bat install. This command installs Elasticsearch as a

Windows service. Note: During this initial run, the console will display an enrollment token and a
password for the elastic superuser. Copy and save these securely. You will need them for configuration
and client connections.

3. Press Windows+R and type services.msc, and press Enter. This opens the Services window that
lists all Windows services.

4. Verify that Elasticsearch 8.x.x service is available and then start the service.

Important
You can also refer to the official Elasticsearch documentation on how to install it on Windows.

5. Verify that Elasticsearch is functioning successfully:
a. Open your Browser and in the Address field type

https://<ElasticsearchMachineName>:9200/_cluster/health.
• Note: You will need to accept any certificate warnings and provide the elastic username and its

generated password when prompted.

b. Elasticsearch is working as expected if the page opens and the Status attribute is green or yellow.
c. If the page does not open or the Status attribute is red, contact Genesys Customer Care for

assistance.

6. Install SpeechMiner. For details refer to SpeechMiner installation.
7. Configure SpeechMiner. For details refer to SpeechMiner configuration.
8. Indexer appsettings.json configuration parameters should be configured according to the below table:

Parameter Name Default value Description Valid values

IsSSLEnabled true

Should be set to true,
if ES8
xpack.security.http.ssl.enabled
parameter is set to
true

true,false

IsSecurityEnabled true

Should be set to true,
if ES8
xpack.security.enabled
parameter is set to
true

true,false

9. Verify that the Indexer is running and is able to connect to Elasticsearch:
a. Enter http://<IndexerHostName>/indexer/api/v1/status. The Indexer is running and is able to
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connect to Elasticsearch if you see isAvailable:true.

After the installation is completed, proceed to the Configure Elasticsearch on Windows section
below for instructions on configuring Elasticsearch.

Configure Elasticsearch on Windows

Important
Edit your Elasticsearch configuration only in rare cases. For example, when adding an
additional Master node to the system.

1. Open C:\ProgramData\Elastic\Elasticsearch\config\elasticsearch.yml.
a. Change the following settings:

• cluster.name

• node.name

• Set bootstrap.memory_lock to true.
• Set network.host as the hostname or the server IP address.
• Set cluster.initial_master_nodes as the name of the master nodes. This name is the host

name that you provided during the installation of Elasticsearch.
• Set discovery.seed_hosts to a list of Master-Eligible nodes.
• HTTP port: Set as 9200.
• Transport port: Set as 9300.

b. By default, a node is a Master-Eligible node, a Data node and an Ingest node.
• To create a dedicated Master-Eligible node, add the following settings to the [node] section:

node.master: true
node.data: false
node.ingest: false

• To create a dedicated Data node, add the following settings to the node section:
node.master: false
node.data: true
node.ingest: false

2. Open C:\ProgramData\Elastic\Elasticsearch\config\jvm.options.
a. Change the JVM heap' size to ~40% of your RAM memory. For example, if you have 32 GB

RAM, ensure that both -Xmx and -Xms values are set to 12g. For example, -Xms12g and
-Xmx12g.

3. Restart the Elasticsearch service from the Services window to update the settings.
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Configure Users and Certificates for Elasticsearch 8.x

Important
The steps described in this procedure are meant to be an example for developers and
should not be used in production. For a production environment, you should follow
your own company's security policies for creating and signing certificates and creating
users.

When securing your Elasticsearch 8.x cluster, you need to set up both:

• users & passwords for authentication
• SSL/TLS certificates for HTTPS and inter-node security

Below are the steps for both manual and automatic approaches.

Default Certificates (Windows):

During the first startup, Elasticsearch automatically generates self-signed certificates for HTTP and
Transport Layer Security (TLS). These certificates are typically stored in the <ES_HOME>\config\
certs\ directory. The http_ca.crt file is the CA certificate used to sign the HTTP layer certificates. You
may need to import this into your client applications' trust stores for https connections if they don't
trust self-signed certificates by default. To download SSL Certificate

1. Open Elasticsearch URL in browser: https://<ElasticsearchMachineName>:9200
2. A certificate warning will appear. Click on "Not Secure" > Certificate (Invalid) > View Certificate.
3. Click Details > Copy to File.
4. Follow the wizard to export as Base-64 encoded X.509 (.CER) format.

SSL/TLS Certificate Generation:

If you need to generate new self-signed certificates for HTTP communication (e.g., with custom
hostnames or to replace the defaults):

1. Run the certutil helper:
a. Navigate to <ES_HOME>\bin in Command Prompt (as Administrator).
b. Run:

elasticsearch-certutil http

c. You will be prompted to:
• Generate new CA or use existing.
• Enter node hostnames/IPs that Elasticsearch will use.
• Choose an output filename (e.g., http-certs.zip by default).

d. This command generates a ZIP file containing the CA certificate and the node certificates.
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2. Extract the certificates:
a. Navigate to the directory where http-certs.zip was generated.
b. Run:

powershell Expand-Archive -Path http-certs.zip -DestinationPath certs

c. This will create a certs folder (or overwrite an existing one) containing the extracted certificates
(e.g., ca.crt, node-1.p12). Copy this certs folder to <ES_HOME>\config\.

3. Configure HTTPS in elasticsearch.yml:
a. Open C:\elasticsearch-8.x.x\config\elasticsearch.yml.
b. Add/Modify the following settings to point to your newly generated certificates:

xpack.security.enabled: true
xpack.security.http.ssl.enabled: true
xpack.security.http.ssl.keystore.path: certs/node-1.p12
xpack.security.http.ssl.truststore.path: certs/node-1.p12
# If your .p12 requires a password, add it securely to the keystore:
# cd <ES_HOME>\bin
# elasticsearch-keystore add xpack.security.http.ssl.keystore.secure_password

c. Note: node-1.p12 is a common default filename; use the actual name if different.

How to add the Certificate to the Trust Store:

1. Open Run (Win + R) and type mmc.
2. Go to File > Add/Remove Snap-in > Certificates > Add > Computer Account.
3. Expand Trusted Root Certification Authorities > Certificates.
4. Right-click Certificates > All Tasks > Import.
5. Select your saved .cert file and complete the import wizard.
6. Restart browser and verify the certificate is now trusted.

Create a New user:

1. Open Command Prompt as Administrator and navigate to the elasticsearch-8.x.x > bin folder.
2. Run the command:

elasticsearch-users useradd smuser123 -p smuser123 -r superuser

Important: Replace smuser123 with a strong, unique password.

Note: Please ensure user passwords do not contain the "@" symbol.

Below are some useful references from the official Elastic documentation and community
resources:

• How to enable security, passwords, HTTPS, etc. → Set up minimal security for Elasticsearch
• Details about the elasticsearch-certutil helper script. → Elasticsearch certutil documentation
• Which users and roles are already available. → Built-in users and roles
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Upgrade Elasticsearch
To upgrade Elasticsearch using the Rolling Upgrades procedure refer to the Elasticsearch website.

See: https://www.elastic.co/guide/en/elasticsearch/reference/5.6/rolling-upgrades.html.

Important
If you are upgrading to SpeechMiner 8.5.512.07 and above you must upgrade
Elasticsearch to 5.6.16.
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Uninstalling SpeechMiner
SpeechMiner components can be installed on one machine or numerous machines. If SpeechMiner
components are installed on more than one machine, you must perform the following procedure on
each machine.

Procedure

1. Double click uninst.exe in the C:\Program Files (x86)\Genesys\software.

The SpeechMiner component is uninstalled.
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SpeechMiner Silent Installation
A SpeechMiner Silent installation is a method of installing SpeechMiner without user interaction. That
is, it is not necessary for the user to direct the installation process.

The SpeechMiner Silent installation bypasses all levels of user interaction by reading instructions that
are coded within a answers.ini response file.
The answers.ini file contains replies to the prompts that the installer would get from the users input
in a Wizard installation.

Before you begin a Silent installation, consider the following:

• The Silent installer ignores window errors (for example, "could not open file"). All errors will appear in
the installation log located in the installation path.

• All of the options available in the Wizard installation can be configured in the answers.ini file. If the
installer cannot find this file an error will appear in the log file and SpeechMiner will not be installed.

• The answers.ini file is divided into sections. These sections represent the Wizard installation pages.
• The Silent uninstall creates a log file in a directory that is configured by the user. This log contains errors

and information about the unistall.
• When installing SpeechMiner, the installation path cannot be longer than 50 characters. A path longer

than 50 characters will not enable you to install SpeechMiner.

Important
The Indexer component cannot be uninstalled using a SpeechMiner Silent Installation

To perform a SpeechMiner silent installation:

1. Prepare the answers.ini file.
a. Open a text file and save it with the name answers.ini.
b. Enter the following code to determine the SpeechMiner deployment you want to install (for

example, an Analytics & Recording deployment):

[Installation Mode]
Mode=Analytics and Recording UI
You can also install a Recording UI Only or a Analytics Only deployment.

c. Enter the following list and select the components that should be installed.
Only components that have the value on will be installed.

[SMComponents]
Uplatform=on
Smart=on
Web=on
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SMConfig=on
ULogger=on
Indexer=on
SMUpgrade=on
Interaction Receiver=off
Database=off

d. Enter the supported language list to select the language you would like to install. For the full list
refer to SpeechMiner Language Support
Only languages with the value on will be displayed.

[Languages]
Some lang=on
Other lang=off

e. Set nodes for the Indexer:

Enter the following to set several nodes for the Indexer: Note: the nodes path here is just an
example.
[SMComponents]
Uplatform=on
Indexer=on
[Indexer]
Nodes=http://esTest1:9200;http://esTest2:9200
For ES8 deployments,
Nodes=https://username:password@ESserver:9200/;https://username:password@ESserver2
:9200/

Enter the following to set a single node for the Indexer: Note: the nodes path here is just an
example.
[Indexer]
Nodes=http://esTest1:9200
For ES8 deployments, Nodes=https://username:password@ESserver:9200/

f. Enter the following database credentials list.
If the database component Windows Authenticated User is set to off, the value of each row
(that is, field) under the component should be empty.
If the database component Windows Authenticated User is set to on, only the values in the last
two rows should be empty.

[Database]
Windows Authenticated User=off
DB Server=<server>
DB Name=<Name>
DB User=<User>
DB Password=<Password>

g. Enter the following general information.
If the reboot value is true, the computer will be automatically restarted after the installation.
The uninstall log path must exist. The path for the uninstall log is the value of uninstall log
path.
If this value is empty, the path will be C:\Temp, and the user should verify that C:\temp exists. The
uninstall log name is the value of uninstall log name. If this value is empty, the name will be
SMuninstLog.txt.
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[General]
reboot=false
uninstall log path=C:\Temp
uninstall log name=SMuninstLog.txt

h. Save the answers.ini file.

9. Open the Command Line as an administrator.
a. Run the following command in the folder that contains SpeechMinerInstall.exe:

start "SpeechMinerInstall" /wait "SpeechMinerInstall.exe" /S

If Indexer is also installed add /auth=user:password to the end of the command line. For
example: start SpeechMinerInstall /wait SpeechMinerInstall.exe /S
/ANSWERS_PATH=C:\SMInstallation /auth=dummy:dummy . The user:password value
should be the same values used when you set the authentication for the indexer. See Step
#10 in the Installing the SpeechMiner Components > Installing Using the Wizard.

b. If the answers.ini file is not in the same folder as SpeechMinerInstall.exe, add the following to the
end of the command:

/ANSWERS_PATH=<answers file path>

c. If the installation path is not C:\Program Files(x86)\Genesys\Software for a 64 bit machine or
in C:\Program Files\Genesys\Software for a 32 bit machine, add the following to the end of the
command.
The installation path must be the last parameter used in the command line and it should not
contain quotes (even if the path contains spaces).

/D=<installation path>

SpeechMiner is installed successfully.

Important
To uninstall SpeechMiner in Silent mode, run the following command in the C folder:
start "uninst" /wait "<uninst.exe path>\uninst.exe" /S .
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Configuring SpeechMiner
This topic explains how to configure SpeechMiner after it is installed. SMConfig is used to perform the
majority of the SpeechMiner configuration. For information about installing SMConfig, see Installing
the Components.

SMConfig is a Windows application that can be installed on any machine on your network. Once
installed it can be used to configure the entire SpeechMiner system.

The following sections describe the steps that you must perform before you can begin working with
SMConfig:

Permissions

Required Permissions

• The user account from which SMConfig is opened must have read, write, and modify permissions on the
local installation folder and files.

• For most of the configuration changes you can perform using SMConfig, you will need Administrator
privileges on the current machine or on other machines. For each configuration task described below,
the required permissions are listed. If you are running SMConfig as a non-administrator user, and errors
are generated during the configuration process, make sure that you have the right permissions for the
task.

• The web application user used to connect to the database must have db_datareader and db_datawriter
roles.

• In Windows Vista and later versions of Windows, if User Access Control is enabled, SMConfig will
automatically require you to run it with administrator privileges. If User Access Control is disabled, it
is recommended to manually run SMConfig with administrator privileges. To do this, right-click the
SMConfig icon, and then select Run as administrator.

For more information on the permissions required for the other SpeechMiner components, see
Configuring Permissions.

Database Connection

Configuring SpeechMiner SpeechMiner Silent Installation

SpeechMiner Administration Guide 169



Encrypting the Connection to the Database

The connection between SMConfig and the database can be encrypted to ensure that confidential
data cannot be intercepted and viewed by unauthorized people. This option is configured by the
system administrator on the SQL database server. Three encryption settings are defined there:

• Always use encryption
• Never use encryption
• Use encryption when the user requests it

If the latter setting is implemented in your system, you can choose to use an encrypted connection
when you log into SMConfig. If the database server is configured to always encrypt or not to encrypt
at all, you cannot change this option when you log into SMConfig, and selecting one of the options
has no affect.

Starting SMConfig

Starting SMConfig

SMConfig can be run on any machine in your system in which it is installed. During installation, an
SMConfig icon is placed on the desktop of the machine.

You can log into SMConfig in one of the following ways:

• Using a SpeechMiner user account
• Using the Windows account you used to log onto the PC
• Using a Genesys user account and connecting to a Genesys configuration server for confirmation

To open SMConfig:

1. On the desktop of the computer, double-click the SMConfig icon. The SMConfig - Login dialog box
appears.
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2. Select the type of user account you want to use to log into SpeechMiner:
• SpeechMiner Authentication: Use the username: administrator and the password: Enterprise.
• Windows Authentication: Use the username and password you used to log into Windows.
• Genesys Authentication: Use a Genesys username and password.

3. In the Username and Password fields, type your username and password.

Important
If you are logging in using Windows Authentication, your
username and password are inserted automatically, and the
username is in the form domain\username.

4. If this is the first time you are opening SMConfig on this computer, or if you want to change the existing
database settings, click the DB Settings arrow. The Login dialog box expands and displays the
database settings.

Important
If you do not need to set or modify the database settings, skip
this and the next step.
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5. Fill in the fields as follows:
Field Description

SQL Server Authentication / Windows
Authentication

Select SQL Server Authentication if the username
and password for accessing the database are
managed on the SQL server. SelectWindows
Authentication if you log into the database using
the same username and password you used to
log into Windows.

Note: If you are not sure which
option to choose, consult your
system administrator.

Server

The name of the database server

Note: If the database is a named
instance on the server, enter both
the server name and the instance
name, in the format server_name\
instance_name.

Port The port to use to connect to the database server
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Field Description

Note: This should normally be left as
<default>, even if the database is a
named instance.

Username

The username to use to connect to the database

Note: This field is not available
when Windows Authentication is
selected. In this case, the username
is automatically taken from the
username used to log into Windows.

Password

The password to use to connect to the database

Note: This field is not available
when Windows Authentication is
selected. In this case, the password
is automatically taken from the
username used to log into Windows.

Database The name of the database

Encrypt connection

If encrypting the connection to the database is
optional in your system, select this option to
activate encryption.

Note: If encryption is always turned
on in your system, selecting or
clearing this option will have no
effect. If encryption is always turned
off in your system, selecting this
option will prevent SMConfig from
connecting to the database server
and you will not be able to log in. In
this case, an error message stating,
Could not connect to database.
Please check database settings,
will appear when you click OK.

6. Enter the name of the server and the port to use to verify the user information, as follows:
• Server—Enter the name of the configuration server.
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• Port—The port to use to connect to the configuration server in order to verify the user information.

After setting or updating the configuration server host and port in SMConfig (either in the Login
window, or in the Sites and Machines panel), the IIS should be restarted.

7. Click OK. You are logged into the system, and the SpeechMiner Configuration Tool (SMConfig)
window opens with the first screen, Sites and Machines, displayed.

Important
If a user attempts to log into SMConfig with Genesys
Authentication, before defining the Configuration Server in the
Sites and Machines tab, an error occurs.
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The SMConfig interface contains panels (Sites and Machines, Reports, etc.) in which various
categories of configuration settings can be accessed.

To open a panel:

• On the left side of the window, select the icon of the panel. The panel opens on the right side of the
window.
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Saving Changes

Saving the Changes in SMConfig

Changes you make in one panel of SMConfig are saved temporarily if you open a different panel.
Nonetheless, you must click Save in each panel to save the settings in that panel.

After you click Save, before the settings are actually saved, some settings go through a validation
process. Validation ensures that the locations specified for folders and files exist and can be
accessed, and checks that certain important parameters are configured properly. Certain key settings
are always validated when Save is selected; you can choose to have the system validate certain
others if you wish.

During the validation process, a Progress window is displayed. The window lists the stages of the
validation process as they are completed, with an icon indicating the status of each stage.

Icon Description

Success: Validation of the stage was successful.
Warning: Validation of the stage was successful,
but some problematic issues were detected.
Failure: Validation of the stage failed, because of
the problems indicated. No changes to the
configuration were saved.

When the process is complete, the Close button at the bottom of the window becomes active. If
validation was successful, the last line of the log says Done. If the Progress window contains any
stages that failed (indicated by ), the entire save process is cancelled. The following screenshots
depict examples of each status:
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To see details about a warning or failure:

• In the Progress window, select the item. Details are displayed at the bottom of the window.
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After the configuration changes are successfully saved, a Restart Services message appears.

Select Yes to restart all of the services, or No if you prefer to restart them later (either after you
make additional configuration changes, or manually from the Services panel.)
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Using SMConfig

This section describes how to use SMConfig to configure the Enterprise.
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Using the SMConfig to Configure
SpeechMiner
The section describes the SMConfig panels.

Important
When you first configure your system:
1. Update the SMConfig Licenses Panel.
2. Save your changes and exit.

3. Open SMConfig to configure additional panels.

Sites & Machines

The first panel of the SMConfig application, Sites & Machines, is used to configure the layout of
the system as well as some other system-wide parameters.

This tool enables you to configure sites, machines and tasks, and system index searches.

For additional information, refer to the following sections:

• Configuring Sites
• Configuring Machines and Tasks
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Configuring Sites

A site is a single geographical location in which SpeechMiner servers are installed. One SpeechMiner
system, which has one database, can have a number of sites. All the sites configured in the Site
section of the Sites & Machines panel are locations that connect to the SpeechMiner database. If
your SpeechMiner is set up in more than one location, configuring each location as a site helps to
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minimize the bandwidth needed for call processing.

Every SpeechMiner system has at least one site. The first site is created automatically, and is initially
called "default." Immediately after SpeechMiner is installed, the "default" site is automatically
configured to include all the servers in the local network. You can change the name of the default
site, and add sites, as required. If you create new sites, you can move servers that are listed under
the default site to other sites.

Required Permissions
Validation of the input, filtered, store, and installation folders can only be performed if the
user account used to log into SMConfig has administrator permissions on the machine that is being
configured. This is because SMConfig must use the $ share to check that the installation folder exists.

Configuring the Default Site
Some of the settings in the Sites & Machines panel are configured per site, and others are
configured for the entire system. This section explains how to configure the default site by
configuring the site and system settings defined in the Sites & Machines panel.

After you configure the settings, and click Save to save them, SMConfig automatically validates the
key folders you specified by checking that they exist and are configured with the required
permissions. Validation is always performed on the items listed under Machines and Tasks. Validation
of other settings is optional, as indicated below. For additional information, see Saving Changes.

To configure the default site:

1. In the Sites & Machines panel, fill in the fields as follows:
Field Description

Site Name The name of the site. Initially, the site is called
"default." Modify this field to change the name.

Filtered Dir
Enter the location of the folder called filtered that
you created (see Creating the Required Folders).
For example, the required path format is
\\computer\data\input.

Input Folders

Click to add a line to the list. Then, modify
the line to give the location of the input folder
you created (see Creating the Required Folders).

If you will be using multiple input
folders for this site, repeat this
procedure to add additional lines to
the list, as necessary. For example,
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Field Description

the required path format is
\\computer\data\input.

Store Folders

Click to add a line to the list. Then, modify
the line to give the location of the store folder
you created (see Creating the Required Folders).

If you will be using multiple store
folders for this site, repeat this
procedure to add additional lines to
the list, as necessary.

Validate input, filtered, store, and installation
folders

Select this option if you want SMConfig to
validate the input, filtered, store, and
installation folders after you click Save (see
Saving Changes).

Cross site processing allowed

If your system will have more than one site,
select this option to enable processing of
interactions from other sites at this site. When
this option is selected, the Recognizers at this
site will give priority to processing local files, but
no local files need to be processed, they will
process calls from remote locations. Selecting
this option can improve the overall performance
of the system, but it does mean that audio files
will be transmitted over the network.

Prefer compressed remote audio

If cross-site processing is activated, select this
option to give priority to compressed audio files
if they are available. If this option is selected,
when call data is transmitted from a remote site
to this site for processing, the system will send
the compressed versions of calls if they are
available. In this case, the compressed audio will
be decompressed before being processed by the
Recognizer. Even so, the quality of the audio
input may be diminished slightly, and this may
impact the recognition quality.

Note: This option is only available
when Cross site processing allowed
is selected.

Machines and Tasks
List all the SpeechMiner machines at the site, and
configure the tasks that will run on each
machine, as explained under Configuring
Machines and Tasks.
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Field Description

Package Folders

Click to add a line to the list. Then, modify
the line to give the location of the grammars
folder you created (see Creating the Required
Folders).

If you will be using multiple
grammars folders in your system,
repeat this procedure to add
additional lines to the list, as
necessary. For example, the required
path format is \\computer\data\
input.

Backup Folders

Click to add a line to the list. Then, modify the
line to give the location of the backup folder you
created (see Creating the Required Folders).

If you will be using multiple backup
folders in your system, repeat this
procedure to add additional lines to
the list, as necessary. For example,
the required path format is
\\computer\data\input.

Email

Fill in the fields in this area as follows:
• Email Server: The name of the email server

SpeechMiner must use to send alerts,
notifications, and reports

• Alerts Email: The email address
SpeechMiner must use as the sender address
when it sends email notifications

Default Workgroup

Enter the default work group. If an interaction is
not associated with a work group, the system will
assign this work group to the specific interaction.

Note: The default work group must
include a slash (/) at the beginning
of the work group name.

Default Language

Select the default language for new Programs
that are opened in SMART. (If additional
languages are installed in SpeechMiner, the
languages of individual Programs can be
changed in SMART when the Programs are
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Field Description
created.)

Note: Only the languages selected
under Select Languages appear in
the dropdown list.

Select Languages

Select all of the languages for which you will
want to perform speech recognition. These
languages will appear as language options in
SpeechMiner and in SMART.

Note: In order to create and apply
Programs in these languages, their
language packs must also be
installed. The language packs are
installed as part of the SpeechMiner
installation process (see Running the
Setup Program and Installing
SMART). Note:The language
selections here do not affect the
language of the web-based
interface. The interface language is
selected in the settings of the Web
server, under Machines & Tasks.

Configuration Server

If users will use Genesys credentials to log into
any of the SpeechMiner components from this

site, Click to add a line to the list and
modify it so that it points to the location of the
Genesys Configuration server (that is,
<config_server>:<port>).
• Server Name: The name of the machine on

which the Genesys configuration server is
installed

• Port: The port SpeechMiner should use to
connect to the configuration server

To configure backup configuration
servers, add additional lines with
their details. After setting or
updating the configuration server
host and port in SMConfig (either in
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Field Description

the Login window, or in the Sites and
Machines panel), the IIS should be
restarted.

Config Server Settings

The following must be configured in the systems
Configuration Server:
• Configuration Server Username and

Password: The Configuration Server user
and password that SpeechMiner applications
should use when connecting to the
Configuration Server. Verify that the specific
user was given read and execute permissions
for the tenant object in the configuration
server and all its objects in the tenant object
hierarchy.

• Application Name: The prefix for the
SpeechMiner applications. For example, if the
prefix is ‘Speechminer’, the Web Server will
use the Speechminer_Web and
Speechminer_Web_node applications

• User Application Name: The name of the
Configuration Manager application object
that will be used to validate user credentials.
For details, see Configuring Permissions.

2. Click Save. The system validates the settings, and then, if the validation is successful, implements
them. The Progress window opens and shows information about the implementation process.

Adding a Site
If your system will have servers at more than one site, you can add additional sites to the
configuration in SMConfig. A new tab is added to the Sites & Machines panel for each site you
create. The settings in the upper half of the panel, under Sites and Machines and Tasks are
configured for each site. The settings in the lower half of the panel are configured for each system,
and thus are not changed when you add an additional site.

Before you begin adding the site, create filtered, input, and store folders on a machine at the
new site (see Creating the Required Folders).

To add a site:

1. In the upper-left of the Sites & Machines panel, select . A new tab is added to the site-setting
area in the upper part of the panel.

2. Under Site Name, modify the name as required. The name of the tab is automatically updated.
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3. Under Sites and Machines and Tasks, fill in the fields for the new site.

Configuring Machines and Tasks

The Sites & Machines panel must list all the machines used by SpeechMiner at each site, and the
tasks they will run. Before you begin configuring the settings in this panel, map out the machines in
your system, their specifications, the sites at which they are located, and the tasks that must be
performed at each site. Using this information, you can decide which tasks to run on each machine.

Important
In SMConfig, in the Sites and Machines panel, when the system tasks
are saved, warning messages indicate that the system does not
include Categorizer and Exploration tasks. These messages can be
ignored when working in Recording UI Mode, since these tasks are
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not available in this mode.

Adding Machines to a Site
You can add machines to sites as required.

To add a machine to a site:

1. Under Machines and Tasks click .

2. In the Properties window, enter one of the following values for <machine name>:
• Machine Name
• Machine IP
• Fully Qualified Domain Name (FQDN)

3. Click OK. The machine is added to the list of site machines.

Choosing Which Tasks to Run on Each Machine
Before you can configure the machines and their tasks, you must decide which tasks to assign to
each machine. Each machine can have a number of different roles at one site. The entire system
must include machines that fill all of the following roles:

• Web server: Runs the SpeechMiner web-based interface.
• Interaction Receiver: Used for the Recording UI and Recording+Analytics modes. It receives

interaction data and metadata from the Genesys Interaction Recording system, inserts it into the
SpeechMiner database, and places the data files in the Store folder to await processing.

• Fetcher: Takes unprocessed interaction data and metadata from the input folder, inserts it into the
SpeechMiner database, prepares the data files for processing by SpeechMiner, and places it in the store
folder to await processin.

• Call Recognizer: Processes call audio according to the requirements of the program to which the call
belongs by transcribing the text and identifying topics and other events in it.

• Scheduler: Sends data to the Indexer Service, creates Quality Management (QM) Evaluation Sessions
and archives QM.

• Report caching: Runs reports that are included in active users' Views pages overnight so that they can
be displayed quickly in their widgets when the users open their Views pages; the amount of time to
store cached results is configured in the Reports panel.

• Exploration: Performs the data analysis required for the Exploration feature of the web-based
interface.
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• Recategorizer: Assigns Categories to the processed interactions in accordance with the Category
definitions defined in the system.

• Text Recognizer: Processes written interaction input data and identifies Topics and other events in it.
• Monitor: Enables the monitoring of the selected machine.

Normally, each site will have:

• One Web server
• One or more fetchers
• Several Recognizers, Recategorizers, and Monitors
• One or more Indexer tasks.

Optimizing the Number of Fetchers

To optimize the rate at which interaction data is fetched, multiple fetchers can run simultaneously.
You can configure SpeechMiner to employ multiple fetchers on one or more machines. However, if too
many fetchers run on a single machine simultaneously, the CPU may not be able to run all of its tasks
efficiently. The optimal number of fetchers to run on a single machine is a function of how powerful
the CPU of the machine is. A general starting point on a new SpeechMiner installation is to assign 0.5
fetcher tasks per core on each fetcher machine. Normally, two fetchers will maximize the CPU usage
on a quad-core machine.

Optimizing the Number of Call Recognizers

To maximize the speed of interaction processing, multiple Call Recognizers can run simultaneously.
You can configure SpeechMiner to employ multiple Call Recognizers on one or more machines.
However, if too many Call Recognizers run on a single machine simultaneously, the CPU may not be
able to run all of its tasks efficiently. The optimal number of Call Recognizers to run on a single
machine is a function of how powerful the CPU of the machine is and how many Topics must be
recognized concurrently. A general starting point on a new SpeechMiner installation is to assign 1.5
Recognizer tasks per core on each Recognition machine. Normally, six Call Recognizers will maximize
the CPU usage on a quad-core machine.

Important
The total number of recognition tasks cannot exceed the number in
the SpeechMiner license under
<maxCallProcessing>xx</maxCallProcessing>.

The Call Recognizers in your system are run by the recognition manager. You can configure the
maximum number of Call Recognizers that should be managed by each Recognition manager. If the
number is too low, performance may be impacted; if it is too high, the process may run out of
memory. The number of recognition machines and processes should be defined by the sizing guide.
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Optimizing Exploration Tasks

Optimizing exploration tasks speeds up the data analysis required for the web-based interface
Trending. The Exploration task and all its sub-tasks are run simultaneously according to a scheduler
mechanism and scheduling parameters (for example, continuously, once every 24 hours, and so on).
A general starting point is to define one machine with Exploration. However, when working with a
very large data set, having all the sub-tasks on the same machine as the Exploration task can impact
performance due to the large CPU/Memory load required. To reduce the negative impact on
performance and to avoid a single point of failure and a loss of redundancy, it is recommended that
you define the Exploration task on more than one machine. Since the Exploration scheduler supports
load balancing the tasks between several machines, there are more hardware resources available for
each task and subsequently each task runs faster.

Important
To configure a Trending Cluster Task for a fixed period longer than
two weeks, you must change the default purging fragments value.
For details, see the Purging Fragments Configuration section in the
Additional Configurations page.

Configuring the Properties of a Machine
You configure the properties of a machine by selecting the tasks it should perform.

To configure the properties of a machine:

1. Under Machines & Tasks, double-click the machine. A Properties window opens and displays the
properties of the machine.
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2. Select all of the tasks the machine should perform.
3. If you selected Web Server, select the protocol, specify the port and virtual folder, and select the

language of the web-based interface.

Important
• It is recommended that in systems with Analytics the language selected here

should be one of the languages selected in the Sites & Machines panel.
• For the language change to take effect you must update the configuration files in
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the web machines using the Service panel.

4. If you selected Interaction Receiver, click the Parameters button to its right. In the dialog box, select
the protocol and specify the port. If you are working with an Analytics deployment, enter the location of
the Interaction Receiver Input folder in which the audio files received from the Genesys Interaction
Recording solution will be placed, and then click OK.
Note that the Interaction Receiver Input folder is not the same folder as the Input folder used by
the fetchers.

5. If you selected Fetcher, configure the Fetcher settings as explained below.
6. If you selected Call Recognizer, configure the Call Recognizer settings as explained below.
7. Click OK. The machine is added to the list of machines at the site.

Configuring the Settings of the Fetchers

To configure the settings of the fetchers:

1. To the right of the Fetcher checkbox, select the number of fetchers that should run on the machine.
2. Click the Parameters button. The Fetcher Parameters window opens and displays a list of all the

input folders that are configured for the site.

3. Under Number of Fetchers, specify how many fetchers should retrieve interaction data from each
input folder. Modify the values so that the sum of all the fetchers defined matches the number of
fetchers that you specified should run on the machine.

4. Click OK.
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Configuring the Settings of the Call Recognizers

To configure the settings of the Call Recognizers:

1. To the right of the Fetcher checkbox, select the number of Call Recognizers that should run on the
machine.

2. Click the Parameters button. The Recognizer Parameters window opens and displays a list of all the
input folders that are configured for the site.

3. Fill in the fields as follows:
Field Description

Maximum number of recognizers per process How many Call Recognizers can be handled by
each process.

Server port range start

The ports that will be used by the Call
Recognizers; the system will use multiple ports,
as necessary, beginning with the port entered in
this field. By default, this is port 2001. You can
change this number if it conflicts with other port
settings in your system.

4. Click OK.
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Reports

Reports

If you want to use any of the SpeechMiner reports, you must deploy both the MRS Library, which is a
DLL that provides support for various report features and all the required reports, on the report
server. You can do this from the Reports panel of SMConfig. The DLL and the reports will be deployed
on the machine that is identified in the Sites & Machines panel, specified as the Server Name
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parameter under the Report Server panel.

Required Permissions
To check if the MRS Library has been deployed on the report server, and to deploy the MRS LIbrary,
SMConfig reads the report server's Registry to locate the report server’s bin folder and then accesses
the folder using the $ share. Therefore, to deploy the MRS Library and any or all of the reports, the
user account used to log into SMConfig must have administrator permissions on the report server.
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Deploying the Reports
To deploy reports on the report server, you must first deploy the MRS Library on the server, and then
deploy the required report templates. You can perform both actions simultaneously by selecting both
options in the Reports panel. Once the MRS Library is deployed on the server, you can deploy
additional reports without redeploying the library.

Important
When you select the Reports panel, SMConfig checks whether the
MRS Library is already deployed on the machine.

To deploy reports on the report server:

1. In the Reports panel, fill in the fields as follows:
Field Description

Validate Report Server

Select this option if you are configuring
SpeechMiner to use a report server. SMConfig
will check that the parameters are correct.

Note: If you select this option,
SMConfig will try to validate that the
user who is running SMConfig has
access to the report web service and
can call methods using this web
service. Therefore, the user account
that was used to run SMConfig must
have the Content Manager role on
the report server (see Configuring
Permissions for UPlatform).

Report Server

Fill in the fields in this area as follows:
• Server Name: The name of the machine on

which the report server is installed
• Protocol: The protocol SpeechMiner must

use to connect to the report server
• Port: The port SpeechMiner must use to

connect to the report server
• Virtual Folder: The folder of the reports on

the report server—usually named
ReportServer. If the database is a named
instance, enter both the folder name and the
instance name, in the format <virtual
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Field Description

report folder name>_<instance_name>.

Note: If you plan to use the report
server, select Validate Report
Server.

Set reports caching time

If you chose to use report caching in the Sites &
Machines panel, specify how long report results
should be cached, in minutes. The results of
reports that are included in active users' Views
pages will be saved for the specified period of
time. Users who open their Views pages during
that time period will see the cached results. The
recommended time period is 24 hours (i.e.,
24*60=1440 minutes), because the report
caching runs once every 24 hours.

Note: For QM reports it is
recommended that the cache setting
be set to the minimum amount of 1
minute.

Deploy MRSLibrary

If the MRS Library has not yet been deployed on
the report server, select this option.

Note: If this option is not selected,
but the checkboxes in the Report/
Resource list below are active, this
means that the MRS Library is
already deployed on the machine. In
this case, it is not necessary to
select this option.

Deploy reports

Enter the location of the reports folder. This
folder is called reports, and is located in the
SpeechMiner installation folder. For example, if
SpeechMiner was installed in c:\Program Files
(x86)\Genesys\Software, the path to enter
would be c:\Program Files (x86)\Genesys\
Software\reports.

Select\Unselect All

Select the checkbox to select all of the reports in
the Report/Resource list below for installation.
Clear it to clear all of the selections in the list.

Note: If this option is not available,
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Field Description

this means that the MRS Library has
not yet been deployed on the
machine. In this case, select Deploy
MRSLibrary, and this option will
become available.

Report/Resource

Select the reports you want to deploy on the
report server

Note: If this option is not available,
this means that the MRS Library has
not yet been deployed on the
machine. In this case, select Deploy
MRSLibrary, and this option will
become available.

2. Click Save. The system begins to deploy the reports on the report server, and the Progress window
opens and shows information about the deployment process.

Configuring Reports on the Secondary Database
Running reports on the secondary database enables you to decrease the load on the main
database.

To run reports on the secondary database:

1. Access the http://<server name>/reports in the web browser and open the SpeechMiner
database folder (that is, the folder with the relevant database name).

2. Open the SME data source and change/add the connection string to the following: data
source=<SERVER_NAME>;initial catalog=<DB_NAME>;applicationIntent=ReadOnly;

3. Click Apply.
4. Restart the Report Server.

Licenses

Licenses

For the system to process calls, enter the licenses you received from Genesys must be entered in the
Licenses panel. The licenses are not included in the SpeechMiner installation folder.
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To update the licenses:

1. Copy the text of the SpeechMiner license that was supplied.
2. In SMConfig, in the Licenses panel, paste the license text into the SpeechMiner License field.
3. Click Save.
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Important
If the license texts are stored in separate files, as an alternative to
the procedure described above, you can browse to locate the files.
When you open the relevant file, its contents are automatically
copied into the appropriate field.

Services

Services

The Services panel is used to manage the SpeechMiner services. You can use it to:

• Register all the SpeechMiner services on each machine in the system. See: Initial Configuration
• Update the SpeechMiner configuration files on each machine. See: Required Permissions
• Start, restart, and stop services. See: Starting and Stopping the System

You must perform these actions at the end of the installation process, and also whenever you add,
change, or remove services or machines to or from the system. You can also use the Services panel
to restart or stop services whenever necessary.
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Initial Configuration
After you install SpeechMiner and configure its components in SMConfig, you must register all of the
SpeechMiner services, update the SpeechMiner configuration files on each machine, and start all
Uplatform servers. In addition, whenever you make changes to the system, you should follow the
same procedures, as explained below.

To configure the services in your system:
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1. In the Services panel, fill in the fields as follows:
Field Description

Create performance counters

Select this option to configure the performance
counters on each of the selected machines.

Note: Performance counters should
normally be configured only once for
each machine. Select this option for
all machines when you first install
SpeechMiner. Then, if you add new
machines to the system, select this
option for the new machines.

Register services

Select this option to register the relevant services
on each of the selected machines.

When you select this option, the
Credentials area becomes active.
Enter the credentials of the Windows
user that will run the services
(typically, SMUSER).
Notes:
Service registration should be
performed once for each machine
when SpeechMiner is first installed.
It should be performed again if the
credentials of the Windows user
account running the services are
changed. Select this option for all
machines when you first install
SpeechMiner. Then, if you add new
machines to the system, select this
option for the new machines. If the
credentials given are for a local user
on each machine rather than a
domain user, under Domain, enter
a "." (dot). The Uplatform service will
be registered but the user will not
have the "Run as Service" role. You
will have to manually go to the
Windows services management tool
on each machine, enter the
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Field Description

password, and click Apply.

Update IIS application pools

Select this option to configure the Application
Pools identity for SpeechMiner Web and
Interaction Receiver.

When you select this option, the
Credentials area becomes active.
Enter the credentials of the Windows
user that will run the services.

Update config files

Select this option to update the SpeechMiner
configuration files on each of the selected
machines.

When you select this option, the
Credentials area becomes active.
Enter the Windows user that will run
the services(typically, SMUSER). In
addition, the encryption options
become active. Select the required
options.
• Encrypt config files - This option will

encrypt the SpeechMiner configuration files
in the local system and remote system.

• Use encrypted SQL connections - This
option will start connecting the SpeechMiner
database in encrypted mode (SSL). You
should use this option only when you use SQL
encryption.

Note: Updating of configuration files
should be performed once for each
machine when SpeechMiner is first
installed. It should be performed
again if the credentials of the
Windows user account running the
services are changed. Select this
option for all machines when you
first install SpeechMiner. Then, if you
add new machines to the system,
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Field Description

select this option for the new
machines.

Restart Services / Stop Services

All the Uplatform services must be restarted after
the installation and configuration processes are
completed. To do this, under Restart Services
and, select change status to run. Then, under
Machine, make sure all servers on which
Uplatform is installed are selected.

Note: The restart and stop options in
this panel should also be used
whenever you need to restart or
stop any of the SpeechMiner servers
(see Starting and Stopping the
System).

Select/Deselect all
Select the checkbox to select all of the machines
in the list below for updating. Clear it to clear all
of the selections in the list.

Machine
Select the machines for which you want to
implement the options you selected on the left
side of the panel.

Set master password

1. Select a machine from the list provided.

2. Select Set master password and
enter the Master password used in
the Media panel, so that the
platform/web for the selected
machine can decrypt audio files.

2. Click Save. The system begins to implement the settings you selected, and the Progress window
opens and shows information about the implementation process.

Required Permissions
The user account used to log into SMConfig must have the required permissions in order for SMConfig
to perform the actions selected in the Services panel. Some of the requirements are for permissions
on the local machine (the machine on which SMConfig is currently running); others are for
permissions on the selected remote machines. The various options in the panel have different
permission requirements, as explained in the following table:
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Option Required Permissions Additional Details

Create Performance Counters

• For remote machines:
Administrator privileges on
the selected machines

• For the local machine: Under
Windows Server 2008,
Windows Server 2012,
Windows Server 2016 and
Windows Server 2019, Power
User privileges

Power User privileges should only
be used when SpeechMiner
services are registered on
selected machines. Power User
privileges should only be given
by an Administrator user.

Register Services Administrator privileges on the
selected machines.

Administrator privileges on the
selected machines are required
in order to register the Uplatform
service. These privileges are
required for running remote
commands on the selected
machines and for registering the
services using the Windows
Services API.

Update Config Files
Administrator privileges on the
local machine and on all selected
machines.

Administrator privileges on the
selected machines are required
in order to update the
configuration files on the local
machine and on the remote
machines. These privileges are
required for accessing the files
using the $ share and for
encryption and decryption (if
Encrypt config files is selected).

Restart/Stop Services

• For remote machines:
Administrator privileges on
the selected machines

• For the local machine: Power
User privileges

• To change the Uplatform
service status on remote
machines, Administrator
permissions are required in
order to get the service
information and change it's
status remotely using the
Windows Services API.

• To change the Uplatform
service status on the local
machine Power User
privileges on the local
machine are sufficient.

Starting and Stopping the System
You can start, restart, or stop SpeechMiner services in SMConfig in the Services panel. One case in
which you must use this feature to start the Uplatform services is after the initial installation and
configuration of the system (see Initial Configuration). You can also use these features to change the
status of a service from run to idle, or vice versa, or to completely stop a service.
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Important
You can also toggle between "idle" status and "run" in the
SpeechMiner web interface, in the System Monitor page.

To start, restart, or stop SpeechMiner services:

1. In the Services panel, clear the Create Performance Counters, Register Services, and Update
Config Files checkboxes.

2. Select one of the following options:
• Restart Services and leave status as is: Restarts the selected services, and leaves them in the

mode they were in previously
• Restart Services and change status to run: Restarts the selected services, and puts them into

"run" mode
• Restart Services and change status to idle: Restarts the selected services, and puts them into

"idle" mode
• Stop Services: Stops the selected services

3. In the list of machines, select the servers you want to restart or stop.
4. Click Save. The system begins to implement the options you selected, and the Progress window opens

and shows information about the implementation process.

Media

Media

The Media panel of SMConfig is used to configure the call-audio recognition and playback formats,
retention periods for each format and site, and playback rates. Below is a summary of the audio
formats that are supported for each audio function.

Important
The Media panel is only available in an Analytics Only deployment.
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Configuring the Media Settings
The Media panel contains the basic audio setting options for the system.
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Important
This panel includes the most common audio configurations. If you
require a more complex configuration, you must manually define it in
the database. Bear in mind that, if you do so, the configuration you
defined in the database will not appear in the Audio panel. In this
case, be careful not to click Save in this panel. If you do, the settings
in the panel will overwrite the more complex configuration you
defined in the database.

To configure call-audio settings:

1. In the Media panel, fill in the fields as follows:
Field Description

Select the audio format for recognition

Select the format of the call audio that must be
used by SpeechMiner during the recognition
process. If the audio received from the recording
system is not in the format selected here, the
fetchers will automatically convert it to this
format (after they retrieve it from the input
folders) before they save it in the store folders to
await processing by SpeechMiner. If the system
is used in the Recording UI mode or Recording
and Analytics mode, the format must be set to
WAV_PCM.

Create compressed audio file

Select the format of the call audio that must be
used by SpeechMiner for playback in the web-
based interface. After the audio of a call is
processed, an additional compressed copy is
made in this format and saved in a file in the
store folders.

If the system is used in the
Recording UI mode, or Recording
and Analytics mode, this must be set
to Do Not Generate.

If compress format not available

Select one of the SpeechMiner actions to be
performed if a user initiates playback of a call for
which no compressed audio file is available. If
compressed audio is available, it is automatically
used for playback:
• Play recognition file: The player plays the

recognition audio file directly without any
format conversion.

• Convert the recognition file on-the-fly to:
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Field Description

The player first converts the recognition
audio file to the format selected here, and
then plays it for the user.

For Internet Explorer users, select
the Convert the recognition file
on-the-fly to MP3 option.

Retention Policies

Specify the retention policy, per site, for each of
the audio/text formats selected above. Call data
is deleted from the store folder automatically
when it has been in the folder as long as the
specified retention period. The values chosen
should be based mainly on the disk space
available for storing the interaction file. Bear in
mind that 1 MB of disk space can contain roughly
one minute of uncompressed audio data or 15
minutes of compressed audio data.

Default values are automatically
entered for each site in the system,
with separate retention periods for
each of the formats selected under
Recognition Audio Format and
Playback Audio Format, in hours.
You can manually adjust the
retention period for each item, as
required. To do so, double-click the
item, or select it and then select
. The Retention Period dialog box
opens. Modify the value in the text
field, and then click OK.

If the system is used in the
Recording UI mode or Recording and
Analytics mode, set the retention
policy of WAV_PCM to 0.

Notes:

• Selecting these options prevents the creation
of unnecessary audio files and the storage of
files for longer than is necessary.

• The recognition audio files of calls that have
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Field Description

not been processed yet, and of calls that are
included in Static Call Lists, are not deleted
even when the retention period is over.

• If you do not want audio data to be deleted
from the store folder automatically, enter the
value -1. This value should only be used in
static systems where the number of calls is
limited and does not grow continuously.

Encrypt audio files

Select this option to encrypt the audio/text files.

Note:
• If you do not have a key, Generate new

password is automatically selected to
generate a key. In this case, you must enter a
Master password and confirm it.

• If you want to generate a new key, select
Generate new password, enter the Master
password and confirm it. The Master
password must be the same as the original
Master password. The Master password is
always the same.

• The new Master password is not saved in the
database. For that reason, you must save the
Master password in a location of your choice.

• The Master password is required for the
machines selected in the SMConfig >
Services panel. For additional information,
refer to the Set master password
description in the Services panel page.

2. Click Save. The system implements the settings, and the Progress window opens and shows
information about the process.

Summary
The Media panel summary lists the preferred formats that SpeechMiner supports:

Item Function Description

Input folder expects Fetcher

Audio formats supported by
fetchers; call audio that is
retrieved from the external
recording system by UConnector
must be saved in the input folder
in one of these formats.

Recognition priorities Recognition Preferred audio formats for the
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Item Function Description
recognition process, in order of
preference; call audio that is
processed by the Recognizers
should ideally be in one of these
formats.

Playback priorities Playback

Preferred audio formats for the
SpeechMiner media player, in
order of preference; call audio
that is played back should ideally
be in one of these formats.

Index

Index

The Index panel enables you to configure the Indexer authentication and service location.
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Indexer Service
Enter the Indexer Service with the location at which it was installed (for example,
http://<IndexerHost>/indexer/). For additional information see Installing SpeechMiner using the
Wizard.
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Indexer Authorization
Enter the username and password defined in the Authentication tab during the Installing
SpeechMiner using the Wizard procedure.

Recording

Recording

When working with a Recording mode, the following configurations are required in the Recording
panel. The Recording panel only appears when you are working in a Recording + Analytics
environment or a Recording Only environment:

• Configuration

The following must be configured in the systems Configuration Server:

• Tenant: The name of the tenant in the Configuration Server that contains the system
configuration.

• Update Agents Every # Hours: Indicates how often agents are updated with new recordings.

• Interaction Receiver

In systems with Call Recording mode or Call Recording and Analytics mode licenses, the Program
ID is normally assigned to calls by the recording processor.
The recording processor adds the Program ID to the call’s metadata. If the call arrives in the
SpeechMiner system without a Program ID, SpeechMiner assigns it the default Program ID.
By default, this value is default.

If you want to change this default value to a different value, perform the following:

• For Call Recording and Analytics Mode licenses, in SMART, create a Program with the name you
want to use for the default Program, and apply it.
Finally, in the SMConfig Recording panel, set Default Program to the Program's external ID.

• For Call Recording Mode set Default Program to the desired value.

Set Extension Speaker Type and Trunk Speaker Type as configured in the GIR system.

Important
For additional information see Recording Modes.
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• RP Authorization

Set the User and Password to the values configured for the RP.

• MCP Authorization

Set the User and Password to the values configured for the MCP.
The MCP authorization option is only available when working in an environment with
SpeechMiner Analytics.

• Playback
• Set the internal RWS URI value (when working with tagging), using the format:

http://rws_host:port.

Configuring SpeechMiner Using the SMConfig to Configure SpeechMiner

SpeechMiner Administration Guide 216



Logging

Logging

The Logging panel enables you to configure the logging output for the following components:

• Platform: manages all the SpeechMiner processing tasks. For example, fetching, recognition,
categorization, exploration, compression and indexing.
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• Web: runs the SpeechMiner web-based interface that enables users to view and work with the
interaction data
after it has been processed.

• Client Applications: SpeechMiner applications such as SMART and SMConfig.

Important
The logging panel is only available when you do not set
Configuration Servers. When a Configuration Server is set the
logging parameters are taken from the Configuration Server. For
details see: Site & Machines > Configuring Sites > Default Site.

For details see the Log Options and Log Output option descriptions below.
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Log Options

Important
For applications configured via a configuration file, changes to log
options take effect after the application is restarted.
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Log Options Description

check-point

Specifies (in hours) how often the application
generates a check point log event, to divide the log
into sections of equal time. By default, the
application generates this log event every hour.
Setting the option to 0 prevents the generation of
check-point events.

Default Value: 1

Valid Values: 0-24

Changes take effect: after restart

compatible-output-priority

Specifies whether the application uses 6.x output
logic.

Default Value: false

Valid Values:
• true: The log of the level specified by Log

Output Options is sent to the specified output.
• false: The log of the level specified by Log

Output Options and higher levels is sent to the
specified output.

Changes take effect: after restart

expire

Determines whether log files expire. If they do,
Expire sets the measurement for determining when
they expire, along with the maximum number of
files (segments) or days before the files are
removed. This option is ignored if log output is not
configured to be sent to a log file.

Note: If an option’s value is set
incorrectly (out of the range of valid
values) it will be automatically reset to
10.

Default Value: false

Valid Values:
• false: No expiration; all generated segments

Configuring SpeechMiner Using the SMConfig to Configure SpeechMiner

SpeechMiner Administration Guide 220



Log Options Description

are stored.
• <number> file or <number>: Sets the

maximum number of log files to store. Specify a
number from 1–1000.

• <number> day: Sets the maximum number of
days before log files are deleted. Specify a
number from 1–100.

Changes take effect: after restart

keep-startup-file

Specifies whether a log startup segment,
containing the initial configuration options, is to be
kept. If it is, this option can be set to true or to a
specific size. If set to true, the size of the initial
segment will be equal to the size of the regular log
segment defined by the segment option. The value
of this option will be ignored if segmentation is
turned off (that is, if the segment option is set to
false).

Default Value: false

Valid Values:
• false: No startup segment of the log is kept.
• true: A startup segment of the log is kept. The

size of the segment equals the value of the
segment option.

• <number> KB: Sets the maximum size, in
kilobytes, for a startup segment of the log.

• <number> MB: Sets the maximum size, in
megabytes, for a startup segment of the log

Changes take effect: after restart

message_format

Specifies the log record headers format used by the
application when writing logs in the log file. Using
compressed log record headers improves
application performance and reduces the log file’s
size.

With the value set to short:
• A log file header or the log file segment

contains information about the application
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(such as the application name, application type,
host type, and time zone), whereas single log
records within the file or segment omit this
information.

• A log message priority is abbreviated to Std, Int,
Trc, or Dbg, for Standard, Interaction, Trace, or
Debug messages, respectively.

• The message ID does not contain the prefix
GCTI or the application type ID.

A log record in the full format appears
as follows:
• 2002-05-07T18:11:38.196 Standard localhost

cfg_dbserver GCTI-00-05060 Application
started.

A log record in the short format
appears as follows:
• 2002-05-07T18:15:33.952 Std 05060

Application started

Note: Whether the full or short format
is used, time is printed in the format
specified by the time_format option.

Default Value: short

Valid Values:
• short: An application uses compressed headers

when writing log records in its log file.
• full: An application uses complete headers

when writing log records in its log file.

Changes take effect: after restart

print-attributes

Specifies whether the application attaches
extended attributes (if any exist), to a log event
that it sends to the log output. Typically, log events
at the Interaction log level and Audit-related log
events contain extended attributes. Setting this
option to true enables audit capabilities, but
negatively affects performance. Genesys
recommends enabling this option for Solution
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Control Server and Configuration Server when
using audit tracking. For other applications, refer to
Genesys Combined Log Events Help to find out
whether an application generates Interaction-level
and Audit-related log events. If such log events are
generated enable the option only when testing new
interaction scenarios.

Default Value: false

Valid Values:
• true: Attaches extended attributes (if any exist)

to a log event sent to log output
• false: Does not attach extended attributes to a

log event sent to log output.

Changes take effect: after restart

segment

Specifies whether there is a segmentation limit for
a log file. If there is, it sets the mode of
measurement along with the maximum size. If the
current log segment exceeds the size set by this
option the file is closed and a new one is created.
This option is ignored if the log output is not
configured to be sent to a log file.

Default Value: false

Valid Values:
• false: No segmentation is allowed.
• <number> KB or <number>: Sets the

maximum segment size (in kilobytes). The
minimum segment size is 100 KB.

• <number> MB: Sets the maximum segment
size (in megabytes).

• <number> hr: Sets the number of hours for
the segment to stay open. The minimum
number is 1 hour.

Changes take effect: after restart

time_convert
Specifies the system in which an application
calculates the log record time when generating a
log file. The time is converted from the time in
seconds since the Epoch (00:00:00 UTC, January 1,
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1970).

Default Value: Local

Valid Values:
• local: The time of log record generation is

expressed as a local time, based on the time
zone and any seasonal adjustments. Time zone
information about the application’s host
computer is used.

• utc: The log record generation time is
expressed as Coordinated Universal Time (UTC).

Changes take effect: after restart

time_format

Specifies how to represent (in a log file) the time
when an application generates log records.

A log record’s time field in the ISO
8601 format appears as follows:
2001-07-24T04:58:10.123

Default Value: time

Valid Values:
• time: The time string is formatted according to

the HH:MM:SS.sss (hours, minutes, seconds,
and milliseconds) format.

• locale: The time string is formatted according
to the system’s locale.

• ISO8601: The date in the time string is
formatted according to the ISO 8601 format.
Fractional seconds are given in milliseconds.

Changes take effect: after restart

verbose

Determines whether a log output is created. If the
log output is created, Verbose specifies the
minimum level of log events generated. The log
events levels, starting with the highest priority
level, are Standard, Interaction, Trace, and Debug.

Note: For definitions of the Standard,
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Interaction, Trace, and Debug log
levels, refer to the Framework
Management Layer User’s Guide,
Framework Genesys Administrator
Help, or to Framework Solution

Default Value: all

Valid Values:
• all: All log events (that is, log events of the

Standard, Trace, Interaction, and Debug levels)
are generated.

• debug: The same as all.
• trace: Trace level log events and higher (that is,

log events of the Standard, Interaction, and
Trace levels) are generated, but Debug level log
events are not generated.

• interaction: Interaction level log events and
higher (that is, log events of the Standard and
Interaction levels) are generated, but Trace and
Debug levels log events are not generated.
Interaction is associated with Information
messages.

• standard: Standard level log events are
generated, but Interaction, Trace, and Debug
levels log events are not generated. Standard is
associated with Warn, Error and Critical
messages.

• none: No output is produced.

Changes take effect: after restart

Log Output Options
To configure log outputs, set log level options (all, standard, interaction, trace, and/or debug) to the
desired types of log output (stdout, stderr, network, memory, and/or [filename], for log file output).

You can use:

• One log level option to specify different log outputs.
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• One log output type for different log levels.
• Several log output types simultaneously, to log events of the same or different log levels.

You must separate the log output types by a comma when you are configuring more than one output
for the same log level.
The log output options are activated according to the setting of the verbose configuration option.

Important
• If you direct log output to a file on the network drive, an application does not create a

snapshot log file (with the extension *.snapshot.log) in case it terminates abnormally.
• Directing log output to the console (by using the stdout or stderr settings) can affect

application performance. Avoid using these log output settings in a production
environment.

Output Options Description

all

Specifies the outputs to which an application sends
all log events. The log output types must be
separated by a comma when more than one output
is configured. For example: all = stdout, logfile

Note: To ease the troubleshooting
process, consider using unique names
for log files that different applications
generate.

Default Value: no default value

Valid Values:
• stdout: Log events are sent to the Standard

output (stdout).
• stderr: Log events are sent to the Standard

error output (stderr).
• network: Log events are sent to Message

Server, which can reside anywhere on the
network. Message Server stores the log events
in the Log Database. Setting the all log level
option to the network output enables an
application to send Standard, Interaction, and
Trace levels log events to Message Server.
Debug-level log events are neither sent to the
Message Server and are not stored in the Log
Database.
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• memory: Log events are sent to the memory
output on the local disk. This is the safest
output in terms of the application performance.

• file name: Log events are stored in a file with a
specified name. The default path used for all
components is C:\Temp\SMLogs. Each
component has its own path. You can save the
files in a different path of your choice. Make
sure the path is absolute (full).

Changes take effect: after restart

trace

Specifies the outputs to which an application sends
the Trace level and higher log events (that is, log
events of the Standard, Interaction, and Trace
levels). The log outputs must be separated by a
comma when more than one output is configured.
For example: trace = stderr, network

Default Value: no default value

Valid Values (log output types):
• stdout: Log events are sent to the Standard

output (stdout).
• stderr: Log events are sent to the Standard

error output (stderr).
• network: Log events are sent to Message

Server, which can reside anywhere on the
network. Message Server stores the log events
in the Log Database.

• memory: Log events are sent to the memory
output on the local disk. This is the safest
output in terms of application performance.

• file name: Log events are stored in a file with a
specified name. You can save the files in a
different path of your choice. Make sure the
path is absolute (full).

Changes take effect: after restart

debug

Specifies the outputs to which an application sends
the log events of the Debug level and higher (that
is, log events of the Standard, Interaction, Trace,
and Debug levels). The log output types must be
separated by a comma when more than one output
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is configured—for example: debug = stderr, /usr/
local/genesys/logfile

Note: Debug-level log events are
never sent to Message Server or
stored in the Log Database.

Default Value: no default value

Valid Values (log output types):
• stdout: Log events are sent to the Standard

output (stdout).
• stderr: Log events are sent to the Standard

error output (stderr).
• network: Log events are sent to Message

Server, which can reside anywhere on the
network. Message Server stores the log events
in the Log Database.

• memory: Log events are sent to the memory
output on the local disk. This is the safest
output in terms of application performance.

• file name: Log events are stored in a file with a
specified name. You can save the files in a
different path of your choice. Make sure the
path is absolute (full).

Changes take effect: after restart

interaction

Specifies the outputs to which an application sends
the Interaction level and higher log events (that is,
log events of the Standard and Interaction levels).
The log outputs must be separated by a comma
when more than one output is configured. For
example: interaction = stderr, network

Default Value: no default value

Valid Values (log output types):
• stdout: Log events are sent to the Standard

output (stdout).
• stderr: Log events are sent to the Standard

error output (stderr).
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• memory: Log events are sent to the memory
output on the local disk. This is the safest
output in terms of application performance.

• file name: Log events are stored in a file with a
specified name. You can save the files in a
different path of your choice. Make sure the
path is absolute (full).

Changes take effect: after restart

standard

Specifies the outputs to which an application sends
the log events of the Standard level. The log output
types must be separated by a comma when more
than one output is configured. For example:
standard = stderr, network.

Default Value: no default value

Valid Values (log output types):
• stdout: Log events are sent to the Standard

output (stdout).
• stderr: Log events are sent to the Standard

error output (stderr).
• network: Log events are sent to Message

Server, which can reside anywhere on the
network. Message Server stores the log events
in the Log Database.

• memory: Log events are sent to the memory
output on the local disk. This is the safest
output in terms of application performance.

• file name: Log events are stored in a file with a
specified name. You can save the files in a
different path of your choice. Make sure the
path is absolute (full).

Changes take effect: after restart

SMConfig Console
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SMConfig Console

This page describes how to configure SpeechMiner using the command line.

Important
To configure SpeechMiner with the command line you must have
SMConfig permissions. You must have the permissions required for
logging in and configuring all SMConfig panels.

Before you begin consider the following:

• SMConfig creates an .xml file(s) that contains the details and selections you made in the SMConfig
panel(s).

• Instead of configuring SMConfig from scratch every time you deploy SpeechMiner, you can simply run
the same .xml file(s) on each environment.

• You can create an .xml file for each SMConfig panel or one .xml file that contains details for all the
panels.

• Once the .xml file is created you can change the order in which the panels are configured by simply
editing the panel order within the .xml.

• You can edit the .xml file so that it includes any combination and panel order you want. For example,
the .xml file can contain the same panel more than once.

• Once the .xml file for the SMConfig panel(s) is created you can modify it for the specific system.
If the deployment is the same as the previous system deployment you will only need to change the
name and system credentials.

• If the command line configuration process fails, the process will stop the execution and it will not
continue to the next SMConfig panel.

To configure SpeechMiner using the command line:

1. Export SpeechMiner configuration to an .xml file.
a. Open SMConfig and configure its panels for the environment you are currently deploying.

See pages above for details.

b. Click the Export button in the SMConfig panel(s) whose details you want to deploy using the
command line.

Important
You do not have to click Save before you click Export.
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c. Select one of the following:

• All Panels: to create an .xml file with all the SMConfig details and selections.
• Current Panel: to create an .xml file with the SMConfig details and selections associated with the

specific panel.

• Browse to the location in which you want to save the .xml file.
• Click Save.
• Configure SpeechMiner:

a. Open your command line.
b. Run the SMConfigconsole.exe (in the Installation folder in ...\utopy\tools\bin\release) with the path to

the .xml file created in step #1.

Important
To validate the input parameters run SMConfigconsole.exe with -v
and the path to the .xml file.

c. Review the command line results:

Exit Code Name Description

0 Success All of the panels were
configured successfully.

1 ExceptionOnConfig An exception was thrown when
configuring a panel.

2 FailedToConfig The panel could not be
configured.

3 FailedToLogin The login failed.

4 FailedToTeadXML The process failed to parse the
XML.

5 InputMissing Input is misssing.

A report will be written to the console. The report will include a status for each SMConfig panel.
If the command line results are a success SpeechMiner was configured successfully.
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Additional Configurations
The following configurations are recommended for the successful completion of the SpeechMiner
configuration process:

Browser
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Configuring the Browser
End users of SpeechMiner access its browser-based interface from Internet Explorer or Google
Chrome, which connects to the SpeechMiner Web server through the local network. In order for the
SpeechMiner interface to work properly, you must configure each user's browser as explained below.
The configuration changes that must be implemented are to allow popups from the SpeechMiner
domain, to treat the SpeechMiner domain as part of the local intranet (or as a trusted site), and to
enable automatic updating of cached web pages.

In addition, if Internet Explorer is running on a Windows Server 2008 machine or Windows Server
2012 machine, the Enhanced Security Configuration feature should be turned off.

Refer to the Turning Off the Enhanced Security Configuration Feature on Windows Server 2008
/ Windows Server 2012 / Windows Server 2019 section below.

Tip
• To run SpeechMiner 8.5.5 you must use a minimum resolution of 1280X1024. We

recommend that you work with a 1680x1050 resolution.
• When working with Internet Explorer 11+, the Online Help documentation may not

appear as it should due to your Internet Explorer compatibility view settings. To view
the Online Help properly, go to the Tools menu, select Compatibility View Settings
and verify that Display intranet sites in Compatibility View is not checked.

Refer to one of the following procedures to configure the browser-based interface:

• Configuring Internet Explorer
• Configuring Chrome

Configuring Internet Explorer

1. In the Internet Options dialog box, in the Security tab, select Local Intranet.
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2. Add the SpeechMiner domain to the list of web sites in the Local Intranet zone.
3. Click Sites > Advanced and add the SpeechMiner web server URL to the list of safe websites. Note:

This step is not required if you already turned off the Enhanced Security Configuration Feature.
4. Click Custom Level to customize the local intranet zone security.
5. Under Miscellaneous > Access data sources across domains, select Enable.

Selecting Enable makes Screen Recording playback possible because it allows access from the
browser to Interaction Recording Web Services.
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6. In the Privacy tab, add the SpeechMiner domain to the list of web sites that are permitted to open
popups.

7. In the General tab, under Browsing history, select Settings.
8. Under Check for newer versions of stored pages, select Automatically.
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9. Click OK to save the changes.

Important
If the SpeechMiner domain is treated as part of the local intranet,
Local intranet should appear in the Status Bar at the bottom of
the Internet Explorer window whenever the browser is displaying a
SpeechMiner page. .
In newer versions of Internet Explorer, the same information can be
found in File > Properties.
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Turning Off the Enhanced Security Configuration Feature on Windows Server
2008

1. In the Server Manager, in the home page (the top level), expand the Security Information section.
The current settings for the Enhanced Security Configuration feature appear under IE Enhanced
Security Configuration (ESC).

2. If the current settings are not Off for Administrators and Off for Users, click Configure IE ESC. The
Internet Explorer Advanced Security Configuration dialog box opens.
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3. For both Administrators and Users, select Off.
4. Click OK to save the changes.

Turning Off the Enhanced Security Configuration Feature on Windows Server
2012 / Windows Server 2019

1. In the Server Manager, in the home page (the top level), select Local Server.
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2. In the Server Properties for the Local Server, you will see the option for IE Enhanced Security
Configuration. Click On to change the option.

3. At this point, you will be prompted with the options to turn off Internet Explorer Enhanced Security
Configuration for Administrators and/or Users. For both Administrators and Users, select Off and
click OK.
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4. Click the Refresh button at the top of the Server Manager and the IE Enhanced Security
Configuration should now show as Off.

Configuring Chrome

By default Chrome disables popups. For this reason, perform the following steps to to configure
Chrome to work properly with the SpeechMiner UI:

1. In the Chrome browser, click the Customize and control Google Chrome menu , and select
Settings.

2. Click Advanced at the bottom of the page and under Privacy and security, click Content
Settings....

3. Click Popups and verify that Allowed is enabled. If it is not enabled click the slide button to
enable popups.

4. To allow popups for the SpeechMiner UI site:
a. Click ADD in the Allow row.
b. In the Add a site window under Site type the address http[s]://host:port (speechminer

webserver url) in the field provided.
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c. Click ADD to add the site to the list of sites from which you allow popups.

Tip
To quickly enable popups for a specific specific site, click the area to
the left of the site address inside the address bar. Select Allow from
the Popups list.

Verify that Java Script is Enabled

1. In the Chrome Browser, navigate to Chrome Settings > Show Advanced Settings > Privacy >
Content Settings.

2. Under Java Script, select Allow all sites to run Java Script (recommended).

For more information about enabling Java Script, see the following example
https://support.google.com/adsense/answer/12654.

ADDP Timeout Settings

ADDP Timeout Settings

The following two configServer DB table timeout values control the Configuration Server timeout
connection.

• ClientTimeout
• ServerTimeout

Enable Config Server Logging
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Enable Config Server Logging

When working with a 8.5.510 system, you can enable Config Server operation logs by configuring the
PSDKLogEnabled parameter in the configServer table in the database to 1. By default the logging is
off (0).

Tone Frequency Configuration

Tone Frequency Configuration

Tone frequencies are used to find non-linguistic events (for example, busy tone, dial tone, and so on).
By default SpeechMiner is configured with tone frequencies according to US standards. Other
countries may have different frequencies.

To change the tone frequency settings, you must modify the following tone frequency settings in the
NLEParams table in the SpeechMiner database:

• DTMF_VECTOR - touch keys tones
• BUSYTONE_VECTOR - busy tone
• DIALTONE_VECTOR - dial tone
• RINGBACK_VECTOR - ring back tone

Important
SpeechMiner supports tone frequencies for multiple countries. To add
tone frequencies for multiple countries, add additional rows to the
NLEParams table. Do not change the remaining fields in the
NLEParams table.

Wave Graph Visibility

Configuring SpeechMiner Additional Configurations

SpeechMiner Administration Guide 242



Set Wave Graph Visibility for Long Recordings

Configuring the 'WaveGraphCallDurationLimit parameter in the webServiceParams table enables
you to limit the Media Player wave graph visibility for recordings that do not include Analytics.

It is recommended to limit the visibility to recordings of the Media Player wave graph that are no
longer than 30 minutes.

Set the WaveGraphCallDurationLimit parameter to 1800 seconds (30 minutes).

Important
If the value of the WaveGraphCallDurationLimit parameter is
longer than 30 minutes, users may experience performance issues.

Date and Time

Setting the Date and Time

The webServiceParams table includes the following parameters for configuring the date and time
display:

• globalDateFormat: Configures the date format, for example: MM/dd/yy
• globalDateTimeFormat: Configures the time format, for example: hh:mm tt
• globalDateTimeOffsetFormat: Configures the timezone format, for example: +/- nn:nn

For additional information about the options available, see http://www.w3.org/TR/NOTE-datetime.

When the following SpeechMiner's interface languages are used for the Web interface, the only
formats supported for globalDateTimeFormat are the following 24-hour formats: H:mm:ss, H:mm,
HH:MM or HH:mm.

• German - Germany
• Spanish - Spain
• Spanish - USA
• French - France
• Italian - Italy
• Portuguese - Brazil
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Archive Quality Management Evaluation Sessions

Archive Quality Management Evaluation Sessions

Archiving evaluation sessions, enables you to remove completed and expired evaluation sessions no
longer needed online, but which must still be accessible at a later date if required. That is, archived
sessions will be removed from the session grid, and will only be visible when the user filters to view
archived sessions. By limiting the number of sessions that appear, archiving also enables you to
maximize performance by minimizing search and filter response times.

There are two types of archiving options:

• Automatic Archive - Enables you to schedule archiving after a specific period of time.
• Manual Archive - Enables you to select specific sessions to archive.

Automatically Archive an Evaluation Session
Automatic archive is configured per system and after the entire system is installed and configured.

Automatic archive includes 2 tasks, that run on the platform and archive sessions x days after the
sessions are completed and/or expired.

To change when Automatic archive is run, you must change the default values for the following
parameters in the QMParams table:

• ArchiveCompletedSessionsAfterDays - Represents the number of days that must pass before the system
archives sessions that have been completed.

• ArchiveExpiredSessionsAfterDays - Represents the number of days that must pass before the system
archives sessions that have expired.

Tip
If the value of each parameter is -1, the automatic archive will not
archive sessions.

Manually Archive an Evaluation Session
To manually archive an evaluation session refer to the SpeechMiner User Manual > Quality
Management > Evaluation Sessions > Archive an Evaluation Session.
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Export from Quality Management

Export evaluation and/or session data from Quality Management

To set the maximum number of evaluations and/or sessions from which data can be exported, you
must set the following parameters in the webServiceParams table:

• Maximum number of evaluations (default 10): MaxEvaluationsForQMSessionsExport
• Maximum number of sessions (default 1000): MaxExportedQMSessions

Configure the Default Score to 100%

Configure the Default Score to 100%

When performing an Evaluation Session, the Default scores to 100% option enables you to turn on/
off all the default answers in the forms associated with the the specific Evaluation Session.

When this option is turned on the form score is 100%. Also, when this option is turned on or off, all
the information entered up to this point will be deleted.

Once the evaluator chooses to turn on the Default scores to 100% option, and subsequently
answer all the questions in the form, the evaluator can change the default answers and reduce the
score.

To activate the Default scores to 100% option in the Evaluation Session page, you must set the
following parameter in the QMParams table:

• AutofillSessionFormsByDefault

• 0 - Do not activate the Default scores to 100% option.
• 1 - Activate the the Default scores to 100% option when an Evaluation Session is opened.

Configure the Quality Management Exactly Value
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Configure the Quality Management Exactly Value

When creating or editing a new Quality Management evaluation (not including the Calibration
Evaluation), you can limit the amount of interactions associated with each Evaluation Session created
as a result of the specific evaluation. To do this, you must configure the Exactly parameter.

To define the maximum and default values for the Exactly parameter, configure the following fields
in the QMParams table:

• DefaultExactlyForDistributedInteractionEvaluation (default = 100)

• MaxExactlyForDistributedInteractionEvaluation (maximum = 1000)

• DefaultExactlyForDistributedAgentEvaluation (default = 3)

• MaxExactlyForDistributedAgentEvaluation (maximum = 30)

• DefaultExactlyForSharedEvaluation (default = 100)

• MaxExactlyForSharedEvaluation (maximum = 1000)

Media Player Wave Graph

Display Media Player Wave Graph

To display the Media Player wave graph you must set the WaveGraphVideoRendering parameter in
the webServiceParams table to 1.

Important
It is not recommended to change this value since doing so will have
negative impact on the Media Player's performance when playing a
screen recording.

Agent Evaluation Configuration
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Agent Evaluation Configuration

To configure the maximum number of agents that can be selected to create a Distributed Agent
Evaluation session (that is, a nonrecurring evaluation), you must set the
MaxAgentsInOneTimeDistributedEvaluations parameter in the webServiceParams table to a
specific value.

The default value is MaxAgentsInOneTimeDistributedEvaluations = 20.

Important
If the value of MaxAgentsInOneTimeDistributedEvaluations is set
to 0, the Distributed Agent Evaluation session cannot be created as a
nonrecurring evaluation. A recurring evaluation can be created.

Configuring Ad Hoc Evaluation Expiry Date

Configuring Ad Hoc Evaluation Expiry Date

To change the default Ad Hoc Evaluation Expiry Date, you must change the
DefaultAdHocExpiration parameter in the webServiceParams table to a specific value.

The default hour value is DefaultAdHocExpiration = 24.

Configuring IIS Recycling

Configure Internet Information Server (IIS) Recycling

The IIS default configuraion is a set to a period of 1740 minutes (29 hours). When a recycle is
completed, the following system log message appears:
A worker process with process id of 'xxxx' serving application pool 'speechminer' has
requested a recycle because the worker process reached its allowed processing time
limit.
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It is recommend that the recycling configuration of the SpeechMiner's application pool be set to a
specific hour during the night, when no one is likely to be working with the system.

To configure the SpeechMiner application pool recycle:

1. Open the IIS Manager.
2. In the Connections pane, expand the server node and click Application Pools
3. In the Application Pools page, select the SpeechMiner application pool, and click Recycling in the

Actions pane.
4. Select specific time(s), and in the corresponding box type a time at which you want the application pool

to recycle daily (preferably during non-working hours. For example, 00:00 AM). The value that you
enter is saved in the configuration based on a 24-hour clock.

5. Verify that Regular time intervals is not selected.
6. Click Next, select the events that should be logged when an application pool recycles and click Finish.

Encrypt Exported Interactions

Request a Password when Exporting Encrypted Interactions

To force the user to enter a password when extracting interactions from a zip file, you must set the
following parameter to True in the webServiceParams table:

• encryptExport

Important
• If encryptExport is set to True, the user will not be able to export an Interaction List

and/or a Saved Search from a Coaching Session.
• To open an encrypted zip file you should not use the Microsoft Windows default zip tool.

You must use an external tool.

Limit Export Audio Interactions Size
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Set a limit for Exporting Audio Interactions

To limit the total exported audio files size, update the LimitExportSize parameter in the
webServiceParams table.

The LimitExportSize value must be set in megabytes and the recommended limit is up to 1.5 GB.

If a limit is not set for LimitExportSize, the system may timeout when the amount requested for
export is too large. When this happens, the export process will be aborted.

Important
The LimitExportSize configuration is only relevant in an Analytics
only system.

Export from a Coaching Session

Export an Interaction List and/or a Saved Search from a
Coaching Session

To enable a user to export an Interaction List and/or a Saved Search from a Coaching Session, you
must set the following parameter to False in the webServiceParams table:

• encryptExport

Forget Password Configuration

Set the Forget Password Login Option

When configuring SpeechMiner you can give users the option of recovering forgotten passwords.
If you choose to enable users to recover their forgotten passwords, the SpeechMiner log in screen will
contain a Forget Password? link.
When the user clicks the Forget Password? link, the user will be required to enter his email address.
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The user will then receive an email with a Reset Password link.
By default the Reset Password link is only available for 4 hours. This default number can be changed.

To enable a user to recover his password perform the following:

1. Access the webServiceParams table.
2. Change the PasswordRecovery field from false to true.

To change the Reset Password link default:

1. Access the webServiceParams table.
2. Change the resetPasswordTokenExpirationTime field from 4 hours to the amount you prefer and

save.

Important
If more than one user has the same email address, the Forget
Password option will not be available.

To change the email message the user receives:

1. Access the webServiceParams table.
2. Change the resetPasswordMailBody field to the content you prefer the user to receive.

The email message content should contain <resetLink>.
<resetLink> represents the Reset Password link.

3. Change the resetPasswordMailSubject field to the subject you prefer the user to receive and save.

Session Timeout

Setting the Session Timeout Value

Web.config includes the following timeout parameter:

Timeout - Determines the period of time, after which the session expires and the user is logged out
of the system.
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To change the Session Timeout Value:

1. Open the web.config file.
2. Go to <system.web> under <configuration> and add the following line: <sessionState

timeout="enter the # in minutes"></sessionState>

3. Run IISReset in the command line.

Important
The expiration time is reset when more than half the timeout interval
has elapsed. The default timeout value is 20 minutes and the
minimum value is 5 minutes.

Resource Type

Setting the Resource Type

The resourceType table contains a list of all the possible resource types.

To enable/disable a resource type in SpeechMiner, update the isEnabled field in the resourceType
table with the relevant status.

The following Resource Types can be enabled/disabled for the Search filter:

• Call
• Email
• Chat
• Free Text
• Social

HTTPS for SpeechMiner

Enable HTTPS for SpeechMiner

The process of enabling HTTPS for SpeechMiner depends on how your system is configured. The
following represent three different system configuration scenarios for which HTTPS can be enabled:
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• Enable HTTPS for SpeechMiner when Internet Information Service (IIS) is configured with HTTPS.
• Enable HTTPS for SpeechMiner when Load Balancer is configured with HTTPS and IIS is configured with

HTTP.
• Enable HTTPS for SpeechMiner when both Load Balancer and IIS are configured with HTTPS.
• Securing SpeechMiner Connections

Important
The following procedures are intended for a WIndows 2008 Server

Enable HTTPS for SpeechMiner on IIS

1. Create a self signed server certificate to enable the https protocol:
a. Open the Microsoft Management Console (MMC).
b. Select File > Add / Remove Snap-in.
c. Select Certificate and click Add.
d. In the Add or Remove Snap-ins, select the Certificates snap-in from the list provided and

click Add. The Certificate snap-in window opens.
e. Select Computer account and click Next.
f. Select Local computer and click Finish and OK.

g. Under Certificates (Local Computer), right-click Personal, Select All Tasks, Request
New Certificates. The Certificate Enrollment window opens:

h. Click Next
i. Click Active Directory Enrollment Policy and Next.
j. Select Public Web Server with Export and click Enroll and Finish.

11. Configure the Report Server:
a. Open the Reporting Services Configuration Manager.
b. Select Web Service URL.
c. Select Advanced.
d. Under Multiple SLL Identities, click Add and select the certificate you created.
e. Click OK and select the https URL.
f. Under Multiple SSL Identities, click Add and select the certificate you created.
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g. Click OK and select the Report Manager URL.

8. Create an SSL Binding:
a. Open IIS Manager.
b. Select Default Web Site and in the right Action pane click Bindings.
c. Click Add.
d. In the Type list select https.
e. In the IP address list select All Unassigned.
f. In the Port field enter the relevant port number.

g. In the SSL Certificate list select the relevant SSL Certificate.

8. Configure SSL settings:
a. In the IIS Manager, click Default Web Site.
b. Under IIS, select SSL Settings.
c. Select Require SSL and click Apply.

4. Restart the IIS Server.

Important
If the following error occurs after you restart the IIS Server, it
may be due to the fact that your Skype process is using the
same ports and should be stopped:
IIS Manager Error: The process cannot access the file because it
is being used by another process. (Exception from HRESULT:
0x80070020)

Additional information about SSL on IIS 7 can be found here: http://learn.iis.net/page.aspx/144/
how-to-set-up-ssl-on-iis-7/
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Enable HTTPS for SpeechMiner when Load Balancer is configured with HTTPS and
IIS is configured with HTTP

Important
Refer to the Redirect SpeechMiner URL to Load Balancer tab in
this page to ensure that SpeechMiner is redirected to the correct URL
after it times out.

1. Download and install Microsoft URL Rewrite Module 2.0 for IIS.
2. Add the following code to the web.config file in side <system.webServer>:

<rewrite>
<rules>
<rule name="HTTPS_AlwaysOn" patternSyntax="Wildcard">
<match url="*" />
<conditions>
<add input="{HTTP_REFERER}" pattern="genesyscloud.com" />
</conditions>
<serverVariables>
<set name="HTTPS" value="on" />
</serverVariables>
<action type="None" />
</rule>
</rules>
</rewrite>

Important
genesyscloud.com should be replaced with your Load Balancer
URL.

3. Restart IIS.

Enable HTTPS for SpeechMiner when Load Balancer and IIS are configured with
HTTPS

1. Enable HTTPS for SpeechMiner when Internet Information Service (IIS) is configured with HTTPS.
2. Enable HTTPS for SpeechMiner when Load Balancer is configured with HTTPS and IIS is configured with

HTTP.
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Securing SpeechMiner Connections
TLS 1.2 Connections

You can configure SpeechMiner to work with TLS 1.2.
SpeechMiner supports all TLS 1.2 connections as long as the server is configured to use TLS 1.2 and
the server certificate is trusted.

Important
• When configuring SpeechMiner to work with TLS 1.2, verify that the connection is

specified in the client exactly the same as it appears in the certificate.
• To ensure that the SQL server is working with an encrypted connection, the SQL

connection must be configured to use a Protocol Encrypted Connection and a Trust
Server Certificate. Both of these should be configured in the SQL Native client 11.0
Configuration Manager Properties window.

Configure UPlatform to work with TLS 1.2

For UPlatform to work with TLS 1.2, the name of the ODBC SQL driver should be manually changed in
the UPlatform SpeechMiner Configuration file.

1. Install the latest ODBC SQL driver (version 13) in the UPlatform machine.
2. In the clients system, after completing the UPlatform installation, update the Uplatform.exe.Config

file under appSettings the new ODBC driver as follows: <add key="sql_driver_name" value=
"driver={ODBC Driver 13 for SQL Server};" />

3. Restart UPlatform.

Working with HTTP
Starting with 8.5.512.37, as part of a security feature update, SpeechMiner is upgraded to work only
with HTTPS connections. However to enable HTTP, remove the attribute requireSSL="true" from
SpeechMiner Web’s web.config file.

Important
It is recommended to always use HTTPS connections. However, this
configuration provides an option to use HTTP also.
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1. Open IIS Manager.
2. On the left panel, expand <Server Name> > Sites > Default Web Site.
3. Right click on SpeechMiner and click Explore. This opens a folder containing the web.config file.
4. Remove the requireSSL="true" from the web.config file.

Recording Modes

Additional Configuration for Recording Modes

• Create a new application for SpeechMiner with a Genesys Generic Server template in the Genesys
Administration Extension:
• Follow the Creating Applications Objects procedure in the Procedures tab of the Applications

page in the Genesys Administration Extension document.
• Verify that the name of the application that you create is the same as the ApplicationName field in

the configServer table of the SpeechMiner database.
• Creating a SpeechMiner application does not require configuring connections or options and is not

integrated with LCA.

SpeechMiner Web Application

Configuring a SpeechMiner Web Application

Configure a new SpeechMiner Web application when your default web site is not sufficient for your
systems demands.

1. Open the IIS Manager.
2. Under Connections, select Sites > Default Web Sites and right-click SpeechMiner.
3. Click Remove to remove the existing SpeechMiner Web Application.
4. Under Connections right-click the web site to which you want to add the SpeechMiner Web Application.
5. Select Add Application.
6. In the Application Name field enter SpeechMiner for the new web application.
7. Click Select.
8. Open the Application Pool list and select SpeechMiner.

Configuring SpeechMiner Additional Configurations

SpeechMiner Administration Guide 256



9. Click OK.
10. In the Physical Path click the Browse button and select the Installation > Web folder. The default

folder is c:\Program Files (x86)\Genesys\Software\utopy\product\web.
11. Click OK.

The SpeechMiner Web Application appears under the web site to which you
selected to add the SpeechMiner Web Application.

Define Caching Reports

Defining Caching Reports

All Caching tasks are listed in the ReportCachingParams and ReportCachingGlobalParams
tables.

In the default database there is one Caching task that caches all the reports in the expanded widgets
for all the active partition sets during the last 30 days.

You can select different reports to cache then those defined by default. You can also delete the
existing cache and create a new cache.

Important
Caching is only available for Saved reports.

To define a new cache report:

1. Access the ReportCachingParams table in the database and insert a new row.
2. Define the following parameters:

Parameter Description
enabled 1

reportsQuery
The query that retrieves the report id’s and the
partition strings associated with the report you
want to cache.

@templatesToExclude The templates to exclude from caching.
@usersToExclude The users to exclude from caching.

@daysUserIsActive
The users that should be cached. For example, if
this is 7, then only users that are active in the
last 7 days should be cached.

runAtTime Defines when the caching task will run within
24hrs. The maximum is 1440 minutes for 24hrs.
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Parameter Description
For example, if you want the cache task to run at
12 midnight and your UTC difference is +2, enter
-120. It is the difference between UTC and the
local time you want it to run in. The difference is
in minutes.

nextTimeToRun
The next time the Caching task is set to run. Set
this parameter to a low value. During the initial
run the task automatically sets the correct value.

3. Access the ReportCachingGlobalParams table in the database and define the following parameters:
Parameter Description

numberOfProcesses The number of parallel threads that should be
cached (at the same time).

keepLogMessages The number of days log messages associated
with caching tasks be should be kept.

NotificationMail
The email address belonging to the users to
whom the caching task report should be sent
when the caching is complete.

webComputerName The name of the web server to which the reports
are cached.

4. Log into SMConfig.
5. Under Machines & Tasks, select one or more machines on which the Caching task will run.

If you select more than one machine the Caching task will be divided equally between the
machines that run simultaneously. The more machines the faster the Caching task will be
completed.

6. Click Edit.

The following Properties window appears:
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7. Select Report Caching.
8. Click Ok.
9. Click Save.

10. Select the Report tab.

The following Report Deployment page is opened:

Configuring SpeechMiner Additional Configurations

SpeechMiner Administration Guide 259



11. In the Set reports caching time (minutes) field enter 1440 (this number represents 24 hours).
12. Select all the report templates and click Save.
13. Verify that the Caching task is running:

a. Access the reportCachingLog table.
b. Select the table records and verify that the Caching task ran.
c. Access the ulogger and verify that it is caching the selected reports.
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Important
If the Report Caching task fails, the Partition Failure error will appear
in the reportCachingLog table. To resolve this error copy the
Microsoft.ReportViewer*.* dlls from the web\bin folder to the
platform bin folder utopy\product\bin\release or Install MS Report
Viewer 2005.

Report Server Email Configuration

Report Server Email Configuration

Configure the Report Server email as follows so that the report schedule and report deliverable
functions operate as expected.

1. Access the Report Server machine.
2. Open Reporting Services Configuration Manager.
3. Click Connect to connect to the Report Server.
4. Select Service Account and define a user account with access to the SMTP server.
5. Click Apply.
6. Select E-mail Setting and define the SMTP Server and default Sender Address.
7. Click Apply.

Integrated Windows Authentication

Integrated Windows Authentication

Integrated Windows Authentication enables you to ensure that your SpeechMiner users are not
required to log into SpeechMiner every time they want to access the application.
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Tip
To configure your application to use Integrated Windows
Authentication, you must use IIS Manager to configure your
application's virtual directory security settings and you must
configure the <authentication> element in the Web.config file.

1. Open IIS Manager and navigate to the level you want to manage. For information about opening IIS
Manager, see Open IIS Manager (IIS 7).

For information about navigating to locations in the UI, see Navigation in IIS Manager (IIS 7).

2. In Features View, double-click Authentication.
3. On the Authentication page, select Windows Authentication.
4. In the Actions pane, click Enable to use Windows authentication and Disable to use Anonymous

authentication.
5. In your application's Web.config file or in the machine-level Web.config file, ensure that the

authentication mode is set to Windows as shown here.
...
<system.web>
...
<authentication mode="Windows"/>
...

</system.web>
...

Multiple Language Support for the User Interface

Multiple Language Support for the User Interface

To enable your user interface to display in more than one language perform the following steps:

1. Create a copy of the SpeechMiner web folder (C:\Program Files (x86)\Genesys\Software\utopy\product\
WEB).

2. In IIS create an additional SpeechMiner application and select SpeechMiner as the Application Pool.
3. Under Advanced Settings change the path of the new physical folder to the new web folder.
4. In the ...\utopy\product\web.config file change en-US to one of the supported languages.

For a list of the supported languages, refer to SpeechMiner Language Support
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Disable the Multi-Language support feature
The web UI is displayed in a language that you selected in the browser. If you select an unsupported
language in the browser, the web UI defaults to the language selected in the SMConfig application.

To disable the Multi-Language support, perform the following steps:

• SMConfig Config File:
1. Navigate to the installation path of SpeechMiner:

C:<installationpath>\Software\utopy\tools\bin\release

2. Open the XML configuration file: SMConfig.exe.config.
3. In the file, search for the parameter: multilingualSupport.
4. Set its value to False.
5. Close and reopen SMConfig.
6. Restart SM Web from SMConfig.

• SpeechMiner Web Config File:
1. Navigate to the installation path of SpeechMiner:

C:<installationpath>\Software\utopy\product\WEB

2. Open XML configuration file: web.config.
3. In the file, search for the parameter: multilingualSupport.
4. Set its value to False.
5. Restart the SM Web.

Purging Fragments Configuration

Purging Fragments Configuration

By default, recognition fragments are stored in the database for two weeks. After two weeks the
fragments are purged.

The default purge value can be configured so that when you create a Trending Cluster Task you can
configure a filter criteria for fixed dates older than two weeks.

To change the default purging fragments value, set a different value in the
PurgeFragmentAfterXDays field in the CallRecognizer database table.
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Redirect SpeechMiner URL to Load Balancer

Redirect SpeechMiner URL to Load Balancer

After logging into SpeechMiner using Load Balancer, and the SpeechMiner session times out,
SpeechMiner may be redirected to the wrong URL.

To verify that SpeechMiner is not redirected to the wrong URL, set the externalApplicationBaseUrl
in the webserviceparams table to the correct Load Balancer URL (for example, http://lb/
speechminer).

Once you assure that SpeechMiner is directed to the correct URL you can Enable HTTPS for
SpeechMiner when Load Balancer is configured with HTTPS and IIS is configured with
HTTP. For details refer to the HTTPS for SpeechMiner tab in this page.

Configure SMART Show Calls Since Value

Configure Default SMART Show Calls Since Value

The default Show Calls Since value can be configured so that users do not have to calculate and
change the date themselves.

To change the default Show Calls Since value, set the DAYS_FOR_TOPIC_AUDIT field in the
SMARTConstants table.

If you enter values lower or equal to zero or a null value (the default), 1/1/1970 will appear in the
field.

If you enter other values, the field will contain the current date minus the value entered in the field
(including the current date). For example, if today is November 6th, 2017 and the value is 5, the field
will show November 2nd, 2017 and if the value is 1, the field will show November 6th, 2017.

Configure SMART Update Event Value
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Configure Default SMART Event Update Value

When a new SMART Strictness value is applied, the Update Event value determines the number of
previous days from which the system will fetch events to update. If this value is null, all events are
updated with the new strictness value.

Important
When the SMART Event Update value is 0, previous events are not
updated.

To change the default Event Update value, set the DAYS_TO_UPDATE_EVENTS field in the
SMARTConstants table to # days.

Remove SpeechMiner Metadata Fields

Remove SpeechMiner Metadata Fields

To remove metadata fields from the SpeechMiner Metadata filter perform the following steps for each
metadata field you want to remove:

1. Run the following SQL command:
a. delete from CallMetaExTypes where fieldName='<FIELD_NAME>'

b. delete from callMetaExTbl where fieldName='<FIELD_NAME>'

2. Mark all the interactions that should be re-indexed by running the following SQL command
exec dbo.sp_reindexCallsByParams 3,0,0,"

3. Restart the SpeechMiner platform.

Important
All of the SpeechMiner fields in the Metadata filter can be removed.
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Configuring Enhanced digits filtering

Configuring Enhanced digits filtering

Update the following value in the callRecognizer table in database for modifying/updating digit
filtering condition: COMPLEX_FILTERED_CONDITION

CORS Support

CORS Support

Cross-origin resource sharing (CORS) configurations are available in the Speechminer Web.config
file.

The Access-Control-Allow-Origin and Access-Control-Allow-Methods values in customHeaders
section has CORS related configurations.

• Any domains that should be included can be added to Access-Control-Allow-Origin.
• Any HTTP methods that should be included can be added to Access-Control-Allow-Methods.

By default, all domains and HTTP methods - GET, POST, PUT, DELETE, OPTIONS are included.

The Web.config file is available in Speechminer installation path. It can be navigated from IIS.

Path: IIS > Select Default WebSite in left side panel and expand > Right click on Speechminer >
Explore.
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Configuring Permissions
This section describes the permissions that must be set for the functional SpeechMiner domain user
(SMUSER) and for users of SMART.

UPlatform

Configuring Permissions for UPlatform

SpeechMiner uses a domain user account as the credentials for all the registered SpeechMiner
services. Your IT department must be able to create this account for you. The domain user must have
assigned permissions on all machines on which the UPlatform service will run, as described below.
The user account must be created and assigned the required permissions before you begin
configuring SpeechMiner.

Important
In this guide, this functional user account is called SMUSER.

Groups
SMUSER must be added to the following groups:

• Power Users
• Performance Monitor Users (if this group exists on the machine)

Folder Properties
In the Properties of the following folders, assign permissions to SMUSER, as follows:

Important
Tab indicates the tab in the Properties dialog box in which the
permission can be assigned.
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Folder Tab Permission Comments

Genesys installation
folder Security Modify

Usually C:\Program
Files (x86)\Genesys\
Software

Genesys data folders Security Modify
For example, C:\data -
where the data\input
and data\filtered
folders are located

Genesys data folders Sharing Change
For example, C:\data -
where the data\input
and data\filtered
folders are located

C:\Program Files
(x86)\Genesys\
Software\utopy\
product\WEB

Security Read/Write
This is for the
impersonation user
specified in the
web.config file.

SMART

Configuring Permissions for SMART

Any user who will run SMART should have the following permissions:

Folder Permission Comments

SpeechMiner installation folder Read/write Usually C:\Program Files
(x86)\Genesys\Software

Package Root Path Read/write
The path configured in the
Packages folders text box in the
Sites and Machines section.

In addition, all SMART users should have permission to use .net encryption. To add this, an
administrator can run the following command on the local user workstation:

aspnet_regiis -pa "NetFrameworkConfigurationKey" "{domain}\{user}"

Web Server
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Configuring Permissions for the Web Server

Once you have installed the SpeechMiner web server, you should set the following permissions:

• On the folder C:\Windows\Microsoft.NET\Framework\v2.0.50727\Temporary ASP.NET Files, set
Modify permissions to the domain user that SpeechMiner will impersonate (For the SMUSER, see
UPlatform).

• Set read/write/modify permissions to the IIS user/group (IIS_IUSRS in Windows server 2008 and
above) and the operational domain user (SMUSER) on the SpeechMiner installation folder.

• Set read/write/modify permissions to the IIS user/group (IIS_IUSRS in Windows server 2008 and
above) on the windows temp folder.

Directories Used by ASP.NET

Give SMUSER access permissions to the IIS metabase and other directories used by ASP.NET. To do
this, an administrator can run this command:

c:\Windows\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis.exe -ga
"{domain}\{user}"

Report Server

Configuring Permissions for the Report Server (Pre SQL Server
2019)

On the report server, assign the Content Manager role to SMUSER, as follows:

1. On the database server, open a browser, and navigate to //<database server name>/reports. The
SQL Server Reporting Services manager opens.

Important
If the Windows UAC (User Account Control) is active on the server,
open the browser by right-clicking its icon and then selecting Run
as administrator.
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2. Select the Folder Settings tab.

Important
If you cannot access this folder, because you are repeatedly
asked for your credentials, and then the screen turns blank, do
the following: In rsreportserver.config, remove the value
RSWindowsNegotiate and ensure that RSWindowsNTLM is
specified. (For more information about this problem, and some
other solutions, see https://docs.microsoft.com/en-us/sql/
reporting-services/security/configure-windows-authentication-on-
the-report-server?view=sql-server-ver15)

.
3. If SMUSER is not on the list, click New Role Assignment and add it. If it is on the list, click Edit to edit

the existing account settings.
4. Select speechminer database > sme.
5. In the Security tab, click New Role Assignment. The New Role Assignment tab opens.
6. In Group or user name, enter the user name (SMUSER).
7. Select the Content Manager checkbox.
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8. Click OK. The Content Manager role is assigned to SMUSER.

Configuring Permissions for the Report Server for SQL Server
2019

On the report server, assign the Content Manager role to SMUSER, as follows:

1. On the database server, open a browser, and navigate to //<database server name>/reports. The
SQL Server Reporting Services manager opens.

2. Right-click on the database folder and click Manage.

Important
To configure permission at the Home level, click Manage folder
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and follow the steps below.

3. Select Security on the left navigation panel and click Add group or user.

4. In Group or user, enter the user name (SMUSER).
5. Select the Content Manager checkbox.

6. Click OK. The Content Manager role is assigned to SMUSER.
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Working with ULogger
ULogger is a SpeechMiner tool that lets you view event logs associated with your system.

Before you begin working with ULogger consider the following:

• SpeechMiner logs are written to the Event Viewer and to files saved on your database.
• The SpeechMiner logs that appear in ULogger are the same logs that appear in Event Viewer >

Applications and Services Logs > SpeechMiner.
• ULogger enables you to view SpeechMiner logs in a central location.
• ULogger view options conveniently enable you to separate information logs from warning and error logs.
• In Debug mode, the debug logs will not appear in the ULogger. The debug messages will only appear in

the log files.

Procedure

1. Right click the ULogger icon and select Run as administrator.

ULogger is opened.

2. Use one or more of the following ULogger options:

ULogger Options Description

Pause
Click Pause to freeze the ULogger scroll bar so
that you can read a specific log. Click Pause
again to unfreeze the scroll bar.

Refresh Click Refresh to reload logs according to the
selected view (for example, View last 7 days)
and source.

Machine Indicates the machine for which the logs are
created.

Find Enables you to search for a specific log.

System
Enables you to select the system for which you
want to view logs. If the system is only working
with one Tenant, SpeechMiner will appear in the
field.

Source

Enables you to view logs associated with a
specific source:
• All: view logs for all sources.
• Default: view logs for components that are

not connected to the database (for example,
SMConfig before it logs into the database).
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ULogger Options Description

Or, view logs for one of the components in the list (for
example, Interaction Receiver, Uplatform, Web, etc.).

File Menu

Contains the following two options:
• Refresh: enables you to view older logs and

updated logs for a specific source.
• Clear: enables you to either erase the logs

from ULogger while keeping them in the
database or you can completely delete the
logs from the system.
Click Yes to delete the log files from the
Event Viewer and No to clear the ULogger
screen.

View Menu

• Split View: divides the screen into two. The
left side contains a list of information logs
and the right side of the screen contains a list
of error and warning logs.

• Merged View: shows all the logs in one list
(that is, information, error and warning logs).

• View All: shows all the available logs.
• View last 7 days: updates the screen with

logs from the last 7 days.
• View last 24 hours: updates the screen with

logs from the last 24 hours.
• View last 60 minutes: updates the screen

with logs from the last 60 minutes.
• Fore Color: enables you to change the log

font color.
• Back Color: enables you to change the log

background color.
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Working with Exploration (Trending)
The SpeechMiner Trending page is designed to help you monitor and analyze terms and phrases
within conversations and identify and explore familiar and unexpected trends. To learn more about
SpeechMiner Trending refer to the SpeechMiner 8.5.5 User Manual or Online Help.

Important
To manage Trending Cluster Tasks, you must be granted the Manage Trending
Cluster Tasks permission. To learn more about SpeechMiner permissions refer to the
SpeechMiner 8.5.5 User Manual.

If you intend to create a custom Trending Cluster Task, you must consider the following
information:

Maximum Trending Cluster Tasks

By default you can define a maximum of five custom Trending Cluster Tasks. If you have too many
Trending Cluster Tasks, your system may not have enough computational resources to handle the
required data load.

To change the default maximum Trending Cluster Task number, change the value in the
MaxRunningClusterTasks field in the webServiceParams database table.

Purging

The SpeechMiner default purge value is two weeks. To retrieve recording fragment information that is
older than two weeks you must change the default purge value.

For details about how to change this value, refer to the Purging Fragments Configuration section.

Default Cluster Task

By default the SpeechMiner Trending feature includes cluster tasks. These default tasks are not as
accurate as custom Trending Cluster Tasks and may exhaust system resources. If you increased the
maximum Trending Cluster Tasks value and you do not mind waiting for a higher accuracy rate, and
you know you do not require information from the default cluster tasks, you should disable the
default cluster tasks so that they do not occupy your resources.

To disable the default cluster tasks, update the ExplorationTasksParams table and set the
ParameterValue column to false where taskid=3 and ParameterName='generate-defaults'.
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Appendixes
The follow sections provide examples and supplementary information that can help you configure
your Genesys Interaction Analytics (GIA) solution.

• Configuring Command Line Availability for SMART
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SMART Command Line
SMART Command Line is useful when you are working with a development system and a production
system. That is, the command line option enables the administrator to run a command in the
production system, that imports and applies SMART programs and topics that were created in the
development system. The programs and topics are exported from the development system as a UPF
file.

Important
Before you perform the SMART Command Line, you must first configure which
database should be used by the command line.

Configure which database should be used by the SMART Command Line

SMConfig

1. Log into SMConfig.
2. Select Services.
3. In the Services window, select Update config files.
4. Select the computer on which you want to run the SMART Command Line.
5. Click Save.

SMART

1. Go to C:\Program Files (x86)\Genesys\Software\utopy\product\bin\release.
2. Open smartc.exe.config and find the following section:

<connectionStrings>
<add name="web_con_str"

connectionString="server=[DBServer];uid=[DBUser];pwd=[DBPassword];database=[DBName];Min
Pool Size=10;Max Pool Size=1000;connection lifetime=10" />
</connectionStrings>

3. Replace the code in the square brackets with the correct values and remove the square brackets.
4. Save the smartc.exe.config file.

Run the SMART Command Line

1. Open a command line, type smartc followed by the parameters you want to use and press Enter.

For example: smartc.exe [-i file.upf] [-a [-l Yes|No|Cancel]] [-u user -p password [-s|-
g]]
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The following is a list of the parameters you can use:
Command Description

-i file.upf Import the file.upf file.
-a Apply changes to production.
-l Yes/No/Cancel Specify whether or not to unlock locked items.
-u user User name.
-p password User's password.
-s Specify SpeechMiner authentication (default).
-g Specify Genesys authentication.
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Working with Chat Interactions
SpeechMiner supports numerous metadata for chat interactions.

This page describes the required system specifications for the successful implementation of chat
interactions.

Supported Formats

Supported Formats for SpeechMiner 8.5 and Above

• Text File
• Chat XML file (.chtx)

File Format

Chat File Format Specifications

Text File

A chat interaction in a text file format only requires a subject and the conversation. The file does not
require information about the participants.

The first line in the text file should be the subject. The second line in the text files should be empty.
The remaining lines should contain the chat conversation.

For example:

Billing Issue

How can I help you today?
I want to change my billing address.
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Chat XML File (.chtx)

When using an XML file (.chtx format), the chat
interactions should be configured as
follows:<textFormat>XML</textFormat>

Additional information can be added as meta data in the interaction XML file.

Important
The .chtx format and specification that is described here is not an
official format or standard. This file format was specifically created
for SpeechMiner purposes. The assumption is that the UConnector or
any other ETL tool will create the chat conversation in this format
before sending the file to SpeechMiner.

A chat conversation in .chtx format can contain one subject, multiple conversation messages and a
description of the parties in the conversation. The subject and each message is not limited to one line
(they can contain multiple lines).

Each message element can contain the following:

• Time stamp - the time format is ISO_8601. For example: '2013-12-04T18:26:46'
• Display name - the display name of the message sender.
• Party ID - the string identifier of the sender/party id. The party ID can be described in two places, in

both cases the ID will be used to match the party/speaker type. If the party ID cannot be found in one
of these places it will be ignored and identified as a different party in the call.
• In the 'speakers' element in the meta data xml file
• In the 'parties' element in the chtx file (see below)

Messages without a party ID or messages with a party ID that were not found, will be treated as one
party. This configuration is similar to the channels speakers configuration in dual channel calls

Each party element can contain the following:

• Party ID - used to match the id from each 'message' element
• Party type - used to identify the type of the party/speaker when you configure categories with

speakers or limit the search in the web to specific speakers.

If one of these attributes are missing this party configuration will be ignored.

May I have your account number please?
...
It's been my pleasure to assist you today
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Important
The additional information in each message is not mandatory.
The order of the messages in the file must be in the original order. Since it's not
mandatory, the system does not sort the messages according to the time stamp
value.

If the sender name is not specified in the message, the system will
not use the speaker name from the speakers configuration (the UI
will not show any name).

File Format Examples

Example 1:

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="FIRST SPEAKER ID" partyType="FIRST SPEAKER TYPE" />
<party partyId="SECOND SPEAKER ID" partyType="SECOND SPEAKER TYPE" />
...

</parties>
<subject>SUBJECT LINE</subject>
<message time="FIRST MESSAGE DATE AND TIME" partyId="FIRST MESSAGE

SPEAKER ID" displayName="FIRST MESSAGE SENDER NAME">
FIRST MESSAGE CONTENT

</message>
<message time="SECOND MESSAGE DATE AND TIME" partyId="SECOND MESSAGE

SPEAKER ID" displayName="SECOND MESSAGE SENDER NAME">
SECOND MESSAGE CONTENT

</message>
...

</chat>

Example 2:

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="customer" partyType="customer" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="agent"

displayName="Agent 1"> How can I help you today?
</message>
<message time="2013-04-18T12:10:51" partyId="customer"

displayName="Customer 1"> I want to change my billing address
</message>
<message time="2013-04-18T12:10:58" partyId="agent"

displayName="Agent 1"> May I have your account number please?
</message>

...
<message time="2013-04-18T12:15:23" partyId="agent"
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displayName="Agent 1"> It's been my pleasure to assist you today
</message>

</chat>

Important
Any white space around the message content or subject content will
be removed (including the first and last new lines). New lines inside
the content will be preserved. Since the format is XML, any reserved
XML characters must be encoded if they appear in the subject
content, message content or attributes. Any other XML information
will be ignored.

PartyID Configuration

PartyID Configuration

PartyID can be configured in two places:

• In the chat meta xml file, in the speakers element. The speakers element in the meta xml file is used
for mapping the interaction to an agent and work group. Since speakerType is defined in the meta xml
file, the file is used as part of the parties configuration.

• In the parties element in the chtx file. The parties element contains parties that are not linked to the
interaction as agents or work group (for example, a customer).

The chtx fetcher will search for each PartyID used in the message in the speakers configuration. If
the PartyID does not exist in the speakers element, the chtx fetcher will check the parties
element. If the PartyID is not defined in both places the PartyID will be ignored.

Example 1: 2 Parties (Agent + Customer)

In this example, the agent is defined as the speaker and the customer is defined in the parties
element.

Meta XML File:

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>
<mediaType>Chat</mediaType>
<textFormat>XML</textFormat>
<textTime>2014-01-07T10:54:04</textTime>
<programID>english</programID>
<speakers>
<speaker id="ag1" speakerType="agent">
<workgroup>/W1/W2</workgroup>
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</speaker>
</speakers>

</callInformation>

CHTX File:

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="customer1" partyType="customer" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="ag1"
displayName="Agent 1"> How can I help you today?

</message>
<message time="2013-04-18T12:10:51" partyId="customer1"
displayName="Customer 1"> I want to change my billing address

</message>
<message time="2013-04-18T12:10:58" partyId="ag1"
displayName="Agent 1"> May I have your account number please?

</message>
</chat>

As shown in the above example the agent with ag1 ID is configured in the speakers element, in the
meta xml file and the customer with the customer1 ID is configured under parties in the chtx file.

Example 2: 3 parties - agent, supervisor and customer

In this scenario there are two options. You can configure the supervisor as a speaker (the common
scenario) or as the party in the chat. When configured as the party a link to an agent or work group is
not possible.

Option 1: Supervisor as a speaker - Meta XML File

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>
<mediaType>Chat</mediaType>
<textFormat>XML</textFormat>
<textTime>2014-01-07T10:54:04</textTime>
<programID>english</programID>
<speakers>
<speaker id="ag1" speakerType="agent">
<workgroup>/W1/W2</workgroup>
</speaker>
<speaker id="sup1" speakerType="supervisor">
<workgroup>/W1/Sup1</workgroup>
</speaker>

</speakers>
</callInformation>

Option 1: Supervisor as a speaker - CHTX File

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="customer1" partyType="customer" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="ag1"

displayName="Agent 1"> How can I help you today?
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</message>
<message time="2013-04-18T12:10:51" partyId="customer1"

displayName="Customer 1"> I want to change my billing address
</message>
<message time="2013-04-18T12:10:58" partyId="ag1"

displayName="Agent 1"> May I have your account number please?
</message>
<message time="2013-04-18T12:11:02" partyId="customer1"

displayName="Customer 1"> I want to talk to supervisor!
</message>
<message time="2013-04-18T12:11:03" partyId="sup1"

displayName="Supervisor A"> I'm the supervisor, how can I help you?
</message>

</chat>

Option 2: Supervisor is not a speaker - Meta XML File

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>
<mediaType>Chat</mediaType>
<textFormat>XML</textFormat>
<textTime>2014-01-07T10:54:04</textTime>
<programID>english</programID>
<speakers>
<speaker id="ag1" speakerType="agent">
<workgroup>/W1/W2</workgroup>

</speaker>
</speakers>

</callInformation>

Option 2: Supervisor is not a speaker - CHTX File

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>

<party partyId="customer1" partyType="customer" />
<party partyId="sup1" partyType="supervisor" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="ag1"

displayName="Agent 1"> How can I help you today?
</message>
<message time="2013-04-18T12:10:51" partyId="customer1"

displayName="Customer 1"> I want to change my billing address
</message>
<message time="2013-04-18T12:10:58" partyId="ag1"

displayName="Agent 1"> May I have your account number please?
</message>
<message time="2013-04-18T12:11:02" partyId="customer1"

displayName="Customer 1"> I want to talk to supervisor!
</message>
<message time="2013-04-18T12:11:03" partyId="sup1"

displayName="Supervisor A"> I'm the supervisor, how can I help you?
</message>

</chat>
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Working with Analytics Interaction
Metadata

Important
• The following metadata interaction configuration details are not relevant for Genesys

Interaction Recording configuration (GIR).
• Every interaction in the Input folder should contain xml data that provides general

information about the interaction (for example, interaction time, speakers, call length,
and so on).

• The name of the xml file must be unique and the same as the interaction file name.
• The name of any attachment must be unique.

The xml file must include the following fields:

• Call / Text Time: The time the interaction started.

• Program ID: The external program name that processes the interaction.

• Speakers: The name of the agent and customer that participated in the interaction. This field is not
mandatory for social interactions.

• Audio / Text Format: The interaction format (for example, eml, chtx, and so on).

• Workgroup: The agent's hierarchy. This field is not mandatory for social interactions.

• Media Type: The type of text interaction (for example, email, chat, text and/or social). This field is only
mandatory and relevant for text interactions.

• Other: Metadata field and value characters. The valid metadata field and value characters are
alphanumeric, spaces, parenthesis (), and backslash \. This field is only mandatory for social
interactions and must include the title, text and url fields.

The following are examples of the structure of the xml files for each interaction type:

Audio Interactions [+]
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<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>

<callTime>2007-05-15T10:54:04</callTime>
<programID>TESTPROG</programID>
<audioFormat>WAV_GSM610</audioFormat>
<encryptionKey>1</encryptionKey>
<speakers>

<speaker id="a2" [startTime=xx] [endTime=yy] speakerType="zzz">
<workgroup>/W1/W2</workgroup>

</speaker>
<speaker ... >
</speaker>
.
.

</speakers>
<channels left="Customer" right="Agent" /> <!-- Only for calls with different speaker in

each channel –>
<callLength>941.5</callLength>
<customerGroupID>custGrp1</customerGroupID>
<customerID>12345</customerID>
<originalAudioPath>//machine/folder</originalAudioPath>
<partitions>

<partition>/A/B/C</partition>
<partition>/X</partition>
.
.

</partitions>
<originalInteractionURL>http://www.genesys.com/audiofile.wav</originalInteractionURL><!--

Only from SM 8.5.504 and up  –>
<other>

<fieldname>value</fieldname>
<fieldname>value</fieldname>
.
.

</other>
</callInformation>

Email Interactions [+]

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>

<mediaType>EMail</mediaType>
<textFormat>EML</textFormat>

<textTime>2007-05-15T10:54:04</textTime>
<programID>TESTPROG</programID>
<speakers>

<speaker id="a2" speakerType="zzz">
<workgroup>/W1/W2</workgroup>

</speaker>
<speaker ... >
</speaker>
.
.

</speakers>
<customerGroupID>custGrp1</customerGroupID>
<customerID>12345</customerID>
<originalPath>//machine/folder</originalPath>
<partitions>
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<partition>/A/B/C</partition>
<partition>/X</partition>
.
.

</partitions>
<attachments>

<attachment>attachment1</attachment>
<attachment>attachment2</attachment>

</attachments>
<originalInteractionURL>http://www.genesys.com/email.eml</originalInteractionURL><!--

Only from SM 8.5.504 and up  –>
<other>

<fieldname>value</fieldname>
<fieldname>value</fieldname>
.
.

</other>
</callInformation>

Chat Interactions [+]

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>

<mediaType>Chat</mediaType>
<textFormat>Text</textFormat><!-- from SM 8.5 and up, text format can be : XML-->

<textTime>2007-05-15T10:54:04</textTime>
<programID>TESTPROG</programID>
<speakers>

<speaker id="a2" speakerType="zzz">
<workgroup>/W1/W2</workgroup>

</speaker>
<speaker ... >
</speaker>
.
.

</speakers>
<customerGroupID>custGrp1</customerGroupID>
<customerID>12345</customerID>
<originalPath>//machine/folder</originalPath>
<partitions>

<partition>/A/B/C</partition>
<partition>/X</partition>
.
.

</partitions>
<attachments>

<attachment>attachment1</attachment>
<attachment>attachment2</attachment>

</attachments>
<originalInteractionURL>http://www.genesys.com/socail.doc</originalInteractionURL><!--

Only from SM 8.5.504 and up  –>
<other>

<fieldname>value</fieldname>
<fieldname>value</fieldname>
.
.

</other>
</callInformation>
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Social Interactions [+]

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>

<mediaType>Social</mediaType>
<textTime>2007-05-15T10:54:04</textTime>
<programID>TESTPROG</programID>
<speakers>

<speaker id="a2" speakerType="zzz">
<workgroup>/W1/W2</workgroup>

</speaker>
<speaker ... >
</speaker>
.
.

</speakers>
<customerGroupID>custGrp1</customerGroupID>
<customerID>12345</customerID>
<originalPath>//machine/folder</originalPath>
<partitions>

<partition>/A/B/C</partition>
<partition>/X</partition>
.
.

</partitions>
<attachments>

<attachment>attachment1</attachment>
<attachment>attachment2</attachment>

</attachments>
<originalInteractionURL>http://www.genesys.com/socail.doc</originalInteractionURL>   <!--

Only from SM 8.5.504 and up  –>

<other>
<title>Subject</title>
<text>bla bla bla</text>
<url>http://xxx.com/path</url>
<fieldname>value</fieldname>
<fieldname>value</fieldname>
.
.

</other>
</callInformation>

Text Interactions [+]

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>

<mediaType>Text</mediaType>
<textFormat>TEXT</textFormat>

<textTime>2007-05-15T10:54:04</textTime>
<programID>TESTPROG</programID>
<speakers>
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<speaker id="a2" speakerType="zzz">
<workgroup>/W1/W2</workgroup>

</speaker>
<speaker ... >
</speaker>
.
.

</speakers>
<customerGroupID>custGrp1</customerGroupID>
<customerID>12345</customerID>
<originalPath>//machine/folder</originalPath>
<partitions>

<partition>/A/B/C</partition>
<partition>/X</partition>
.
.

</partitions>
<attachments>

<attachment>attachment1</attachment>
<attachment>attachment2</attachment>

</attachments>
<originalInteractionURL>http://www.genesys.com/socail.doc</originalInteractionURL><!--

Only from SM 8.5.504 and up  –>
<other>

<fieldname>value</fieldname>
<fieldname>value</fieldname>
.
.

</other>
</callInformation>
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